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1. Overview

1.1 About

CERTivity® is a powerful pure Java multi-platform visual KeyStores manager. This
standalone GUI desktop application provides a natural experience for managing and using
KeyStores, Certificates, Key Pairs (Private Key, Certificate Chains), Secret Keys in various
formats. It covers and combines functions that otherwise are available through verbose
command line tools or other operating system tools or browsers. It is not intended to be just
a simple 1:1 visual equivalent of these tools - the features being combined and centralized
in an intuitive and productive organization.

Thus developers and system administrator can gain valuable time and ensure the greatest
productivity by letting CERTIvity taking care of the low level details in a uniform manner on
almost all the systems - Windows, Unix/Linux, Mac.

In the long term, CERTivity aims at being a centralized manager and platform for the digital
security related assets.

1.2 Features Summary

CERTIvity has the following main features and advantages:

¢ GUI Representation of the security related items in a Tabbed Document Interface
allowing for visualizing in parallel the following types of models: KeyStores, individual
Certificates and Test Certificate Scenarios. The GUI representation is taking advantage
of the natural approach of using an IDE style interface.

KeyStores entries are represented using a Tree Table structure, each entry and sub-
entry being visualized in a Details Panel resembling the view of an e-mail client. As well,
KeyStore entries take advantage of contextual menus or natural editing actions such as
but not limited to delete, rename, expand, undo/redo. Many of these actions can also
be used through Keyboard shortcuts.

Navigation between KeyStore entries is enhanced by positioning based on the first
character (case sensitive) of a KeyStore alias or by sorting the table columns.

Many of the application's components expose Context Sensitive Help (default F1), the
Table of Contents tree being synchronized with the current context.

Status Bar is displaying useful information including if the KeyStore is case sensitive,
or case aware.

« KeyStore management - The application is able to work with a wide range of KeyStores
types: (JKS, JCEKS, PKCS #12, BKS, BKS-V1, UBER and Windows native ones) and
supports the following KeyStore operations:

1. Create (generate) a new KeyStore;

2. Open an existent KeyStore;

3. Opening the CA TrustStore(s) of the JRE(S) discovered on the current system;
4. Save a KeyStore;

5. Copy and Paste entries from one KeyStore to another;

6. Copy to clipboard Certificates from Key Pair’s Certificate Chain;

Overview
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12.
13.
14.
15.
16.

17.
18.

19.
20.
21.
22.

23.
24,

25.
26.

27.
28.
29.
30.
31.

. Change a KeyStore's password;
. Change a Key Pair's password;
. Password manager to avoid entering Key passwords each time;
10.
11.

Emphasizing expired and about to expire Certificates or Key Pairs;

Emphasizing Certificates and Key Pairs for which the key size is smaller than a
value set by the user;

Display trust status for Certificates in the KeyStore view;
Convert to other KeyStore format;

Delete KeyStore entry;

Change KeyStore entry alias;

Import Key Pairs from Key Pair files or from separate Private Key and one or more
certificate files;

Import trusted Certificates;

Trust verification when importing certificates (with user confirmation when trust is
not established);

Add Certificate Extensions;
Save Certificate Extensions as XML;
Generate self signed Key Pairs (Private Key with corresponding Certificate);

Generate new Key Pairs using the information from other already existing Key
Pairs;

Set a custom minimum key size limit for new Key Pair generation;

Select the country code from a list of available countries resulting a valid 1SO
country code when generating a Key Pair;

Generate Secret Keys;

Retrieve certificates from servers (e-mail server, web server etc.) - This is based
on the underlying SSL/TLS protocols;

Set SSL Connection Type (to be used when retrieving certificates);
View Private Key Details;

View Public Key Details;

View Certificate Chain Detalils;

Configurable KeyStore persistence on successive runs of the application.

« Certificates operations:

1.

2.
3.
4.

Import Certificates / Certificate Chains into KeyStore either from files or from SSL
connections;

Open an existing Certificate as standalone (not part of a KeyStore);
Display Certificate Details (having 11 Certificate Fingerprints types available);

Display certificate trust status;
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9.
10.
11.
12.
13.
14.

. Display multiple certificates including certificate chains;
. Obtain the revocation status from the signing CA through CRL;
. View the CRL associated to a certificate;

.Useltest a certificate against a SSL connection (including plain upgradable

sockets) to an end-point and permitting raw TCP/IP level communication (similar
to telnet/nc raw inspections); verbose handshaking information is also available;

View Public Key Details for the opened certificate;
View PEM representation;

View ASN.1 representation;

View Certificate Extensions;

View ASN.1 representation for a Certificate Extension;

Extend validity for a Key Pair entry.

« Sign and verify

CERTIivity aims to bridge the gap between keys management and digital signature
functionality as well as offering a suitable introspection for developers interested in
various investigations. CERTIvity signs and verifies PDF, JAR and XML files with
verbose details. CSR can be signed as well.

1.

Existent signature applications lack the in-depth key management and vice-versa,
existent key management applications lacks the signing and verification process
or the verbose details. CERTIvity interconnects these functionalities;

. The embedded signature certificate can be directly imported into the active

KeyStore;

. Signing is a contextual action while you browse the KeyStores so you will take

advantage of all the existent key management features described above;

. PDF digital signature and verification:

* Many existent PDF signature applications cover just the signature process,
leaving the verification process to PDF readers or editors. CERTIvity is offering
a PDF signature verification process too, which can show you details that are
not otherwise accessible, especially when you deal with the PDF specification;

« Each signature details can be inspected;

« All PDF standard SubFilter values are supported: adbe.pkcs7.shal,
adbe.pkcs7.detached and adbe.x509.rsa_shal as opposed to the general
practice of supporting just adbe.pkcs7.detached;

« The name of the PDF signature handler (Filter) is Adobe.PPKLite;

« Multiple PDF signatures can be applied incrementally;

. XML digital signature and verification;

« All XML signature types are supported: enveloped, enveloping and detached;

e The XML signature is based on Java Specification Request JSR-105 which
standardizes the XML Digital Signature APlIs;
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6. JAR digital signature and verification:
» GUI alternative of the Java command line jarsigner tool, both for signing and
verifying;
 Sign and verify the Android Application Package (APK) signature.
e Export options:
1. Retrieve and Export Certificates from multiple sources into multiple formats;
2. Export Key Pairs, Certificate Chains, Private Keys, Public Keys;
3. Some of the formats supported besides the KeyStores themselves are:
» X.509 Certificate Files;
« X.509 Certificate Files (PEM encrypted);
* PKCS #7 Certificate Files;
« PKCS #7 Certificate Files (PEM encrypted);
» PKI Path Certificate Files;
* PKCS #12 Key Pairs;
« PKCS #8 Key Pairs;
« OpenSSL Public Key;
e OpenSSL Public Key (PEM encrypted);
« PKCS #8 Private Key Files;
« PKCS #8 Private Key Files (PEM encoded);
« OpenSSL Private Key Files (PEM encoded);
* PKCS #10 for CSR;
» SPKAC for CSR;
« ASN and PEM for visualizing most of the items.
e TrustStores Management:
1. Set/Remove TrustStores at runtime without restarting the application;

2. Configure Trust Path validation options at runtime without restarting the
application;

e Certificate Authority functions:

1. Certificate Signing made easier using "Select as CA Issuer" and "Sign Certificate
by <aliasForlssuer>" actions;

. Generate Certificate Signing Request (CSR) files;
. Sign Certificate Signing Request (CSR) files;
. Import CA Reply;

g b~ W N

. Trust verification when Importing CA Reply (with user confirmation when trust is
not established);

6. Check PKI file type;

Overview 4
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7. Open Certificate Revocation Lists (CRL) from files or URLS;
8. Open Certificate Signing Request (CSR) files;

9. Certificate chain management: append and remove signer certificate (with Copy/
Paste/Delete/Undo/Redo functionality included);

10. By generating CSR files, signhing CSR and importing CA reply the application can
act as a testing purposes CA.

¢ Multi-platform

Being a Java application it runs anywhere an Oracle (Sun) JRE or Apple JRE can run.
Depending on the platforms, CERTIivity comes bundled with JRE or standalone. Please
check the download page for the suitable setup package.

Most of the operations are executed on separate threads, so that for example while
generating a key or signing a PDF one can perform other tasks as well.

The existence of some of these features are controlled by the category of your license -
either Standard or Professional. For the features matrix of CERTIivity see the Appendix A,
CERTivity™s Features Matrix.

1.3 Documentation and Samples

CERTIvity provides documentation in more format types:

1. documentation file, CERTi vi ty. pdf, contained in the doc subdirectory from the
distribution kit and also available on our website at http://www.edulib.com/products/
keystores-manager/download/#manual;

2. application help which can easily be accessed using the application's Menu Help;

3. many of the application's components expose Context Sensitive Help (default F1),
the Table of Contents tree being synchronized with the current context;

4.the HTML CERTivity manual is available on our website for reading
on line (using http://www.edulib.com/keystores-manager/resources/doc/html/
CERTIivity/CERTIivity.html).

Samples files are contained in the sanpl es subdirectory of the doc directory from the
distribution kit. You have further details (including passwords) in the Readn®. t xt file which
will be opened when you first run the application. The Readn®. t xt file can be opened again
using Menu File > Qpen > Open Sanpl e Readne. txt.
The sanpl es subfolder is further divided in 10 subfolders:

1.keyst or e - can be used to observe the KeyStore features;

2.certificates - can be used to observe the certificates features;

3.crl - can be used to observe the open CRL feature;

4.csr - can be used to observe the CSR features - generate and sign;

5.j ar - can be used to observe the sign/verify JAR files features;

6. pdf - can be used to observe the sign/verify PDF files features;

7.xm - can be used to observe the sign/verify XML files features;

8. keypai r - contains examples of exported Key Pairs useful to observe the export/
import features for key pairs;

Overview
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9.privat ekey - contains examples of a Private Key exported in myriad formats.
Together with the suitable certificate from the certi fi cat e directory a Key Pair
can be imported in a KeyStore;

10. publ i ckey - contains examples of a public key exported in various formats.

Overview 6
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2. CERTivity®'s Administrative Details

2.1 System requirements

CERTivity being a GUI desktop application it requires a Graphical Interface to install and run.

The minimum and recommended hardware configurations are depicted in the table below:

Table 2.1. System Requirements

Minimum Configuration Recommended Configuration

Processor: 800MHz Intel Pentium Il or|Processor: 2.6 GHz Intel Pentium IV or
equivalent equivalent

Memory: 512 MB Memory: 2 GB

Disk space: 200 MB of free disk space Disk space: 400 MB of free disk space

2.2 Platforms and Java Virtual Machines

CERTivity is a Java based application, available for download and install through:
¢ Bundled JRE Java Native Installers, the recommended option;
« Normal Java Native Installers (standalone, no JRE bundled);

e Plain archives (Zip/TAR.GZ) - manual process.

The recommended CERTivity distribution for Microsoft Windows and Linux platforms (x86/
AMDG64) is the Installer with the embedded Java Runtime Environment (JRE) as everything
is out of the box. If the target operating system is not in the list of the supported embedded
JRE distribution, or there are other reasons for which you don't want an embedded JRE, you
will need to have an already installed JRE from Sun Microsystems (Oracle) which is now
supported for Mac OS as well. Note that the embedded JRE is exclusively used for running
the CERTIvity application and is not affecting the existent applications.

Being a Java based application, CERTivity could run anywhere where an Oracle or Apple
JRE is available - this covers a wide range of systems such as Microsoft Windows, Linux, Unix
and Mac. The exact JRE for the CERTIivity application is configured in the j dkhomne property
from the configuration file ${certivity_home}/etc/certivity. conf (on Windows),
respectively ${certivity_hone}/etc/certivity. conf. sh (onLinux, Unix and Mac).
The Installer is transparently setting this path according to the installer type:

« If you are using the recommended bundled JRE Installer, then the embedded JRE is
used to run the installer itself and is also configured in the j dkhone property.

« The standalone (non-bundled JRE) Installer will need a JRE to start with and to set for
CERTIvity. If you are using the standalone Installer make sure your system has a Sun
Microsystems (Oracle) JRE available for the user you intend to use to install CERTIivity.
If not, then please install JRE 1.7 according to the Java vendor instructions. We do not
recommend using JRE 1.8.

The standalone Installer will automatically look for a suitable JRE on your platform for
the installation itself and for configuring CERTivity to start with. The minimum required
version is 1.7. The first JRE found in this search order is mainly used:

« Environment variables ${ JAVA_HOVE} , ${ JDK_HQOVE} ;

CERTIivity 's Administrative
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« Windows registry (if the OS is Windows) ;

» Standard locations.

If the JVM found is not the standard recommended one a warning message is displayed
but the installation will continue.

« Ifyou are using a plain archive distribution, then you will need to install JRE 1.7 according
to Sun Microsystems (Oracle) instructions and to configure the j dkhone property
from ${certivity hone}/etc/certivity.conf(.sh) by uncommenting it and
pointing it to the JRE path, for example j dkhone="C:\ Program Files\Java
\'j re7".Ifyou are not configuring j dkhome, CERTIvity will try to use the default location
of JDK/JRE on the platform, but in case the target system has more Java distributions
installed, it is safer to expressly point the j dkhone property to the exact location.

The exact Java version the CERTIvity application started with is displayed in the Hel p >
About menu, for example:

Java: 1.7.0_15; Java HotSpot(TM dient VM 23.7-b01

As there are many flavours of hardware, operating systems and versions available it is
practically impossible to test each one of these. We have successfully run CERTIvity on
Micrososft Windows XP, Microsoft Windows 7, Microsoft Windows Server 2003, Microsoft
Windows Server 2008, Linux Debian, Linux Ubuntu, RedHat, Solaris Intel and Mac OS X.
Both 32 and 64 bit OS distributions as well as JREs are supported.

Even if there is a wide platform distribution there are just few known issues:

o Default font size being ignored by the GTK Look and Feel on Gnome Desktop
Environment on Linux;

< Contextual Help Window is not brought up to front on Mac OS X;

* In Windows 7, like for many other applications, an "Access Denied" error may be
encountered when trying to save KeyStores or when exporting Certificates, Key Pairs,
or Private / Public Keys to files that are located in the Windows special folders (e.g.
Program Files, Program Files (x86) ), due to the User Account Control (UAC) function.
This can be fixed by setting the UAC to a lower level or by turning it off.

2.3 Install and Run

2.3.1 Installing CERTivity

On Linux/Unix platforms after downloading the Installer you must make it executable, by
opening a shell, going into the downloads directory (via cd) and running the command chnod
+x, for example:

chnmod +x CERTi vity-uni x-1.0. sh

Then you start the installer either from a file manager or from the command line by running
the above executable script in the same directory, for example:

./ CERTi vi ty-uni x-1. 0. sh

The Installer will guide you through the necessary steps for having CERTivity installed. The
default installation directory and other links are containing the version of the product in

CERTIivity 's Administrative
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them. We strongly recommend to keep this naming convention. Default Installation directory
examples are given below:

e On Windows: C: \ Program Fi | es\ EduLi b\ CERTi vity 1.0;

e On Linux: /opt/EduLi b/ CERTivity 1.0 or / hone/user/ EduLi b/ CERTi vity
1. 0 depending on the user's rights for the / opt directory;

e On Mac:/ Appl i cations/ EduLi b/ CERTivity 1.0/.

As stated in the previous section, if the Java version that we recommend is not detected, the
Installer will present a warning dialog, continuing the installation. After the installation finishes,
we advise you to install the standard JRE (recommended 1.7) and configure CERTivity to
use that standard JRE according to the above section.

2.3.2 License Key (File) Registration

After the installation, when you first run CERTivity, you will be asked to activate it either for
your trial or for your purchased license. Make sure you correctly point to your license file,
then press Install.

Install License Key @

CERTivity 1.2 is not registered.

Please install the Commerdial License Key (File) that you received upon purchasing or the
Free 30 Day Trial License Key (File) that you received upon Trial Request from
http: /fewwe edulib, com,

Browse

| Details || Install || Cancel || Help |

A Commercial License for a CERTIvity version is valid for all the minor versions. For example,
if you purchased CERTIvity 1.0, installed and registered it you will also be able to install and
run CERTIvity 1.3 on the same machine, without the need of requesting or registering another
license file. So the above dialog will not appear in such a case if you use the same machine.

If you have a trial license you can register a commercial license without the need to uninstall
the existent version. Use the menu Hel p > License > Install License Key to
change the license to the one that you purchased. In the same way, without uninstalling, you
can switch from a Standard to a Professional License activating all the features.

2.3.3 Running CERTivity

CERTivity can be started either from the Start Menu / Desktop shortcuts or directly using the
applications startup launchers from the installation base directory bi n/ certi vi ty. exe on
Windows system, bi n/ certi vi ty on the rest of the systems. This later option is the only
one available if you installed CERTIvity using a plain archive.

The CERTIvity application settings are stored outside the application directory under the
Eduli b/ . certivity/ <versi on> sub-directory, located under the platform dependent
user home directory. The settings are accessible through Tool s>Opti ons panel as
described in Section 3.6, “Tools Menu”. From this panel you can export the settings values

CERTIivity 's Administrative
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from the old version into the new application version via an intermediary archive file. That
is the recommended way.

The CERTIvity application is also producing log files in the same user location. Its exact
sub-path under the platform dependent user home directory is (. ) EduLi b/ . certivity/
<version>/var/log/ . The last 3 application runs are logged in nessages. | og,
nessages. | og. 1 and nessages. | 0g. 2. The exact path is dependent on the target OS,
for example:

¢ On Windows XP C:.\ Docunents and Settings\John\Application Data
\. EduLi b\.certivity\1l. 0\var\l og;

e On Linux/ hone/john/. EduLib/.certivity/1.0/var/l og;

¢ On Mac  /Users/john/Library/ Application Support/ EduLi b/
certivity/1.0/var/log

The Log level can be configured from the Application Options accessible through
Tool s>Opt i ons panel as described in Section 3.6, “Tools Menu”, via the option Log | evel
which comes with the default value of | NFO

2.3.4 Handling Multiple CERTIivity versions

Multiple CERTivity versions can be run on the same machine, each one being independent
of the other. This is the normal process for upgrades. Each application version has its own
installation directory, its own Start Menu links, its own settings.

The CERTivity application settings are accessible through Tool s>Opti ons panel as
described in Section 3.6, “Tools Menu”. From this panel you can export the settings values
from the old version into the new application version via an intermediary archive file. We
recommend that after installing the new version and becoming familiar with it, you uninstall
the previous version.

It is possible as a repairing process to install the same CERTIvity version overwriting the
previous installation.

2.4 Java Virtual Machine settings

Standard Java Virtual Machine parameters can be passed through the configuration file
${certivity_hone}/etc/certivity.conf(.sh) inthedefault_opti ons property
by pre-pending - J to the standard parameter, for example - J- Xnk256m

If you handle larger files (especially the PDF operations are memory consuming) or more
files at the same time you may ran out of JVM Heap memory. By default CERTivity comes
with a maximum of 256 MB configured as above. Depending on the memory available on
the target machine, the operating system 32/64-bit architecture, you can specify different
sizes for memory, for example by modifying - J- Xmx256minto - J- Xnx512m After doing this
setting you need to restart the application. If the heap memory amount that you specified is too
high for that platform/32-bit model, upon starting up a "JVM creati on fai | ed" message
will be present. You will need to adjust the memory settings according to your architecture
- for example on Windows on 32-bit JVM distributions due to the 32-bit Windows process
model you cannot specify values larger than about 1100 MB. It is also not recommended to
set the maximum JVM heap to be larger than the physical memory.

Note that this file is specific to each CERTIvity version, so this allows you to manage each
version independently.
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CERTIivity has a Memory Detection system letting you know when the maximum heap
memory passes a threshold. This is configured in the Application Options (accessible through
Tool s>Opt i ons panel as described in Section 3.6, “Tools Menu”) by the property Memory
usage warning max threshold, which comes with the default value of 90%. In such case the
following dialog will be presented:

Th Warning @

! : The memaory threshold was exceeded.
- Current available memary: 247.5 MB
Current used memory: 219.98 MB (59%)

Do not display this warning message anymore

It is possible that after this warning the JVM may issue an OutOfmemory error if the threshold
is too tight. In such a case please adjust the JVM heap setting as described above.

The CERTIvity application also features a memory toolbar, which by default is on - there you
could see the exact memory used and even force a garbage collection.

2.5 Purchase and Licensing Model

CERTivity is a commercial product, which is also offered for Trial for 30 days. The trial
registration is fully functional, except limitations on the number of KeyStores that can be
opened and created during an application instance (run). In order to be able to use a certain
version of CERTIivity permanently and without any limitation a commercial license is needed.

Facts about the licensing model:

e There are two categories of commercial licenses - Standard and Professional - the
feature differences are depicted in Appendix A, CERTivity®s Features Matrix. The
price difference is depicted on our web site [http://www.edulib.com/products/keystores-
manager/purchase/];

e The license is per number of users and each user can use the software on more
machines;

« We offer volume discounts (per number of users) according to the information on our
web site;

« If the License Key (File) is for more users, as the file is the same, each user will have
to use that file to register the application;

« A License Key (File) covers a major version and all its minor upgrades (e.g. 1.0, 1.1,
1.2..., but not 2.0). The same License Key (File) will unlock all the minor versions. If you
purchased a license for a certain major version (e.g. 1.2) you don't have to purchase
licenses for any of the next minor versions (e.g 1.4) if the software is used by the same
users;

« If in less than 60 days after you purchase a License Key (File), a major release is out,
you are entitled to use the new major version for the category of license you bought. You
can download and use it as well as any further minor versions with the same License
Key (File);

CERTIivity 's Administrative
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« For new major versions (e.g. 3.0) existent users of the previous major version (e.g. 2.0)
will be able to upgrade their License Key (File) by purchasing that license at an important
discount.

« Changing your license category ("migrade") of a certain License Key (File) is possible by
paying the difference between the categories; this is available upon request by providing
us the previous details of the license;

« We offer a full 30 days refund.
2.5.1 Payment details

Our orders are securely handled by our e-commerce and payment partner Avangate [http://
www.avangate.com]. Avangate handles all the payment details in a safe and secure manner,
starting from using SSL channels for communication up to anti-fraud screening procedures.
Upon payment you will be redirected from our site to the Avangate site for the payment. You
will benefit from multiple payment methods, over 49 currencies and a localized user-friendly
store.

If you want to purchase a license for more users you will get a discount according to the one
specified on our web site [http://www.edulib.com/products/keystores-manager/purchase/].
The price is automatically adjusted in your shopping cart depending on the quantity you
select.

2.5.2 What do | get after payment

Our software delivery is electronic only. Even before the payment you can download the
suitable setup package of the last CERTivity version. Shortly after the payment you will get
via the e-mail the License Key (File) to activate your CERTivity copy - please store it in a
secure place, as you may need it for future installations. For instant payment methods like
Credit Card or PayPal, the delivery e-mail will be sent usually within a few minutes after an
order has been successfully completed. For payment methods such as Bank Transfer, check
or PayPal eCheck, the delivery will be done after the payment is confirmed (usually 2 to 3
business days).

For more details about the payment and the e-mail delivery you can read the Avangate -
Shoppers FAQ [http://www.avangate.com/help/customer-faqg.php].

You will use the License Key (File) that you will have been receiving via email to register your
CERTivity application. You may be in one of the following scenarios:

« On a certain machine, you have already installed CERTivity and run it registered with an
unexpired trial license. Then start the application and use the menu Hel p > Li cense
> Install License Key tochange the License Key (File) to the one that you just
purchased; the same scenario applies if you migrate from the Standard category to the
Professional category.

¢ On a certain machine, you have already installed CERTivity but the trial license has
expired. Then upon application start-up you will be prompted with an Install License Key
dialog. There you will provide the License Key (File) that you just purchased.

« You don't have any installation of CERTIivity on the target machine or you have other
previous major versions of CERTivity. Then you need to download and install the new
major version of CERTIvity. The installation is done in parallel, not overwriting the
previous version. After the installation, upon the application start-up you will be prompted
with an Install License Key dialog. There you will provide the License Key (File) that you
just purchased.
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If, at a later time, a new minor version is released you will just download and install it in
parallel and it will be registered with the same License Key (File). If you need to install the
new minor version on a different machine (used by the same user) you will need to provide
the License Key (File) that you initially received.
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3. CERTivity®'s Menus/Tool bar
3.1 File Menu

The File menu includes the following commands:
« New KeySt or e - Creates a new KeyStore;

« Open - Opens an existing KeyStore, an existing certificate, an existing CSR file, an
existing CRL file, Windows Root CA KeyStore, Windows User KeyStore, JREs CA
Keystores and the Samples Readme.txt file;

* Open Recent Fil e- Opens a file from a list of the most recently used files;

* I nspect Type - when accessed, detects the type of a file. The cryptographic file types
detected are:

« JKS KeyStore;

« JCEKS KeysStore;

* BKS KeyStore;

e BKS-V1 KeyStore;

* UBER KeyStore,

« PKCS#12 KeyStore or Key Pair;

* Certificate;

« Certificate Signing Request (CSR) of PKCS10 type;

« Certificate Signing Request (CSR) of SPKAC type;

« Certificate Revocation List (CRL);

» Encrypted Microsoft PVK Private Key;

« Unencrypted Microsoft PVK Private Key;

« Unencrypted OpenSSL Private Key;

« Unencrypted PKCS #8 Private Key;

« Encrypted OpenSSL Private Key;

« Encrypted PKCS #8 Private Key;

e OpenSSL Public Key.
e Save- Saves the current KeyStore, if it has been modified;
e Save As - Saves the opened KeyStore under a different name;
e Save All - Saves all the opened KeyStores;
e Exit - Exits the application.

Note that the features regarding the opening of the native Windows related are available only
if run on a Microsoft Windows platform.

A screenshot for the File Menu is given below:
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% Ci/Program Files (x86)/EduLib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity (=R
Edit KeyStore Signatures View Tools Window Help
i 3 = g & B
2/ Mew KeyStore Ctrl+N Al 2 By S E LEA il
Open b= Open KeyStore Ctrl+=0
Open Recent File I [ Open Certificate Ctrl+Shift=0 CHEE
Inspect Type Open CSR Ctrl+Shift=R -+ Generate Secret Key 1}5 SSL Certificates Retriever ﬂ’. Import Key Pair E Import Certificate
Save Ctrl+S OpSHERE 4 Last Modified Validity Status Trust Status
Save ds.. e U e e (Heel S i 2012-10-05T1 1005040300 Vaiid NJA
— Open Windows User KeyStore 2013-04-26T15:14:2140300  Valid n/A
Open IRE CA KeyStare 3 C:/Pragram Files (xB6)/Java/jre7 /lib/security/cacerts A
Exit Alt+F4 Open Samples Readme. bt C:/Program Files (86)/Java/jdkl.7.0_15/jre/lib/security/cacerts
g kp-dsaver3 DsA 512 2014-10-06T 1 0:39:20-+030) C:/Program Files (x&6)/Edulib/CERTivity/jre/lib/security/cacerts
-8y kp-md2rsaverl RSA 2048 2014-10-06T10:43: 11+030) Other...
‘B"' kp-md2rsaver3 RSA 2048 2014-10-05T10:47: 19+0300 T IO O T T T O T T O o
.y kp-mdSrsaverl RSA 2043 2014-10-05T10:49:044+0300 2012-10-05T12; 14:25+0300 Valid
‘B"' kp-mdSrsaver3 RSA 1080 2014-10-05T10:50:36+0300 2012-10-05T11:01:47+0300 valid
.y kpshalrsaverl RSA 2043 2014-10-05T152;25+0300 2012-10-05T11:01:47+0300 Valid
-8y kp-shalrsaver3 RSA 2048 2013-02-05T10:55: 12+0200 2012-10-05T12:14:39+0300 Expired
&y kp-with-expired-cert RSA 2048 2012-10-08T12:24:35+0300 2012-10-05T12:24:39+0300 Expired
g kp-with-ext DSA 1024 2014-09-04T13:12:15+0300 2012-10-05T11:07:54+0300 valid
B uleeds-udn-trust RSA 2048 2020-05-30713:45:33+0300 2013-04-26T15: 14 16+0300 valid A
Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

3.2 Edit Menu

The Edit menu includes the following commands:

Cut - Removes the currently selected entry from a KeyStore and places it in the
clipboard;

Copy - Copies the selected entry into the clipboard,;
Past e - Inserts the entry from the clipboard in the KeyStore;
Renane - Renames the KeyStore entry;

Del et e - Deletes the KeyStore entry.

These commands are also having their usual Keyboard Shortcuts by default.

3.3 KeyStore Menu

The KeyStore menu is available when a KeyStore is opened and includes the following
commands:

Change KeyStore Password - Changes the password of the store;

Vi ew Convert KeyStore Type - Views the current store type and gives the
possibility to change it ;

Gener ate Key Pair - Generates a new Key Pair;

Gener at e Secr et Key - Generates a new Secret Key - note that not all of the KeyStore
types are able to store Secret Keys;

I mport Certificate - Importa Certificate from a file into the KeyStore;

| rport Key Pair - Import a Key Pair from a file into the KeyStore;

SSL Certificate Retriever - Connects to a remote SSL socket (host and port)
and extracts the certificates used during handshaking. It is then possible to inspect and
import the certificates into the KeyStore.

A screenshot for the KeyStore menu can be seen below:
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% C:/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/PKCS12-KeyStore-Sample.pl2 - CERTivity

File Edit Signatures View Tools Window Help

a g 3
BiEXis I EHSn

ore-Sample.jce 5| |7 BKSKeyStore-Sample.bks 2] |3 UBERKeyStore-Sample.ubr 2 5 PKCS12KeyStoreSample.pl2 EEE

f=lE =]

7 E i Change KeyStore Password 5912123 B
Y3/ View /Convert KeyStore Type
7 K5Ke o

@ Generate Key Pair

2 Chan =+ Generate Secret Key

Entry Ali E Import Certificate

rert KeyStore Type  #-y Generate Key Pair -+ Generate Secret Key ‘3(3 SSL Certificates Retriever ﬂ}i Import Key Pair E Import Certificate

Expire Date Last Modified Validity Status Trust Status
G of S Import Key Pair Z013-09-03T15: 145040300 2013-05-0ITIS:04S240300  Vald N/A
- (3] df %) SSL Certificates Retriever 2013-06-25T19:49:3040300  2013-05-01T1S:04:5240300  Valid /A
[F digicertrootca RSA 2043 2014-07-26T21:15: 1540300 2013-05-01TIS:045240300  Valid N/A
18y kp-dsaverl DSA 896 2014-10-05T12:1 33740300 2013-05-01T1S:04:5240300  Valid

E![ﬁ Certificate Chain
-- El SampleDSAVerl
[F sampleDsavers

-8y kp-dsaver3 D5A 512 2014-10-06T 10:39:20+0300 2013-05-01T15:04:52+0300 Valid
&y kp-md2rsaver1 RSA 2043 2014-10-06T10:43: 11+0300 2013-05-01T15:04: 5240300 Valid
-8y kp-md2rsaver3 RSA 2048 2014-10-05T10:47:19+0300 2013-05-01T1%:04:52+0300 Valid
&, kp-mdSrsaver1 RSA 2048 2014-10-05T10:49:04+0300 2013-05-01T15:04: 5240300 Valid
-8y kp-mdSrsaver3 RSA 1080 2014-10-05710:50:36+0300 2013-05-01T1%:04:52+0300 Valid
-8y kp-shalrsaverl RSA 2048 2014-10-05T10:52:25+0300 2013-05-01T15:04:52+0300 Valid
&, kp-shairsaver3 RSA 2043 2013-02-05T10:55:12+0200 2013-05-01T15:04: 5240300 Expired
-8y kp-with-expired-cert RSA 2048 2012-10-06T12:24:35+0300 2013-05-01T15:04:52+0300 Expired
&y kp-with-ext DSA 1024 2014-09-04T13:12:15+0300 2013-05-01T15:04: 5240300 Valid
El uleeds-udn-trust RSA 2048 2020-05-30713:48:38+0300 2013-05-01T1%:04:52+0300 Valid NfA

Case Aware Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

3.4 Signatures Menu

The Signatures menu includes the following commands:

e Veri fy - validates the following types of files presenting verbose details; it is possible
to view and export the certificates embedded in the verified files.

1.JAR fil e - Validates a signed JAR file;
2.PDF fil e - Validates a signed PDF file;
3. XM fil e - Validates a signed XML file.

< Si gn the following types of files using the current Key Pair entry; disabled if no Key
Pair is selected. Also accessible from the contextual menu for a Key Pair. Specific sign
parameters are presented depending on the file type.

1.JAR fil e - Signs a JAR file using the current Key-Pair entry;
2.PDF fil e - Signs a PDF file using the current Key-Pair entry;
3. XML fil e - Signs an XML file using the current Key-Pair entry;
4.CSR fil e - Signs a CSR file using the current Key-Pair entry.

3.5 View Menu

The View menu includes the following commands:
e Tool bars - Is used to show or hide toolbar groups;

e Full screen - Allows application to run using the whole screen. The main toolbar will
be hidden during in this mode.

3.6 Tools Menu

Using the Tools menu, you can change:

» The application options (use Mai n Opt i ons);

CERTivity®'s Menus/Tool bar 16



* CERTivity

Trust Path Options;

Advanced Options;

Using the filter of the Options Panel, consisting of a text field in the top right corner of the
Options Panel, the matched tab from the available options is activated. The matching is based
on the name of the options and sometimes based on the values of the options.

3.6.1 Main Options

The Main Options of the application are the following:

L]

Certificate expiry notification period (default 30 days), meaning that if a certificates valid
interval ends before the current date + the notification period a certain visual element
will alert you;

RSA Key Pair default size (default 1024),- the default size for RSA keys which will be
used when generating a RSA Key Pair. Change it for your convenience;

RSA Key Pair max size (default 4096) - you won't be able to generate a key Pair having
more bits than this value. This prevents bigger values that would require a great CPU
time to generate;

Auto generated Certificate serial number max bit length (default 20);
Undo level - the number of undo levels for each opened KeyStore (default 20);
Log level;

Memory usage warning max threshold, meaning the percentage of used memory after
which a warning message will be displayed (default 90);

KeyStore persistence - the type of persistence for opened KeyStores when exiting
the application. CERTivity® can remember the KeyStores which are opened when the
application exits, and reload them again when the application is launched next time.
There are two options available:

» Persist only KeyStore file name - meaning that only the name (and path) of the
previously opened KeyStores will be remembered to be reopened on the next launch.
The passwords of the KeyStores will not be remembered, and you will be prompted
to enter the password for each of them when selecting each KeyStore tab first time
(recommended);

e Fully persist - meaning that the name and password of the KeyStores will be
remembered so that the KeyStore to be reopened when launching the application,
without prompting you for the passwords of the KeyStores. The passwords are stored
in an encrypted way.

Although the "Fully persist" option makes the application more friendly, use this option
with care and only when you are sure the machine is exclusively accessible by you;

Recent File list max size - sets the list maximum size for the most recently used files
(default 10);

JRE CA KeyStore list max size - sets the list maximum size for JRE CA KeyStore list
(default 10);

Certificates Retriever connection type - sets the connection type used when retrieving
certificates, the combo-box being populated with all connection types available for the
Java version used,;
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 Inspected and draggable file size limit (default 2048 KB) - sets the size limit for the files
inspected using the "Inspect File" action and for the drag and drop action.

3.6.2 Trust Path Options

The user has the possibility to set the TrustStores which should be used for establishing
trust when importing a certificate from different sources, when importing a CA Reply, or when
displaying the trust status for certificate entries in the KeyStore view. Also, the user has the
possibility to set a series of Trust Path validation options.

The Trust Path Options have 2 main categories:

¢ TrustStores Selection;

* Trust Validation Options.

3.6.2.1 TrustStores Selection
A TrustStore is basically a KeyStore which contains Trusted Certificate Entries.

CERTivity allows setting more TrustStores which can be chosen from the JRE CA
TrustStores discovered on the current machine, from the Windows Native KeyStores (if
running on a Microsoft Windows system), or from a custom KeyStore which you can select
that can act like a TrustStore. Also, you have the option to set as a TrustStore the current
active KeyStore. The current active KeyStore is the KeyStore which is opened and focused
at the moment of starting an operation (such as importing a certificate, importing a CA Reply,
etc.).

A screenshot of the TrustStores Selection panel which allows selecting one or more
TrustStores (as it can be seen), is depicted below:
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Main Options | Trust Path Options | adyznced Options Keymap Miscellaneous

TrustStores Selection | Trust Validation Dptions|

Werify Certificates Trust Path Using:
CA Certs KeyStores

IVM CA Certs

[¥] C:/fProgram Files/Javafidk1.7.0_45jreflb /security fcacerts
7l C:/Program Files/Javafidk1.7.0_09fireflibjsecurity fcacerts
[ C:/Program Files/Javajdk 1. 7.0_05fireflib/security fcacerts
[ C:/Program Files/Javajdk1.6.0_35fire/lib/security fcacerts

Windows KeyStores
Windows KeyStores

(] Windows-My
Windows-ROOT

Other KeyStores

Other KeyStores

[¥| D:fEdulib Projects certivity fapplication ftarget/certivity /doc/samples keystore [JKS-KeyStore-sample. jks

7l D:/EduLib Projects/certivityfapplicationftarget/certivity jdoc/samples keystore UBER KeyStore-Sample. ubr

[ Add KeyStaore ” Remove selected

[Bowt. ] [(Iwet. | [oc ) [aewhr ) [“com ) [tb ]

As it can be seen, there are 4 categories of TrustStores: CA Certs KeyStores, Windows
KeyStores, Other KeyStores and Current KeyStore. Each of these categories can be disabled
or enabled by clicking on the corresponding checkbox. The selections made within each
category will not be lost when unselecting the category from its checkbox.

In the situation in which some CA Certs KeyStores are not found anymore, they will not be
displayed when opening the Options panel.

To add a custom KeyStore, select Add Key St or e button. A file chooser dialog will be opened
and you will be able to select a KeyStore. Any type of KeyStore from the ones supported by
CERTivity can be selected here. To remove a KeyStore, select the KeyStore from the list
and press Renove sel ect ed.

For the new TrustStores that you add or select, you will be prompted to enter the passwords
of the KeyStores only if the KeyStores have not been opened in the current run of CERTIivity,
or if they are not currently opened. Also, you will be prompted to enter the passwords only
when they will be needed first time. For example, when closing the Options dialog by pressing
OK, if there is no KeyStore opened in background, you will not be prompted to enter the
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passwords of the new TrustStores that you selected right away. You will be prompted to enter
them when you will open a KeyStore, or a Certificate from file, or when performing any other
action which will need the TrustStores for trust validation.

Also, if the password of a TrustStore is changed from outside CERTIvity, you will be prompted
again to enter the password when that TrustStore will be reloaded from the file.

Note

When prompted to enter a password, if you select "Cancel" or you close the dialog,
the TrustStore will be unselected, and it will not be used again until you select it again
(goingto Options > Trust Path Options > Trust Stores Sel ection).

3.6.2.2 Trust Validation Options

When establishing the Trust Path for trust validation, there are more parameters which can
be taken in consideration. Some of them are configurable, and the user has the possibility to
set them according to his needs by going to the Trust Val i dati on Opti ons tab.

The Trust Validation Options panel looks like in the screenshot below:

! Options

e = G

G o) X G./a)
Trust Path Options| advanced Options

Main Options

(]

B m °

Keymap Miscellaneous

| TrustStores Selection | Trust Validation Options |

Options for Trust Path Validation:
[ Inhibit any policy

[] Explicit policy required

[] Inhibit policy mapping

[] Use revocation checking

Use policy qualifier processing
[] Use a path length constraint of: 5| certificates
[] Use this date for validation:
Provider Options:

(@) Use default provider

(7)) Use Bouncy Castle provider

2013-11-18T15:16:17+0200

m

[ Export... H Import... ]

[ OK H Apply H Cancel H Help

As it can be seen, the user can set the following options:

e Inhibit any policy

Default value: unselected;

If selected, any policy OID will be inhibited if it's included in a certificate;
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e Explicit policy required

Default value: unselected;

If selected, an acceptable policy needs to be explicitly identified in every certificate;
e Inhibit policy mapping

Default value: unselected;

If selected, policy mapping will be inhibited;

e Use revocation checking

Default value: unselected (using the Default provider), unavailable (using the Bouncy
Castle provider);

If selected, the default revocation checking mechanism of the underlying service provider
will be used (if the Default provider is selected and if the Default provider supports
revocation checking). The Bouncy Castle provider does not support revocation checking,
so this option is disabled for the Bouncy Castle provider. Also, in the situation in which
the Default provider option is selected and the only available provider is Bouncy Castle,
revocation checking will not work;

e« Use policy qualifier processing
Default value: selected;

If selected, the most common (and simplest) strategy for processing policy qualifiers will
be used.

e Use a path length constraint of n certificates
Default value: unselected,;

If selected, it sets the number of non-self-issued (non self-signed) intermediate
certificates that may exist in a certification path. The last certificate in a certification path
is not an intermediate certificate and it is not included in this limit.

A negative value set implies that the path length is unconstrained. This is equivalent with
unselecting the "Use a path length constraint of ..." check-box.

A value of 0 certificates implies that the path can only contain a single certificate.

The default maximum path length is 5.

Note

If the check-box is unselected, the value from the text field will be ignored and
the path length will be unconstrained.

e Use this date for validationF
Default value: unselected;

If selected, it sets the time for which the validation of the certification path should be
evaluated. If not selected, the current date and time (at the moment of performing the
validation) will be used.

CERTivity®'s Menus/Tool bar 21



* CERTivity

When setting a date, the entered date format must be ISO 8601.
The default value of the date field is the current date and time in ISO 8601 format.

Also, the user has the possibility to set the provider that will be used for Trust Path validation.
The user can choose either the default provider (which is the first provider from the system
where CERTIvity runs which supports the Trust Path validation operations), either the Bouncy
Castle provider. The Bouncy Castle provider supports almost all the Trust Path validation
operations with some limitations. It does not support revocation checking ("Use revocation
checking" option will be disabled). Also, if the default provider is selected but the only
available provider is Bouncy Castle, revocation checking will not work.

3.6.3 Advanced Options

Here are some advanced options that can be set to enhance some CERTivity features.

Caution

Keep in mind that you must be fully aware of what you are doing before modifying
these options, otherwise changes can lead to unexpected behaviour.

The Advanced Options panel looks like in the screenshot below:
1 Options @

@} 'E-E’;_,))/B =2 Q, |Filter (Ctrl+F)
o) ﬂ S (il
Main Options  TTust Path Options | ady=nced Options

Miscellaneous

JCE Unlimited Strength Jurisdiction Policy Files

Download URL: https/fuwewe . orade. comftechnetwork fjava fiavase /downloads fjce-7-download-432 124, himl

File download pattern: | .zip?AuthParam= AND

|Use Secure Validation for XML Signatures:

| Expart... || Import... | Apply | Cancel || Help |

The automatic JCE Unlimited Strength Jurisdiction Policy Files installation wizard needs
some parameters that can be set here:

 Downl oad URL

Specifies the link to the Oracle site from where the JCE Unlimited Strength
Jurisdiction Policy Files need to be downloaded. The page that displays from
following this link should have the link to the JCE files (e.g.: for JRE 7, the link
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is http://ww. oracl e. com t echnet wor k/ j ava/ j avase/ downl oads/j ce- 7-
downl oad-432124. ht ).

File downl oad pattern

Pattern identifying the direct authenticated link to the Java Cryptography Extension
(JCE) Unlimited Strength Jurisdiction Policy Files. When clicking on download, the
browser is redirected to other page, that is the final, authenticated direct download link
(e.g.: for JRE 7, the identifying pattern can look like this: ".zip? AuthParam=", because
the link is identifying a "zip" file and it has an "AuthParam" parameter). You can insert
multiple patterns. If so, they must be separated by a semicolon (; ). In case of using
multiple patterns, the operator that will be used between those patterns can be set here
(AND meaning all of the specified patterns must match or OR meaning only one of the
specified patterns must match).

Other settings:

Use Secure Validation for XML Signatures

When set to t r ue, this option instructs the implementation to process XML signatures
more securely. This will set limits on various XML signature constructs to avoid
conditions such as denial of service attacks.

When settof al se, the property instructs the implementation to process XML signatures
according to the XML Signature specification without any special limits.

Caution

Enabling this option when using Java version 1.7.0_25 or greater will lead to failure
when verifying detached XML signatures!

Note

For non Oracle JVM's or Java versions lower than 1.7.0_25 this option will be
disabled, since it has no effect, meaning that for Java versions lower than 1.7.0_25,
XML signatures are processed without any special limits;

3.6.4 Other Options

Defined KeyBoard shortcuts (use Keynap);
Appearance options (use M scel | aneous).

3.7 Window Menu

Using Window menu, you can run the following IDE related actions:

Cl ose wi ndow,

Maxi m ze w ndow,

Unl ock wi ndow;

Cl ose all docunents;

Swi tch between opened docunents;
Reset w ndow.

3.8 Help Menu

The Help menu includes the following commands:
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e Li cense - Allows installing a new license and viewing the installed license details;
* Hel p Contents - Access to CERTIvity Help;

< About - Provides minimal information about the application and system;

« Advanced Det ai | s - Provides detailed information about the system.

3.9 Advanced Details
The Help menu shows detailed information about the system:
e Security Properties;

The Security Properties panel looks like in the screenshot below:

o "

' Advanced Details ==

Security Properties | Java System Properties |

Policy Status

ICE Unlimited Strength Jurisdiction Policy Files installed: | false

Maximum allowed key sizes

Algarithm Key size

DES 64

DESede 2147433647

RC2 128

RC4 128

RCS 128

RSA 2147433647
Policy Files

C:\Program Files\Javaljdk1. 7.0_13\ireVib\securityocal_palicy.jar
C:\Program FilesUavaljdkl. 7.0_13YreVib\security U5 _expart_palicy.jar

View File

Browse Dir

Close

Here are displayed detailed information about the Java Virtual Machine's security
settings:

e Policy Status -what kind of Java security policy is installed on the system, if the
unlimited strength jurisdiction policy files are installed,;

It also provides a wizard for automatic installation of the unlimited strength jurisdiction
policy files. In order to use this feature, you must click on the "Install" button.
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Note

This feature is available only when using Oracle's Java Virtual Machine
version 1.7.0_13 or later on the platforms supporting JavaFX (for example
JavaFX is not supported on SunOS);

If the unlimited strength jurisdiction policy files are already installed on the
system, this button will be disabled.

An integrated JavaFX web browser window will be displayed and you will be driven to
the official Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy
Files Download page.

|2/ Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 7 Download o -E| ]

http: /fwww.orade.com/technetwork fiava fiavase (downloads fice-7-download-432124. html

Sign In/Register Help Country ~ Communities ~ |ama.. ~ |wantto.. ~ Search Q

ORACLE’

Products Solutions Downloads Store Support Training Partners About |OTN

Java SE Overview | Downloads | Documentation || Community || Technologies || Training LL00 L T

JavaEE 8 lava SF
va M - = = ¥
Java ME Java Cryptography Extension (JCE) Unlimited Strength # Java BE and Glzssfish
Java SE Support Jurisdiction Policy Files 7 Download ¥ dacalif
Java SE Advanced & Suite ¥ JavaFX
Java Embedded i . R I § JavaCard
Javarx 7Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 3 el DE
JavaDB ‘You must accept the Oracle Binary Code License Agreement for the Java SE Platform # Java Mission Contro
Web Tier to this
Java Resources
Java Card Accept License Agreement ®  Decline License Agreement & JavaAPls
Java TV S
& Technical Arlicles
Newto Java 3D
Community i =
[ Product ! File Description ;T; Download & Forums
ava Magazine
= ¥ Java Magazine
Java Cryptography Extension (JCE) Unlimited Strength 73K % z
Jurisdiction Palicy Files 7 UnlimitedJCEPolicy JOKT zip # Javanst
& Developer Training

The usage of these files is under the import restrictions of some countries, so it is the
user's responsibility to decide if (s)he is entitled to use them. Assuming you have the
rights to download these security files, you must click to accept the "Oracle Binary
Code License Agreement for the Java SE Platform Products" and then click on the
"zip" file to trigger the download the Java Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files.

The installation process is automatic, so no other action is required. At the end, a
message confirming installation will be displayed.

The installation process needs administrative rights, as it needs to write the new JCE
Unlimited Strength Jurisdiction Policy Files. If not, the process will fail, showing an
error message and instructions on how to manually write the policy files, but CERTivity
is still assisting you here:
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% Error @

I ~ ) CERTivity does not seem to have permission to write to java security folder (C\Program Files (x36)\Java'jdk1.7.0_45\jre\lib\security).
You will have to install the JCE Unlimited Strength Jurisdiction Policy files manually.

Far this, just copy the files from the "Ch\Users\ADRIAN~1\AppData\Local\TemptUnlimited) CE\UnlimitedJCEPolicy” folder to the
“C:\Program Files [x56)\Java'jdkl.7.0_45%jre\lib\security” folder, overwriting existing files.

These folders will be opened after you dlick "Cpen folders™,

Then you will need to restart CERTivity in order for changes to take effect.

After clicking "Open folders" button, two folders will be opened:

» The folder containing the new JCE Unlimited Strength Jurisdiction Policy Files which
were just downloaded from Oracle's site;

» The Java Security folder, where the old policy files are located.

You will have to manually copy the files from the first folder into the Java Security
folder, overwriting old ones.

Note

Remember to first make a backup of the old policy files, just in case you will
need them somewhere in the future.

After that, you will need to restart CERTivity in order for the changes to take effect.
You should now see, in the "Advanced Details" panel, that the Unlimited Strength
Jurisdiction Policy Files are installed, as in the screenshot below:
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' Advanced Details

{ Security Propertiesi| 1aya System Properties

Policy Status

Maximum allowed key sizes

1CE Unlimited Strength Jurisdiction Policy Files installed:

true

Install

Algorithm Key size
DES 2147483647
DESede 2147483647
RC2 2147483647
RC4 2147483647
RCS 2147483647
RSA 2147483647

Puolicy Files

C:\Program Files\Javaljdk1. 7.0_13YjreVib\securityYocal _policy.jar
C:\Program Files\Javaljdk1. 7.0_13YjreVib\security\US_expart_policy.jar

(G ] (b

« Policy Files - the system's currently installed policy files.

e System Properti es;

The System Properties panel looks like in the screenshot below:
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" Advanced Details @
| Security Properties | Java System Properties |

Java Home: |C:\Program Files\Javaljdk1. 7.0_13Yjre
Java Vendor: Orade Corporation
Java Vendor URL: |http:/fiava.orade.com/
Java Version: |1.7.0_13
Java Class Path: |D:\EduLib Projects\certivity\application\targeticer tivity \platformib\boot
05 Arch: |amd&4
05 MName: |Windows 7
05 Version: 6.1
IUser Dir: |D:\Edulib Projects\certivity\applicationtarget\cer tivity
User Home: | C:\Users\Adrian

IUser Mame: |Adrian

Close

Here there are displayed detailed information about the system such as the Operating
System properties and Java Virtual Machine's properties:

e Java Hone - path to the currently used Java Virtual Machine;

e Java Vendor - name of the vendor of the currently used Java Virtual Machine;
* Java Vendor URL - URL to the vendor's site;

e Java Ver si on - the version of the currently used Java Virtual Machine;

« Java O ass Pat h - class path of the currently used Java Virtual Machine;

* OS Arch - architecture of the installed Operating System;

e OS Nane - the name of the installed Operating System;

e User Dir -the current user directory;

e User Hone - home directory of the currently logged user;

* User Nane - name of the currently logged user.
3.10 Contextual Menu

Each KeyStore entry or sub-component has a contextual menu associated with it. Items such
as rename and delete are commons to most entries, but for a clear picture all the available
actions are specified below depending on the entry.

» Certificate entry: Cut, Copy, Paste, Rename, Delete, Export Certificate, Export Public
Key;
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T C:/Program Files (x86)/Edulib/CERTivity/doc/ pl ! /PKCS12-KeyStore-5: le.p12 - CERTivity
File Edit KeyStore Signatures View Tools Window Help

T EA DR D M EEEX L W ES

3] JKSKeyStore-sample.jks 5| | JCEKS-KeyStore-Samplegce 8| |2 BKS-eySta ple.bks %[ 5 UBER-KeySto ple.ubr 5] [3) PRCS L2-KeyStore-Sanple.p1z_ x| (AH[=][E)

|3 Change KeyStore Password {3 View / Convert KeyStore Type 8- Generate Key Pair 5+ Generate SeactKey %) SSL Certificates Retriever  #% Import Key Pair  [B] Import Certificate

Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
El delicious.com RSA 2048 p-+-0300 2013-05-01T15 38+0300 Walid Not Trusted
El digicert root ca RSA 2048 0300 2013-05-01T15:13:33+0300 Walid Trusted
Ay kp-dsaverl DSA 826 Paste 40300 2013-05-01TIS!13:33+0300  Valid

i &y private Key
EHE Certificate Chain
(5] sampleDsaver1
(5] sampleDsavers Export

&y kp-dsaver3 DSA 512 List Options »HO300 ZOLFOS-OITISIIZIG+0300  Vaid

Rename

Delete

&y kp-md2rsaver1 RSA 2048 OI4-10-06TI0 43 T1+0300 2013-05-01T15:13:29+0300 valid

&y kp-md2rsaver3 RSA 2048 2014-10-05T10:47: 1540300 2013-05-01T15:15:27+0300 valid

Ay kp-mdSrsaveri RSA 2048 2014-10-05T10:49:04+0300 2013-05-01T15:13:27+0300 Walid

4y kp-mdSrsaver3 RSA 1080 2014-10-05T10050:36-+0300 2013-05-01T15:13:27+0300 Walid

&y kp-shalrsaver1 RSA 2048 2014-10-05T10:52:25+0300 2013-05-01T15:13:27+0300 valid

&y kp-shalrsaver3 RSA 2048 2013-02-05T10:55: 1240200 2013-05-01T15:13:27+0300 Expired

g kp-with-expired-cert RSA 2048 2012-10-06T12:24:35+0300 2013-05-01T15:15:27+0300 Expired

Ay kp-with-ext DSA 1024 2014-09-04T13:12: 1540300 2013-05-01T15:13:27+0300 Walid

@ uleeds-udn-trust RSA 2048 2020-05-30T13:43:36+0300 2013-05-01T15:13:27+0300 walid Trusted

Case Aware Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 1 selected

« Key Pair entry: Cut, Copy, Paste, Rename, Delete, Change Password, Export Key Pair,
Export Private Key, Export Certificate Chain, Generate CSR File, Import CA Reply, Sign
Certificate by <aliasForlssuer>, Extend Validity, Select CA Issuer, Sign CSR file, Sign
XML file, Sign PDF file, Sign JAR file;

% Cy/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/BKS-KeyStore-Sample.bks - CERTivity [=x
File Edit KeyStore Signatures View Tools Window Help

TGO DE KB Xk e TSl

|7 JKS+KeyStore-sample.jks B‘ 1) BKS-KeyStore-Sample.bks H‘ m@ @
5 Change KeyStore Password {3 View / Convert KeyStore Type &g Generate Key Pair 5+ Generate SecretKey U5 SSL Certificates Retriever &% Import Key Pair (5] Import Certificate
Entry Alias & Key Type Expire Date Last Modified Validity Status Trust Status
n I ] o R -
@9 kp-dsaver3 DSA 512 @ ali) 2012-10-05T1 Valid
o
g kp-md2rsaverl RSA 2048 s i) 2012-10-05T11: Valid
Pasti Ctrl+V |
Ay kp-mdarsaver3 RSA 2048 e i 00 E01Z-10-05TIL: Valid
Ay kp-mdsrsaver1 RSA 2048 Rename 00 2012-10-05TLZiG: Valid
@ kp-mdSrsaver3 RSA 1080 Delete oo 2012-10-05T11;08; Valid
@9 kp-shalrsaverl RSA 2048 Change Password i) 2012-10-05T11: Valid
- kp-shalrsaver3 RSA 2048 o0 2012-10-05T12: 16z Expired
Ay kp-nith-expired-cert  RSA 2048 Export MO0 2012-10-05T12:25: Expired
g kp-nith-ext DSA 1024 Regenerate Key Pair 00 2012-10-05TL1: Valid £
e sk-aes Secretiey Generate C3R File 2012-10-05T11:
<o skearcfour Secretkey Import CA Reply 2012-10-05T11:
gk sk-blowfish Secretiey Sign Certificate by <.> 2012-10-05T11:
- Secretie: 10| fi=H
e sledes SeretEy Certificate Chain Actions 3 Z1E-AR-DeTLL
e sk-desede Secretkey 2012-10-05T11:08:32+0300
Extend Validity
g% sk-hmacmd5 Secretkey 2012-10-05T11:08:32+0300 L
g sk-hmacshal Secretiey Select CA Issuer 2012-10-05T11:08:32+0300
~igk sk-hmacsha2ss Secretkey sign 3 2012-10-05T11:08:32+0300
~-ige skhmacsha3s4 Secretiey List Options o 2012-10-05T11:06:32-+0300 -

Case Sensitive Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 1 selected

« Certificate Chain entry:Export Certificate Chain, Certificate Chain Actions;
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% Cy/Program Files (x86)/Edulib/CERTivity/doc/samp

File Edit KeyStore Signatures

.y /IKS-KeySt

View Tools Window Help

le jks - CERTivity

T E R D@ M MEBEEX L A RS

|5 JKS+eyStore-sample.jks BI‘ 3| BKS-KeyStare-Sample.bks l‘

LHEBE

|3 Change KeyStore Password {3 View / Convert KeyStore Type 8- Generate Key Pair 5+ Generate SeactKey %) SSL Certificates Retriever  #% Import Key Pair  [B] Import Certificate

Entry Alias 4

(5] certwith extensions
(5] delicous.com

E| digicert root ca
-8y kp-dsaverl

H e Private Key

g kp-dsaver3

9 kp-md2rsaverl
4y kp-mdarsaver3
4.y kp-mdSrsaver1
@9 kp-mdSrsaver3
‘- kpshalrsaverl
Ay kpshalrsaver3
4y kpwith-expired-cert
.y kponith-ext

‘[ uleeds-udn-trust

Key Type
RSA 1024
RSA 2048
RSA 2048
DSA 896

Expire Date

2013-09-03T15:14:50+0300
2013-08-25T19:49: 3040300
2014-07-26T21:15:15+0300
2014-10-05T12:13:37+0300

@ Certificate Chain

Copy
Paste

Export Certificate Chain
Certificate Chain Actions

List Options

FO6T10:39:20+0300
FOETL0:43:11+0300
FOSTL0:47: 18+0300
» (FOSTL0:49:044+0300
» [-05T10:50:36+0300

Crl+v

RSA 2095
RSA 2048
RSA 2048
DSA 1024
RSA 2048

OT-T0-05T10:52:25-+0300
2013-02-05T10:55:

2012-10-06T12:
2014-09-04T13:
2020-05-30T135:48:38+0300

Last Modified

2012-10-05T11:00:50+0300
2013-04-26T15: 14:21+0300
2012-10-05T11:00:29+0300
2012-10-05T12:13:46+0300

2012-10-05T11:01:47+0300
2012-10-05T11:01:47+0300
2012-10-05T11:01:47+0300
2012-10-05T12: 14:25+0300
2012-10-05T11:01:47+0300
2012-10-05T11:01:47+0300
2012-10-05T12: 14:39+0300
2012-10-05T12:24:39+0300
2012-10-05T11:07:54+0300
2013-04-26T15:14:16+0300

Validity Status
valid
Walid
Walid
Walid

Walid
Walid
valid
valid
Walid
Walid
Expired
Expired
Walid
walid

Trust Status
Trusted
Not Trusted
Trusted

Trusted

Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

Private Key entry:Export Private Key.

! C:/Program Files (x86)/EduLib/CERTivity/doc/ pl

File Edit KeyStore Signatures

ystore/IKS-KeyStore-

View Tools Window Help

lejks - CERTivity

=]

Sl LN BT Y HEA R SO S N O e

3 JKS+eyStore-sample ks | = BKSKeyStore-Sample.bks 5|

HEE

3/ Change KeyStore Password {3 View [ Convert KeyStore Type & Generate Key Pair -+ Generate Secret Key &y S5L Certificates Retriever aﬁ Import Key Pair E Impart Certificate

Entry Alias 4

(5] certwith extensions
‘[3 delidous.com

-[E digicertroot ca
18y kp-dsaverl

Private Key
[F certificate Chain
g kp-dsaver3

4y kp-mdarsaverl

4.y kp-md2rsaver3

@9 kp-mdSrsaverl
- kp-mdsrsaver3
Ay kpshalrsaverl
4y kpshalrsavers
2.9 kp-with-expired-cert
Mg kp-nith-ext

[E uleeds-udn-trust

Key Type
RSA 1024
RSA 2048
RSA 2048
D5A 896

Export Private Key
List Options

RSA 2048
RSA 2048
RSA 2048
RSA 1080
RSA 2048
RSA 2048
RSA 2048
DSA 1024
RSA 2048

Expire Date
2013-09-03T15:14:50+0300
2013-08-25T19:49:30+0300
2014-07-26T21:15: 15+0300
2014-10-05T12:13:37+0300

2014-10-06T10:39:20+0300
2014-10-06T10043: 1140300
2014-10-05T10:47: 1940300
2014-10-05T10:49:0440300
2014-10-05T10:50:36-+0300
2014-10-05T10:52:,

2013-02-05T10:
2012-10-06T12:

2014-09-04T135:12:
2020-05-30T13:

Last Modified

2012-10-05711:00:50+0300
2013-04-26T15:14:21+0300
2012-10-05T11:00:23+0300
2012-10-05T12: 13:46+0300

2012-10-05T11:01:47+0300
2012-10-05T11:01:47+0300
2012-10-053T11:01:47+0300
2012-10-05T12:14: 2540300
2012-10-05T11:01:47+0300
2012-10-05T11:01:47+0300
2012-10-05T12: 14:39+0300
2012-10-05T12:24:39+0300
2012-10-05T11:07:54+0300
2013-04-26T15: 14:16+0300

validity Status
Walid
Walid
Walid
valid

Walid
valid
valid
Walid
Walid
Walid
Expired
Expired
walid
Walid

Trust Status
Trusted
Not Trusted
Trusted

Trusted

Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

3.11 Toolbar

The Tools toolbar provides a quick method for invoking tools for using in the application. The
toolbar items are grouped in certain categories that can be disabled or enabled using the
Vi ew > Tool bar s menu option:

Icon

Action

Category

Creates a new KeyStore.

Opens an existing KeyStore.

&

Opens an existing Certificate as Standalone.

File

CERTivity®'s Menus/Tool bar
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Saves the active document.

Saves all documents.

Undo the last action, if possible.

R I & O

Redo allows commands that have previously been
undone with the Undo to be redone.

Undo/Redo

Removes the currently selected data from the active
document and put it on the clipboard.

Copies selected data onto the clipboard.

Inserts a copy of the clipboard contents at the insertion
point.

Clipboard

Changes the alias name for the KeyStore entry.

X & @ ¥

Deletes the KeyStore entry.

Edit

Changes the KeyStore password.

Converts the KeyStore type.

Generates a Key Pair.

T

Generates a Secret Key.

[

Retrieves Certificates from SSL.

Imports a Key Pair.

= F

Imports a trusted Certificate.

KeyStore

A memory usage toolbar icon showing the current memory and the current maximum memory
of the Java Heap is also present. When clicking on it, you can force the garbage collection.

A Quick Search function for Actions, Options and Help items is available, by default, in the
Toolbar area, helping one to identify an item based on its name. The Quick Search feature
at the application level, consists of a text field in the top right corner. As a search string is
typed in the field, a drop-down list appears, showing matching items. The items come from
the names of actions, options registered in the application and help topics in the application's
JavaHelp. When an action item is selected, the action is invoked; when an option item is
selected, the options dialog is displayed; when a help item is selected, the topic opens in

JavaHelp.

Besides the main toolbar, the application provides a secondary toolbar on the KeyStore tab,

for quick access.

CERTivity®'s Menus/Tool bar
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4. CERTivity®'s Certificates

4.1 Open Certificate

A Certificate embeds a public key belonging to an entity. It certifies the public key and all the
information via digitally signature of another entity (the issuer, e.g. - a person, company, etc.),
saying that the embedded public key (and some other information) belongs to the declared
entity (the subject) and has some specific value. That is why it is also called a Public Key
Certificate. The certificate is usually signed by a trusted Certification Authority (CA) or it can
be self signed.

CERTivity can handle X.509 certificates types, both version 1 and 3.

In order to open a standalone existing certificate, click on Menu File > Open > Open
Certificate. After the certificate file (with .cer or .crt extension) is selected, it will be
opened in a new tab which is named after the certificate's file name. There is drag and drop
support for certificate files on Microsoft Windows and Linux platforms.

Most recently used certificates can be found using Menu File > Open Recent File.
A simple click on the desired certificate in the menu, will open the certificate in a new tab. If
the certificate has been already opened, the certificate's tab will be activated.

If the file opened using Menu File > Open > Open Certificateor Menu File
> Open Recent Fil e contains more than one certificate, then in the left part of the new
tab opened these certificates will be displayed in a tree view reflecting their hierarchy. When
a certificate is selected in the tree view, the information associated with it will be displayed
in the right part of the window.
The following certificate details will be displayed:

* Format;

* Version;

 Serial Number;

< Validation date period;

¢ Public Key;

« Signature Algorithm;

¢ Subject/Issuer;

e« Common Name (CN);

¢ Organization Unit (OU);

¢ Organization Name (O);

¢ Locality Name (L);

e State Name (ST);

e Country (C);

e Email (E);

* Trust Status;

e MD5 Fingerprint;
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SHA1 FingerPrint.

In the certificate window details the following actions are available:

Test on Custom Protocol - which will open a new window for testing the certificate against
a raw TCP/IP connection with the possibility to send text requests;

Get Revocation Status - which will open a dialog to check the revocation status;

View Associated CRL - which will open a new tab to view the entire Certificate
Revocation List associated to the certificate in case one is available in the certificate
extension;

Open public key - which will complete the window with details about the public key
(algorithm, key size, modulus, public exponent, ASN.1);

PEM - which will open a new window containing the PEM representation of the certificate;

ASN.1 - which will open a new window containing the ASN.1 representation of the
certificate.

Display more certificate fingerprints - which will expand the list of certificate fingerprints
by adding to the list the fingerprints of a certificate in the following hashes: MD2,
MD4, RIPEMD-128, RIPEMD-160, RIPEMD-256, SHA-224, SHA-256, SHA-384 and
SHA-512.

Display less certificate fingerprints - which will collapse the list of certificate fingerprints
by removing from the list the fingerprints of a certificate in the following hashes: MD2,
MD4, RIPEMD-128, RIPEMD-160, RIPEMD-256, SHA-224, SHA-256, SHA-384 and
SHA-512.

The details above, the actions and the display format are mostly the same when a Certificate
is visualized from a KeyStore tab, either as a KeyStore entry or as a Key Pair entry sub-
component, only that the information will appear in the Details Panel and depending on
the resolution it might be scrollable and the Public Key Details will not be visible from the
beginning in the view from KeyStore, but rather after opening it.

CERTivity®'s Certificates 33



 CERTivity

T3 D:/sampleMultipleCertificates.cer - CERTivity
File Edit KeyStore Signatures View Tools Window Help

12 G B

L HE=R® L

|:‘| Readme txt = E| sampleMultipleCertificates. cer x‘

Q Test on Custom Protocol E Get Revocation Status @ Wiew Assodated CRL

[EIEY|E9)

=

. Certificates

F: Certificate Chain
E SampleDSAVer3

G SampleDSAVer 1

Format: Version:
X.509 3

Serial Number:

OXEFACL B

valid from:
2012-09-03T15:14:50+0300
To:
2013-09-03T715:14:504+0300
Public Key:

RSA 1024 bits

Extensions:

Autharity Key Identifier, Basic Co Open

Signature Algorithm:
MDSWithRSA

Certificate Fingerprints

Subject [ Issuer (self signed certificate):

O=SampleCertificate Organization Name,OU=SampleCertificate On E

Common Mame (CN):
Organization Unit (OU):
Organization Name (0):

Locality Name (L):
State Name (ST):
Country (C):

Email (E):

Trust Status:

Trusted

MD5 Fingerprint: | 99:09: 1E:51:90: 1F:BA:0B: 28:D0:C5:09:33:DE:F5:CF

SHA1 Fingerprint: | 03:E8:49:D4:AD:01:11:02:85:D5:E8: 18:35:FA:95:09:E5:FA: 7A:8D

More ...

SampleCertificate With Extensions
SampleCertificate Organization Unit

SampleCertificate Organization Name

® &

Public Key Details

Algarithm:
RSA

Fields:

Key Size:
1024

ASM. 1 -

Modulus

0xCZ4337F753307FCO046C44E373EDZ 1CFACARESE1SFC4964BERSR0ZR3537Z
Public Exponent ||BB31D35D42C7DB260DF74415815C8FC0CELCD213026C837D56CEFFECSITED
FSERE1REE04263D36369ETDSD3157422151 2 GESRC4EIS01ERDRESA144 7702

DER Sequence

DER Sequence
ObjectIdentifier(1.2.840.
NULL

DER Bit String(140, 01
30818902818100c24937£7539

o A5EAA0 a0 dn

Note

You can use certificates examples provided in the distribution kit in doc/ sanpl es/
certificat e folder, to test the certificates features.

4.2 Get Revocation Status for a Certificate

Checking certificates for revocation excludes the possibility that an application or user
will accept credentials that have been revoked by a Certification Authority administrator.
A certificate is considered valid until its expiration date. However, various circumstances
may cause a certificate to become invalid prior to the expiration of the validity period.
Such circumstances include change of name, change of association between subject and
Certification Authority and compromise or suspected compromise of the corresponding
private key. Under such circumstances, the issuing Certification Authority needs to revoke
the certificate. In order to get the revocation status of a certificate, open the certificate (click
onMenu File > Open > Open Certificate)andclickonGet Revocation Status

button.

CERTivity®'s Certificates
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-

Get CRL Revocation Status @

Certificate Revocation List Source:

@ Use information from certificate extensions

Use file:

Use URL:
Protocols supported: HTTR, HTTPS, FTP and LDAP.

[ 0K ]| Cancel || Help |

When checking the revocation status of a certificate, the following situations may be found:

* The certificate has been revoked;

The certificate has not been revoked;

No revocation information found;

Invalid revocation information found;

An error was encountered while trying to retrieve the revocation status of the certificate.
* Information @

[0]

— The certificate has not been revoked,

4.3 View Associated CRL for a Certificate

While in the certificate details window, the user can view the Certificate Revocation List
associated to the selected certificate. In order to view the certificate revocation list associated
to a certificate, open the certificate (clickon Menu File > Open > Qpen Certificate)
and click on Vi ew Associ at ed CRL button. Note that the Vi ew Associ at ed CRL button
is inactive if the certificate for which the user wants to view the associated CRL does not
contain extensions.

When viewing the certificate revocation list associated to a certificate, the following situations
may be found:

« The certificate revocation list associated with the selected certificate is opened in a new
top component window;

« An error was encountered while trying to retrieve the list of CRL distribution points URLs
from the certificate;

* There are no CRL distribution points available for the selected certificate, therefore the
action will end with an warning message;

< An error was encountered while trying to retrieve the certificate revocation list;

< An error occurred while trying to load the certificate revocation list;

CERTivity®'s Certificates 35



* CERTivity

An 1/O error occurred and the certificate revocation list could not be read;

The list of CRL distribution points associated with the selected certificate does not
contain any CRL URLs, hence the action will end with an warning message.

4.4 Test Certificate on Custom Protocol

In order to test or use a certificate against a certain TCP/IP raw text connection, you have to
open it first (click on Menu File > Open > Qpen Certifi cate). After the certificate is
opened, click on Test on Cust om Pr ot ocol on top of the page.

This action will open a new top component window (named "Test Certificate Window"),
containing the details needed for testing the certificate. The name of the tested certificate will
be written in the "Currently used certificate" field. The certificate can be changed from a file
chooser by clicking on Br owse button.

This functionality is also available for a certificate that is part of a KeyStore.

In order to use the certificate for the secure connection, the following server connection
details must be filled in:

server name;
server port;

connection type;

secure connection type;

the charset used for the request;

client authentication (KeyStore file - can be chosen using Br owse button; KeyStore
password; key pair password, alias). If a Private Key alias will not be provided the default
Java selection behaviour of the private key from the provided KeyStore will be used.

The connection to the server can be initiated, closed or upgraded using the corresponding
buttons on the page - the buttons changed their state accordingly.

The test window has other three areas for:

request details area - the location where will be introduced the specific request details.
A request will be sent to the server only after clicking on Send r equest button. Note
that some protocols require line terminators for delimiting the requests. These should be
added manually and the button Send Request must still be pressed.

e response area - where the response from the server will be displayed;

e SSL communication information area - where SSL information will be displayed.
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(@) Secure
Connection type:

) Character set for request: .Syshem Default
() Upgradeable plain :

-

Secure connection type: @) S5L () TLS [ Use dient authentication
Client authentication
KeyStore File: Browse
KeyStore password:
Private Key alias:
Private Key password:
Close connection Upgrade connection

Reguest details:
Request

Send request

% Test Certificate Window - CERTivity [r= -3z
File Edit KeyStore Signatures View Tools Window Help
15558 29y @GR L3 o Yy R
[ Readme. txt ﬁl E| jira.cer le[QTest Certificate Window ss| m E @
Currently used certificate: |CA Cert Signing Authority
Server connection details: Response:
Connecting to server: jira.edulib.ro On port: | 443

S5L comunication information:

=>> Connecting to jira.edulib.ro:443...
=>> Connection established to
jira.edulib.ro:443.

=>» Handshake completed successfully.

[VERBOSE]: Handshake Information
follows...
Cipher Suite in use is:

TLS_RSA_WITH_AES_128_CBC_SHA.

=>» Initializing connection. .. !

»

Verbose

You can also test connections that starts on plain and then upgrades to SSL. For example
testing a STARTTLS connection type for a SMTP server would be done according to the

following scenario:
1
2

. Configure server connection details;

details if necessary;

3.Press Connect to Server;

Don't forget to add the line terminators before pressing Send r equest ;

press Ent er, then Send request;

. If the server responds with 220 2.0.0 Ready to

start

. Select Connection type to be Upgradeable plain. Configure client authentication

. Start the handshaking plain messaging by issuing the necessary text commands.
. Empty the request window (e.g. select all with Ct r| +A and write STARTTLS and

TLS or similar press

Upgrade Connection. The connection will be switched to secure and the certificate

provided will be used for this;

. Continue messaging on the secured connection.
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4.5 Certificate's Representations

When opening an existent certificate, you can see two representations for the certificate:
* PEM;
« ASN.1.

4.5.1 PEM

representation for an existing certificate, open the certificate (click on Menu Fil e > Open
> Open Certificate)and click on PEMbutton.

You can copy the content of the PEM certificate representation by clicking on Copy button.

' Certificate PEM Representation @

[

MITHPTCCESWgAwIBLgIBRADANEgkghkiGaw0BAQOFADBS
IENBME4wHAYDVOOLExVodHRwD1 Bvd 3d 3 LmNh Y 2 VydChw
IENlenQgU2 lnbmluZ yBEBAXRob3 JpdHkxITAfBgkghki®s
YZFjZXI0LmayZzheFwiwMzhzMzAxMjISNDlaFwlzMzRz| =
BgNVBAoTBl Jvb30gl0ExHjAcBgNVBASTFHhOdHAGLYS3
MCACRIUEARMZIQOEgGRZVydCBTaWduaWsnIEF1dGhveml O
AR¥Sc3VweGapdER I YWN 1 onQub3 TnMIICIjANBgkghkis
CgEChgERAziTA4kZS7D¥oBlCHEqR=0IxLATtmPzHlawIz2
SBLPRoZ=YLdufujAWESuzbCtRReMY / pnCujWHir8+553E
SHYyN3LE9w I 1xBlYy¥TnDl7glvacoRQRFHyChFtkZips
fklWpRPsetgSngxEQRSYYEUFZvw i ARLAL1BACEgw3ZWiY
WwZtEiPGweswlHyCRTBY¥CEoS8yeReYSHNDHES4CHEE 4 JZwE
GEYO£2/JHIJeBVgrCFvz0FRErFllmyZ j¥nhCLotlddJe3
epEwlplUeb+agRThHgtdBTUg3EvEXG40EDyTYCEZZ160E
laegwlSTpfvbilEinkLDvhE+LIGE1i5Z4rSDTiigaPeb
QUxPEZgh/TMfdOwETf0Zd 9wUFBzugcMd3Z2i3alaRIt0A
falfrejrckezkeVLIL+apl fEEQRARBIeF1ITel YwlnPkER

-

4 1] 3

I Copy H Close H Help I

4.5.2 ASN.1

Abstract Syntax Notation One (ASN.1) is a standard and flexible notation that describes data
structures for representing, encoding, transmitting, and decoding data. DER(Distinguished
Encoding Rules) is a subset of Basic Encoding Rules (BER) is used in situations when a
unique encoding is needed, such as in cryptography and ensures that a data structure that
needs to be digitally signed produces a unique serialized representation.

In order to see the ASN.1 representation for an existing certificate, open the certificate (click
on Menu File > Open > Open Certificate)and click on ASN. 1 button. You can
copy the content of the ASN.1 certificate representation by clicking on Copy button.
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"' Certificate ASM.1 Dump (25

»

DER Sequence
DER Sequence
Tagged [0]

Integer(Z)

l.m

Integer (0]

DER Seguence
ObjectIdentifier (1.2 _540.113545. "
NULL

DER Seguence
CER Set

DER Seguence
ObjectIdentifier(2_5_4_1(
PrintabkleString (Root CA)

LER Bet

DER Seguence
CbjectIdentifier{Z.5.4_1:
PrintableString(http://wm

DER Set

| Copy H Close ” Help |

4.6 Certificate's Public Key

In order to see more detail information about a certificate's public key, open the certificate
(clickonMenu File > Open > Open Certificate)and click on Open button located
near the Publ i ¢ key field. The Public Key Details will be displayed in the bottom part of
window. There you can find information about:

« algorithm;
« key size;

* ASN.1;

* modulus;

 public exponent.
4.7 Certificate Signing Request

A Certificate Signing Request (CSR) consists of a distinguished name, a public key,
and optionally a set of attributes, collectively signed by the entity requesting certification.
Certification requests are sent to a certification authority, which transforms the request into
an X.509 public-key certificate.

The most widely used syntax for a CSR is defined by the PKCS#10 specification. Another,
far less common CSR format is the Signed Public Key and Challenge (SPKAC) format, which
was defined by Netscape for use inside their browsers.

It is possible to encode a PKCS#10 CSR in binary or text formats. The text or PEM (Privacy
Enhanced Mail) formatted CSR is the binary CSR after it has been Base-64 encoded to
create a text version of the CSR. It also includes additional header and footer lines which
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enclose the Base-64 and provide an indication of the content. See below an example of an
PEM encoded CSR:

————— BEG N CERTI FI CATE REQUEST- - - - -

M | CWI'CCAhk CAQAWD DEWWVBQGAL UEAWWNUZ Ft ¢ Gx | RFNBVIMVY MTE0 MCYGAL UEOwm
U2Ft cGxI RFNBVmVy MSBPc nhbni 6 YXRpb24gVWspd DEoMCYGATUECgW U2Ft ¢ Gxl
RFNBVVy MSBPcmdhbm 6 YXRpb24gTnt ZTCCAYEwggE! Bgcghkj OOAQBM HBANEA
i NTi phpbWQwggdf kTCIc/ r ggs/ keJUpQuWKogbxHBr AxJYSi f Upnel ej xul yO3VR
gt 5medn36ngZnOLPAVOP7| q9R0+x O+PoZBVD8bs+We/ eb/ SH+/ kzpaR5ez5WA t m
w TgM 6j 5YniYNdP02l algQ VAl JQzWXRB24cxbnFLquobenh30ygr AnAi pl ep41Z4
MXA t h5S9F3YI npgVzFOAZy x| YEbNuP9DoRe8VJ SKaQpy XMEBHNUI 5h+onxuMApg
Yj NAVOwa3/ kgowd8wbe8h3DvKi Xl Kl 4t j SkBOSSVLT/ cN+i r aO7JPI C/ P5cbTQy2
SYa7r f Te/ ycLASMAANAW | F8yI 4+01bj pVQ+6kchHpULI 8DYXh7NE4TPkBokb5dH
Zl sEbDbF501 7nSSKPSLr Hh5cf j 001aYxXYoCkLMLua+FNKnnl cEEN4z/ CLOGLZLxX
76W/ a+z 10WFr zaZ+LhZal 5QuXVPoi Kn8zZSA Vf o CEwHwYJKoZI hvc NAQKHVRI M
EHNhbXBsZS1j aGFsbGVuZ2UwCQYHKoZI zj gEAWMY ADAs AhQTY7AYt pdMX3aJ MW 4h
8F2dNOXa/ Q URPf 9ef xkDwPbdbW 3| dAgeFj Emv=

————— END CERTI FI CATE REQUEST- - -- -

See also a CSR file in SPKAC format:

SPKAC=M | CQz CCASswggEi MAOGCSqGS| b3DQEBAQUAA4| BDwWAWggEKAoI BAQCdYpr 9Vj a/ ui 3

oyaJpRbgXXNBYSy2x33i yM2Jj HTagQLNu6Wy/ LVOSCh0DQZt MbH 2D/ f Hr | 8Bpnj q3LZHWPbcl T8f j +yzi VkadCf nNkk
QGUUEx+Dc8aSj Hukl f 3wx YPt nEPZTbxf mPf wog1oLGxVk3I JI EPnoCz9gG FMRG agoBgWe9aTDOTu8Xv mBHe GOWNFf Bn
Q+PMpVLWGT UKMAUVHWPYRLj Az4EQ4YhXp108MS2AuV1q2TH HUNWRBK 4f v O4f Vn7EdpVAdGPpr M | egn9SY+45M | Twf R
sl Ag8PEd2Pr / r 5Lr yt k10DRbYvOPQuUk9A2pr 4c TEsr vxUvokpf AgMBAAEWAZ Ey Mz ANBgk ghki GOWOBAQ FAAOCAQEAW 8
I M xz0Q00sN1d6VFAcbVGyxg+mQAl 5p/ eTpBny2nf i C/ eMIUKES8t 2Vnr V7j 1QCNg/ v2Adnf ZOuFCBSwby 2sPLi pWgF9j i
vSn1HG 8bTgi W2KTLCOf 0Qf RzppFr 1ROp5Lj | z4cOBoPf | P/ JDUWPI bkehOx+H Ej 1TZ5R5Bd821 GvDCObyal4j csNvbSWa
i hoi kot Rr eKOakf Zzdt t TwOf 6/ NuaDN+t f GUPKR31Qc 7hW2yneWRedJ YXLhvSLV7RI HId9JI | b6 TwQbeNFw | JFi 2/ ¢93
t 4Ht eaFi b1M602j Er VOFc72anBj M xgOr sYMB9S1KZ4i X3GA 8s7qSTNaz9ZA==

CN=Sanpl eMD2RSAVer 1

QOU=Sanpl eMD2RSAVer 1 Or gani zation Unit

O=Sanpl eMD2RSAVer 1 Organi zati on Name

4.7.1 Open Certificate Signing Request

In order to open a standalone existing CSR file, clickon Menu Fil e > Open > Open CSR
After the CSR file (with .p10, .csr, .pem or .spkac extension) is selected, it will be opened in
a new tab which is named after the CSR's file name. There is also drag and drop support for
CSR files on Microsoft Windows and Linux platforms.

Most recently used CSR files can be found using Menu File > Open Recent File. A
simple click on the desired CSR file in the menu, will open the CSR in a new tab. If the CSR
file has been already opened, the CSR's tab will be activated.

4.7.2 Certificate Signing Request Details

The following CSR details will be displayed:
* Format;
* Version;
* Public Key;
¢ Signature Algorithm;
¢ DN Details;
e« Common Name (CN);
¢ Organization Unit (OU);
» Organization Name (O);
¢ Locality Name (L);
e State Name (ST);
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e Country (C);
e Email (E);

Challenge
e CSR Dump;

In the CSR window details the following actions are available:

« Open public key - which will complete the window with details about the public key
(algorithm, key size, modulus, public exponent, ASN.1);

« Copy - which will copy into the clipboard the content of the CSR file;

! Cy/Program Files (+86)/Edulib/CERTivity/doc/samples/csr/CSR-File-Sample(kp-dsaverl).pl0 - CERTivity [F=] [=23a)
File Edit KeyStore Signatures View Tools Window Help

= = f i Search (Cirl+1)
1 O D@ YR E G S e D

[‘] Readme. txt H‘ D CSR-File-Sample{kp-dsaver 1).p10 ﬁ| @E @
General Detail DN Details:
Format: CN=SampleDSAVer1,0U=SampleDSAVer 1 Organization Unit,0=SampleDSAVer 1 Organization Mame
PRCS10 Common Mame (CM): |SampleDSAVer1
Version: Organization Unit (OU): |SampleDSAVer 1 Organization Unit
0wl7)
Organization Name (0): | SampleDSAVer1 Organization Mame

Public Key:

Locality Name (L):
DSA 896 bits ty o

State Name (5T):
Signature Algorithm:
SHA IWthDSA ey (B
Challenge: Email (E):

sample-challenge

CSR Dump

————— BECIN CERTIFICATE REQUEST-————
MIICWTCCAhkCAQAWBDEWMBOEA1UEAwWNIZ FrcGx]l RENEVIV yMTEcHCYGA L UECHWE
UZFteCxl RENEVnVyMSEPemdnbm] 6YERpbZ 4gVHEpdDEcMCYEALUECqwE T2 Fratxl
RFNBVEVyMSEFemdhbml §YXRpbZ 40TMFCZICCAYEWgQEIBgeghk] COROBMIHERANEA
iNTiphpbiQwggd£kTC3c/ rggs/ ke JUpOUWEoghxHBrARJYS1 flpmzlejxuly03va
gt5medn3EngZnOLPAHORT 1q9R0+x0+PoZBUDEbs+Hic/ b/ SHt/kzpaRbezSHATtn
w/TgMEE] SYmYNAP021algQIVAIIQzN(32 4cxbnFLquobenh30ygrankiplepdlzd
MEE1th555F3Y1npgVaF0AZ yil YEbNuPSDoRe 8UISKa(pyXMEBHNU1 Sh+onwuMipg
¥jH4VOwas/ kglwiBwbeBh3DvKiX1K14t ] SkBOSSvLT/ ci+ira0TIPIC/ PSchTOg2
S¥a7rfTe/yclA3MARNRWIIFEyI4+olb)pVi+6kehHpULl EDY A TNE4TDkEokbSdH
Z1sEbDbF50I7mSSKPSLrHhS cfj001aYxXYoCkIMlua+FNEanT 4z/CLOG1ZLx
T&Wo/atzl0WFrzaZ+lhZal SGvEVPoiKnEzZ5CIVEoCEWHWY JEoZ ThyeNAQKHMATH
EHNhbXBSZ51]aGFsbEVuZ 2 UWwCOYHK0Z [2] gEAWMYADASENOTY TAYtpdMX3adMy4h
SF2dNOHa /QIURPESefnkDuwDbdbil3 ldAgeFiEnk=

Public Key Details

Algorithm: Key Size: ASN. 1; "
DSA 895 Sequence
Seguence =
Fields: ObjectIdentifier(1.2.640.10040.4.1)
Sequence
Base Generator G | nx22R487A59E356733171A5B61E52F45DDESETAE0573174 Integer (282372567148043435168567611
Prime Modulus P Integer (74237075153440816257672866733
SubPrime Q 542833 00A60623378574C1ADFFS20D30DFCCL Integer(714304154116914651810111420
Public Ke B7BCE7TOEF2AZ5E52A5E2DED2501D124AF2D3FDCSTECAR DER Bit Stringl[l14, 0] il

Note

You can use CSR examples provided in the distribution kit in doc/ sanpl es/ csr
folder, to test the CSRs features.
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4.8 Certificate Revocation Lists (CRL)

A Certificate Revocation List (CRL) is a list of certificates that have been revoked. This
list contains, more exactly, the serial numbers of the certificates which have been revoked
together with other information such as revocation date and additional extensions which
contain more details about the revoked certificates and the revocation reasons. The CRL
also contains some global information attributes such as the version, signature algorithm,
issuer name, issue date of the CRL and next update date.

The most common type of Certificate Revocation Lists is X.509 v2 and are usually encoded
in DER (binary) or PEM (text) formats.

An example of a PEM encoded CRL can be seen below:

————— BEGA N X509 CRL-----

M | DFDCCAf WCAQEWDQYJKoZI hvc NAQEFBQAWXz Ej MCEGATUEChMaU2Ft cGxl | FNp
Z25| ci BPcnmdhbm 6 YXRpb24x Gz AZBgNVBAS TEl NhbXBsZSBTaWduZXl gVWspdDEb
VBk GALUEAX MBU2Ft cGxI | FNpZ25I ci BDZXJ0FwOx Mz Ay MTgx VDM VDBaFwOx Mz Ay
Mrgx MDQy MDBaM | BNj ABAgMJeUc XDTEz MDI x ODEWM | xM owdj AKBgNVHRUEAWOB
Az AYBgNVHRgEERgPM Ax Mz Ay MTgx VDI y MDBaVDWCAX R5SBc NMTMMV] EAMTAYM |y
W AmivAo GA1 Ud FQQDCg EGVBg GA1 Ud GAQRGA8Y VDEz MDI x ODEWM | wivFowPAI DFHI J
FwOx Mz Ay MTgx MDI y Mz J aMCYwCg Y DVROVBAMKAQQWGAYDVROYBBEYDz | MMV E4
MrAyM AwWy A8AgMJe UoXDTEz VDI x ODEWM | OM owdj AKBgNVHRUEAWO BATAYBgNV
HRgEERgPM AxMz Ay MIgx VDI y MDBaVDWCAX R5Sxc NMTMwW] EAMTAY M UxW AmVAoG
Al Ud FQQDCg EFVBg GA1 Ud GAQRGA8Y MDEZ VDI x ODEWM | wiVFgLz At MB8GALUd I wQY
VBaAFL4SAcyq6hGA2i 6t sur Ht f uf +a00MA0 GA1UdFAQDAgEDVAOGCSqGSI b3DQEB
BQUAA4I BAQBCI b6B8cN5dnizbzi ETi mi ot Dy+FsOvS93LeDWSkN) XTG +bGgnr nBa
QpgB7heT8L207s2Qt j X2DaTOSYL3nZ/ | bn/ RBSO0g+EbNQxdk5/ | a6CERXi Rp+E2T
UGBLDb14YVVhRGKv CguS| y UGOMMGWewWaqgVt d6K71u7vhl U Ti df 62Sds TMhpPPFu
PUI d4j 29U3q10SGFF6cCt 1Dzj vUc OWHGhHAO2Men70EgZFADPLWrLgOHgl Kuhli Z
WBG ev/ 8VsUi j yj sMD72C6Ut 5TwiNyr r t hb952+eKl mKLNgTOo5hVYxj Xht wLQsL
7Qzhr ypAMLDLYQQ ki DI 7hl vt 7QuDGTJ

————— END X509 CRL-----

4.8.1 Open a Certificate Revocation List

CERTivity allows opening Certificate Revocation Lists which are stored in local files, or from
a remote location, using a given URL address which identifies the location of a CRL. To open
a CRL the following actions have to be performed:

e For aCRL stored in alocal file: Clickon Menu Fil e > Qpen > Qpen CRL > From
Fi | e. A file chooser will appear allowing to select one or more CRL files (having either
.crl or.pemextension). If a CRL that has to be opened has a different extension,
an "All files" filter is available in the file chooser which allows selecting any file. After
selecting one or more files, press Open, and each selected CRL will be opened in a
different tab which will display the content details of the CRL. There is also drag and
drop support for CRL files on Microsoft Windows and Linux platforms.

e For a CRL from a remote location: Click on Menu File > Open > Open CRL
> From URL. A dialog will appear requesting to enter the URL of the CRL. The CRL
found at the location denoted by the given URL will be opened into a new tab. If the
CRL is large, a progress bar will be displayed on the status bar until the CRL content
is retrieved from the remote location. If the URL is invalid, an error message will be
displayed informing that, and the user can enter another URL.

The dialog for entering the URL can be seen below:
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1 Open CRL

Enter URL:

Protocols supported: HTTP, HTTPS, FTP and LDAP.

[ Cpen H Cancel ][ Help

After opening and closing more Certificate Revocation Lists, the most recently used CRLs
can be found using Menu Fil e > Open Recent Fil e. Forthe CRLs which were opened
from local files the entire file path will be displayed in the menu that appears, while for the
the ones opened from URLs, the URL will be displayed. A simple click on the desired CRL
in the menu, will open it in a new tab. If the CRL has been already opened, the CRL's tab

will be activated.

4.8.2 CRL Details

CERTIivity displays the content of the CRL using a tree like structure for each field or group
of fields of the CRL as it can be seen in the screenshot below:

k. I'_ﬂqultn”

Lof
1 C/Program Files (x86)/EduLib/CERTivity/doc/samples/crl/SamplePemCrl.pem - CERTivity
File Edit KeyStore Signatures WView Tools Window Help

| bl 9 Iil aIb

|:‘| Readme.txt @ ESamplePemCr\.pem $|

XS AT

2 B

i@ Type (X.509)
Version (2Z)

# Issuer (Sample Signer Cert)
Extensions (Z)

ASN, 1

Revoked Certificates List (5)
Revoked Certificate

-4 Extensions (2)
. Revoked Certificate
Revoked Certificate

-4 Extensions (2)
. Revoked Certificate
| Revoked Certificate

This Update (2013-02-18T12:32:00+40200)
MNext Update (2013-02-18T12:42:00+0200)
# Signature Algorithm (SHA 1withRSA)

-4 Serial Number {0x14 79 47)
-# Revocation Date (2013-02-18T12:22:12+0200)

-4 Serial Number (0x14 79 49)
-# Revocation Date (2013-02-18T12:22:32+0200)

SamplePemcCrl.pem

Issuer:

Revoked Certificates:

Type X.509
Version 2
This Update

MNext Update

O=Sample Signer Organization,OU=Sample Signer Unit,CN=Sample Signer Cert
Common Mame (CM):
Organization Unit {OU):
Organization Name (O}
Locality Mame (L):
State Name (ST):
Country {C):

Email (E):

2013-02-18T12:32:00+40200

2013-02-18T12:42:00+40200

The "Mext Update”™ was exceeded. A newer CRL should be available.

Signature Algorithm | SHA1withRSA

D
Sample Signer Cert
Sample Signer Unit

Sample Signer Organization

Serial Number
0x14 79 47

Revocation Date
2013-02-18T12:22:12+0200

Extensions
Extensions (2Z)

0x14 79 43

2013-02-18T12:22: 2240200 [Extensions (Z)

0x14 79 49

2013-02-18T12:22:32+40200 [Extensions {2)

0x14 79 4A

2013-02-18T12:22:42+40200 [Extensions (Z)

0x14 79 48

2013-02-18T12:22:51+0200 [Extensions (Z)

m
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Each node of the CRL tree contains the name of the field and its value in brackets, if the value
is short enough to be displayed, like for Type, Ver si on, Thi s Updat e, Next Updat e.

For each selected node in the CRL tree, the content of the selected node will be displayed
in the right panel. When the root of the tree is selected (selected by default when opening
the CRL), the right panel will display the entire content of the CRL (as it can be seen in the
example screenshot from above).

In this full display mode (selecting the root node of the tree), the ASN.1 representation and the
CRL extensions are not displayed by default but the user can make them visible by clicking
on the ASN. 1 and Ext ensi ons buttons, which will expand the panel with the corresponding
additional content.

Also, when the root node of the CRL tree is selected, the revoked certificates are
displayed at the bottom of the right panel as a list containing for each revoked certificate the
Serial Nunber, Revocati on Dat e, and Ext ensi ons. The Extensions column displays
informations only about the number of extensions if the revoked certificate has extensions.
To view the extensions of a certain revoked certificate, select the corresponding row of the
table, and an additional panel will appear at the bottom of the table containing details about
the extensions of the selected revoked certificate. The names of the available extensions of
a revoked certificate can be viewed faster in the tooltip which appears when positioning the
cursor over the revoked certificate row.

Note

The same view of the revoked certificates and their extensions can be obtained by
selecting the Revoked Certificates List node from the tree, as it can be
seen in the screenshot below:
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SamplePemCrl.pem 5

| CRL (SamplePemCrl.pem)

------ ® Type (X.509)

Version (2)

This Update (2013-02-18T12:32:00+0200)
Next Update (2013-02-18T12:42:00+0200)

Signature Algorithm (SHA LwithRSA)

- # Issuer (Sample Signer Cert)

i # Extensions (2)

@ ASN.1

=+ | Revoked Certificate

i # Serial Number (0x14 79 47)

# Revocation Date (2013-02-18T12:22:1240200)

# Extensions (2)

. Revoked Certificate

. Revoked Certificate

i Serial Number (Ox14 79 43)

i # Revocation Date (2013-02-18T12:22:32+0200)
i - # Extensions (2)

. Revoked Certificate

. Revoked Certificate

SamplePemCrl.pem
Revoked Certificates:

Serial Number
0x14 79 47

0x1479 49

Revocation Date
2013-02-18T12:22:12+0200
2013-02-18T12:22:22+0200
12013-02-18T12:22:32+0200

Extensions

0x14 79 4A

‘ZI] 13-02-18T12:22:424+0200

|[Exten| Extensions:

0x14 79 48

‘2013-02—1“12122: 51+0200

[Exten|

Reason Code
Invalidity Date

Click to view details of the extensions.

m

Revoked Certificate Extensions

Extensions:

Reason Code (2.5.29.21)

Invalidity Date (2.5.29.24)

Extension Value:

Certificate Heold

i

If the revoked Certificates List node is expanded, each revoked certificate can be visible as
a child node, which can also be expanded further to see the fields of the Revoked Certificate

(Seri al

Nunber, Revocati on Dat e or Ext ensi ons). If the Revoked Certificate

node is selected, the right panel will display the fields contained by the selected revoked
certificate, as it can be seen below:

SamplePemCrl.pem &

CHEE

| CRL (SamplePemCrl.pem)
-4 Type (X.509)
- Version (2)
i~ # This Update (2013-02-18T12:32:00+0200)
4 Next Update (2013-02-18T12:42:00+0200)
- Signature Algorithm (SHA lwithRSA)
|- # Issuer (Sample Signer Cert)
i @ Extensions (2)
~# ASN.1
-}, Revoked Certificates List (5)
= s Revoked Certificate
1 Serial Number (0x14 79 47)
i~ # Revocation Date (2013-02-18T12:22:12+40200)
- @ Extensions (2)
Jrevoked Certifcate
= | Revoked Certificate
i @ Serial Number (0x14 73 49)
- # Revocation Date (2013-02-18T12:22:3240200)
| @ Extensions (2)
J Revoked Certificate
- s Revoked Certificate

o

Note

SamplePemCrl.pem
Revoked Certificate

Serial Number Ox14 79 48

Revocation Date | 2013-02-18T12:22:2240200

The extensions of the revoked certificate can also be seen by clicking the Extensions
button, which will trigger the displaying of the revoked certificate's extensions. Also,
each field of the revoked certificate including the extensions, can be seen individually
by selecting the corresponding field in the child nodes of the revoked certificate in

the CRL tree.
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4.8.2.1 CRL Fields

The

CRL Viewer from CERTIvity allows viewing the content of the following CRL fields:
Type

The type of the CRL. In most cases, this is X.509;

Ver si on

The version of the CRL. In most cases, the version is 2;
Thi s Update

This field indicates the issue date of the current CRL;
Next Update

This field indicates the date by which the next CRL will be issued. As mentioned in
RFC 5280 [http://www.ietf.org/rfc/rfc5280.txt], the next CRL could be issued before the
indicated date, but it will not be issued any later than the indicated date.

When displaying this field is selected in the CRL tree and is displayed on the panel in
the right side, the date held by it is verified against the current date, and if the date is
exceeded, a red notice message will be displayed under the field as a reminder that
maybe a hewer CRL has been issued;

Signature Al gorithm

The algorithm that was used for the signature of the current CRL;

| ssuer

The name of the entity that signed and issued the CRL. In this field, the issuer identity is
carried. Alternative name forms may also appearinthe |l i ssuer Alternative Nane
extension.

The value of this field is not displayed entirely in the CRL tree next to the node between
brackets, only a part of it is shown. The full issuer details can be seen in the right panel
when clicking on the node;

Ext ensi ons

The extensions of the CRL. According to the RFC 5280 [http://www.ietf.org/rfc/
rfc5280.txt], this field may only appear if the version is 2. If present, this field contains
one or more CRL extensions.

The value of this field is not displayed entirely next to the node between brackets. Only
the number of extensions is displayed. The full details about the extensions can be seen
in the right panel when clicking in the extensions node;

Revoked Certificates

This field contains the list of revoked certificates. When there are no revoked certificates,
this list is absent.

The revoked certificates are displayed as child nodes of this CRL tree node. The
Revoked Certificates List nodeon its own displays only the number of revoked
certificates. Also, the list of revoked certificates can be seen in the right panel by clicking
on the Revoked Certificates List node.
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The CRL tree contains one more node, ASN. 1, which contains the ASN.1 representation of
the current CRL. The value of this node can be viewed in the right panel when it is selected.

4.8.2.2 CRL Extensions

CRL extensions provide methods for associating additional attributes with CRLs. These
extensions can be marked as critical or non-critical.

CERTivity can display the following CRL extensions, defined in the REC 5280 [http://
www.ietf.org/rfc/rfc5280.txt]:

Authority Key ldentifier

This extension provides a means of identifying the public key corresponding to the
private key used to sign a CRL;

| ssuer Alternative Nane

This extension allows additional identities to be associated with the issuer of the CRL;
CRL Nunber

This extension contains a monotonically increasing sequence number for a given
CRL scope and CRL issuer. This extension allows users to easily determine when a
particular CRL superseedes another CRL. CRL numbers also support the identification
of complementary complete CRLs and delta CRLs;

Delta CRL | ndicator

The delta CRL indicator identifies the CRL as being a delta CRL. Delta CRLs contain
updates to revocation information previously distributed rather than all the information
that would appear in a complete CRL;

I ssuing Distribution Point

This extension identifies the CRL distribution point and scope for a particular CRL
and it indicates wether the CRL covers revocation for end entity certificates only, CA
certificates only, attribute certificates only or a limited set of reason codes;

Freshest CRL (orDelta CRL Distribution Point)

This extension identifies how delta CRL information for this complete CRL is obtained.

Authority Information Access

This extension defines the use of the Authority Information Access extension in a CRL.

Also, the following CRL Entry extensions can be displayed by CERTivity:

Reason Code

This extension identifies the reason for the certificate revocation. The possible reason
codes are:

e unspecifi ed;
e keyConpr omi se;
e cAConpromi se;

« affiliationChanged;
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e superseded;
e cessati onOf Qperation;
« certificateHol d;
* renmoveFr onCRL;
e privilegeWthdrawn;
e aAConprom se.
e Invalidity Date

This extension provides the date on which it is known or suspected that the private key
was compromised or that the certificate otherwise became invalid. This date may be
earlier than the revocation date in the CRL entry;

e Certificate |ssuer

This extension identifies the certificate issuer associated with an entry in an indirect
CRL, that is, a CRL that has the i ndi r ect CRL indicator set in its issuing distribution
point extension. When present, the certificate issuer CRL entry extension includes one
or more names from the issuer field and/or issuer alternative name extension of the
certificate that corresponds to the CRL entry.

More information about the CRL and CRL Entry extensions can be found in the RFC 5280
[http://www.ietf.org/rfc/rfc5280.txt].

4.8.2.3 Revoked Certificates

The revoked certificates (if present) can be viewed in CERTivity either by selecting the
Revoked Certificates List node, which will display a table in the right panel
containing the information about these certificates, either by expanding the Revoked
Certificates List node and selecting its child nodes, which will display the available
fields of the revoked certificate in the right panel. Also, each revoked certificate node can be
expanded to see individual fields.

For a revoked certificate, the following fields will be displayed:
e Serial nunber;
* Revocation Date;

* Ext ensi ons.

The number of revoked certificates present in the CRL can be seen next to the Revoked
Certificates List node,in brackets.
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5. CERTivity®'s KeyStore

5.1 KeyStores Capabilities

A KeyStore is a protected database of cryptographic keys - private, public, secret. Private
keys in a KeyStore have a certificate chain associated with them, which authenticates the
corresponding public key - together they form a Key Pair entry - you cannot have just a
private key by its own. On the other hand a KeyStore can contain just the certificates from
trusted entities.

A Certificate embeds a public key belonging to an entity. It certifies the public key and all the
information via digitally signature of another entity (the issuer, e.g. - a person, company, etc.),
saying that the embedded public key (and some other information) belongs to the declared
entity (the subject) and has some specific value. That is why it is also called a Public Key
Certificate. The certificate is usually signed by a trusted Certification Authority (CA) or it can
be self signed.

CERTivity can handle X.509 certificates types, both version 1 and 3.

Besides Key Pair and Certificate entries (asymmetric keys) some types of KeyStores can
store Secret Keys (symmetric keys) as well.

Hence a KeyStore is a protected collection of Key Pair, Certificate and Secret Keys entries
and each such entry is addressable via an unique alias or entry name. KeyStores are stored
according to their standards and they are protected by a general password while the Private
Keys and Secret Keys are protected by different individual passwords.

CERTivity asks for these passwords when operations are requiring access to the keys. Once
a Private key or Secret Key is unlocked it will stay unlocked while the KeyStore is loaded.

CERTivity can manage the following KeyStore types - their main capabilities according to
their standard are described below.

Table 5.1. KeyStores capabilities

Keystore type |Keystore Supports Aliases  Case|Provider
password Secret Key Sensitive
protection
jks - Java|Yes No No - use lower|Default JCE
KeyStore case
(Oracle's
KeyStore format)
pkcs12 - Public-|Yes (for|No Half - Case|Bouncy Castle
Key password that is aware

Cryptography greater than 7
Standards #12|characters, you
KeyStore (RSA'smay need to

Personal download and
Information install the Java
Exchange Cryptography
Syntax Extension (JCE)
Standard) Unlimited
Strength
Jurisdiction
Policy Files)
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Keystore type |Keystore Supports Aliases  Case|Provider
password Secret Key Sensitive
protection
jceks - Java|Yes Yes No - use lower|Default JCE
Cryptography case
Extension

KeyStore (More
secure version of
JKS)

bks/bks-v1l -|Yes. Note the|Yes Yes Bouncy Castle
Bouncy Castle|empty string
KeyStore " universal
(Bouncy Castle's|password. If
version of JKS); [the KeyStore is
unlocked using
the universal
password, and
if the password
is not changed
until saving the
KeyStore, the
empty string will
be set as
the KeyStore
password when
saving.

uber - Bouncy|Yes Yes Yes Bouncy Castle
Castle UBER
KeyStore (More
secure version of

BKS)

Windows Root|Yes No Yes Default JCE

CA (on Oracle -
SunMSCAPI)

Windows User |Yes Yes Yes Default JCE
(on Oracle -
SunMSCAPI)

Please note that PKCS12 KeyStores have no password protection for their key pair entries.

"Case aware" means that an alias can be defined both with low case and upper case, will be
saved as this, but there cannot be two aliases which differ just by the case of their letters.

Working with Windows Root CA KeyStore and Windows User KeyStore are available only on
Windows platform and additional confirmation and warning panels will be displayed by the
Windows system when installing, deleting, renaming a KeyStore entry. Hence, the second
confirmation dialogs are not under the control of CERTivity application.

The BKS/BKS-V1 type of KeyStore allows for being accessed both with the KeyStore
password, as well as with the empty string password - this is not under the control of the
CERTivity application .
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5.2 KeyStore |

The

The

Note

You can use KeyStore examples provided in the distribution kit in the folder doc/
sanpl es/ keyst or e, to test the KeyStore features.

nterface Organization

KeyStore Interface contains two main sections:
Tree Table panel allowing the navigation between the entries;

Details Panel for visualizing the current selection.

tree table contains the following sortable columns:
Entry Alias - e.g. the name of the certificate, the name of the key pair;

Key Type - e.g. RSA 2048, DSA 512, EC 163 (the type of the key pair or of the certificate,
and the length of the key);

Expire Date - the expiration date of the certificate or key pair - e.g. 26.10.2011 17:43:03
(DD.MM.YYYY HH:MM:SS);

Last Modified - the date of the last modification of the certificate or key pair - e.g.
26.10.2011 17:43:03 (DD.MM.YYYY HH:MM:SS);

Validity Status - the status of the entry (e.g. - valid, expired, about to expire);

Trust Status - the trust status of the certificate entry. It can take one of the following
3 values:

e Trusted - if a Trust Path could be established using the provided TrustStores and
Trust Path options;

* Not Trust ed -ifaTrust Path could not be established using the provided TrustStores
and the Trust Path options;

* N A-if no TrustStores were set.

Each entry type has a specific icon.

Certificate entry.

Certificate Chain entry.

Unlocked Key Pair entry.

Locked Key Pair entry.

Unlocked private key entry.

Locked private key entry.

JHIFT S RE

Public key entry.

+
+

Certificate Extensions entry.

f

Unlocked Secret Key entry.
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e Locked Secret Key entry.

After selecting a KeyStore entry, when clicking on the right button of the mouse, you
can use the contextual menu. More details about the contextual menus are available in
CERTivity's Menus / Tool bar / Contextual nenu.

The Details Panel is polymorphic, changing according to the current selection type. Using
the Details Panel section, you can get more details about the selected entry:

« for certificate entry, you can see the Certificate Details;

« for key pair entry, you can see the Private Key Details and also Certificate Chain Details;

« for certificate chain entry, you can see Certificate Chain Details where you can select
a certificate and see its details;

« for Public Key entry, you can see Public Key Details like ASN.1, algorithm, key size;

« for Private Key entry, you can see Private Key Details like ASN.1, algorithm, key size.

The Details Panel can be minimized and maximized, by clicking on the top right corner button
of the panel.

5.3 Create a New KeyStore

In order to create a new KeyStore, clickon Menu Fi | e > New KeySt or e or use the default
keyboard shortcut CTRL+N. A new window for the new created KeyStore will be opened.
The Create New KeyStore File dialog is more complex than in a standard MDI application,
because there are more settings to be bound from the beginning such as the KeyStore
password and type. Protection being an important factor it is important to bind the KeyStore
file name with the password from the beginning.

The available KeyStore types are:

¢ jks - Java KeyStore (Oracle's KeyStore format);

e pkcsl2 - Public-Key Cryptography Standards #12 KeyStore (RSA's Personal Information
Exchange Syntax Standard);

« jceks - Java Cryptography Extension KeyStore (More secure version of JKS);
* bks - Bouncy Castle KeyStore (Bouncy Castle's version of JKS);

* bks-v1 - Legacy version of Bouncy Castle KeyStore - this has been added for people
needing to create and manage key stores compatible with earlier versions of Bouncy
Castle (less than 1.49);

e uber - Bouncy Castle UBER KeyStore (More secure version of BKS).

When creating (and in general handling) a pkcs12 or a uber type KeyStore, longer passwords
either for the KeyStore of the Key Pairs requires that you have the Java Cryptography
Extension (JCE) Unlimited Strength Jurisdiction Policy Files installed. If you are not allowed to
install it then you will need to use smaller passwords (e.g. maximum 7 characters). Otherwise
you may encounter "lllegal Key Size" errors when accessing pkcs12 or uber files or keys
inside them.

Note

This is a matter of import control restrictions in most of the countries and is not related
to technical reasons.
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7% Windows Root CA KeyStore - CERTivity (e l=]=]
File Edit KeyStore Signatures View Tools Window Help
< =] = 5 0 & B B
3 8 S ] aa e Rl il
3| Windows Root CA KeyStore ml El delicious.cer 8| |7/ UBER-KeyStore-5ample.ubr ml lr B @
3/ Change KeyStore Password ¥z View [ Convert KeyStore Type  #-g Generate Key Pair 5+ Generate Secret Key 1}5 SSL Certificates Retriever ﬂ’. Import Key Pair E Import Certificate
Entry Alias 4 Key Type Expire Date Last Modified validity Status Trust Status
El Baltimore CyberTrust Root RSA 2048 2025-05-13T02:53:0,,, 2013-05-01T15:435, ., Vald Trusted -
El Certum RS5A 2048 2027-06-11T13:46:3.., 2013-05-01T15:49:5. . Vald Trusted
% % Create Mew KeyStore File @
El Savein: keystore - ¥ B
El || BKS-KeyStore-Sample.bks KeyStore Type:
o i
% ';B" || JCEKSKeyStore-Sample. jce New KeyStore Type: ,Jks =
JKS-KeyStore-sample.jks
Recentltems | i e Password for new Keyg =
El _ﬁ PKCS12-KeyStore-Sample.p12 pkes12 =
El _ﬁ PKCS124arge-password.p12 ;:sks
-] ! UBER-KeyStore-Sample.ubr Ente
= uber
El Desktop Enter Password:
% Retype Password:
- -
El My Documents
@
El Computer
- & =
5 B e rame:
Network " .
El Files of type:  keyStore Files (*.ks; *.jks; .jce; *.p12; *.pfix; =.bks; =.ubr; *keystore) -
B Thawte Timestamping CA RS5A 1024 2021-01-01T01:59:5,,, 2013-05-01T15:50:0... Vald Trusted
El Trustwave RSA 2048 2029-12-31T21:40:5,., 2013-05-01T1S:50:0. ., Vald Trusted
El USERTrust RSA 2048 2019-07-09T21:40:3.., 2013-05-01T15:50:0. . Vald Trusted -
Case Sensitive Aliases | 45 entries (45 certificates, 0 key pairs, 0 secret keys), 0 selected

5.4 Open an Existing KeyStore

In order to open an existing KeyStore, click on Menu File > Open > Open KeyStore
or use the default keyboard shortcut CTRL+O. A file chooser dialog box will be opened in
order to select the desired KeyStore file. The supported file extensions have the following
default filters: cacerts; *.ks; *.jks; *.jce; *.pl2; *.pfx; *.bks; *.ubr;
* keystore..AnAl'l Fil es filter is available, too.

After selecting the KeyStore file, the KeyStore password is required.

Most recently used KeyStores can be found using Menu File > Open Recent File. A
simple click on the desired KeyStore in the menu, will open the KeyStore in a new tab. The
KeyStore's password is required only in the "Persist only KeyStore file name" mode. If the
KeyStore has been already opened, the KeyStore's tab will be activated.

On Microsoft Windows and Linux platforms, dragging a KeyStore from a file explorer into
CERTivity will also open it.

CERTivity automatically detects the right type of KeyStore when openning. For bks type
CERTIivity supports Bouncy Castle's bks- v1 as well to stay compatible with older versions
of Bouncy Castle (older than 1.49). The logic related to the BKS type versions is:

* When opening an existent BKS-V1 KeyStore CERTivity keeps it in the bks- v1 format,
including the saving operations;

¢ When creating a BKS as a new KeyStore the user can select between the old BKS
format (bks- v1) and the new BKS format (bks);

e There is also the option for converting between BKS(bks) and BKS-V1(bks- v1) type.
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Note

You can see a sample of :

* jks KeyStore type in the sanpl es directory: doc/ sanpl es/ keyst or e/ JKS-
KeySt or e- sanpl e. j ks;

e pkcsl2 KeyStore type in the sanpl es directory: doc/ sanpl es/ keyst or e/
PKCS12- Key St or e- Sanpl e. p12;

» jeceks KeyStore type in the sanpl es directory:doc/ sanpl es/ keyst or e/
JCEKS- KeySt or e- Sanpl e. j ce;

« bks-vl KeyStore type in the sanpl es directory: doc/ sanpl es/ keyst or e/
BKS- Key St or e- Sanpl e. bks;

e uber KeyStore type in the sanpl es directory: doc/ sanpl es/ keyst or e/
UBER- Key St or e- Sanpl e. ubr .

5.5 Open JREs CA KeyStores

An efficient way to open CA KeyStores (TrustStores) of the JREs on the current system is
touse Menu File > Open > Open JRE CA KeyStore. There you have a list of the
CA Truststores discovered on your system. The discovery of the JREs is done by compiling
a list of paths in the following way:

« The Java property ${j ava. hone} of the JRE CERTIvity started with;
» The system environment variables JAVA HOVE and JRE_HOVE;

» For Windows platforms searching the installed Java JDKs and JREs in the Windows
registry;

e« For Unix and Mac we are looking for traditional Java installation
directories such as /usr/java for Unix, /usr/lib/jvm for Linux (Debian,
RedHat) and for Mac /Library/Javal/ Hore/, /System Library/Java/
JavaVi rt ual Machi nes/ . Various patterns are then used.

You can select a KeyStore from the TrustStore list discovered by CERTivity on your system,
or you can select another one by using Menu File > Open > Open JRE CA KeyStore
> Ot her. .. menuitem. In this menu item you have to select the JDK's or JRE's home path,
and CERTIvity will open the Truststore for you. This new selected Truststore will be added to
the menu list, so you will not have to make the selection steps again next time. The maximum
list size of JREs CA Keystore can be set in the Tool s > Opti ons menu.

Before opening the selected JRE CA KeyStore CERTIvity will ask for its password. The
password depends on the JRE distribution, but generally it has a well known default -
changeit.

5.6 KeyStore Persistence (Reloading opened KeyStores)

CERTivity® offers KeyStore persistence between runs by remembering the KeyStores which
are opened at the time the application exits. If the KeyStores are not closed before exiting
the application, their names and locations are remembered so that on the next launch they
will be reloaded (if the KeyStore files still exist, and they can be loaded). When reloading
the KeyStores, you can set CERTivity® to either ask you for the password of each KeyStore
when each KeyStore tab is selected for the first time, or, you can set it to remember the
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passwords of each KeyStore as well, so that you won't be prompted for them. All passwords
will be encrypted to increase safety.

Although the full persistence option (remembering the KeyStore name and encrypted
password) makes the application more friendly we are not recommending the full persistence,
unless you are sure the machine is exclusively accessible by you. Otherwise, it is
recommended to use the option which only remembers the name and location of each
KeyStore.

To change the persistence type, click on Menu Tools > Options or use the default
keyboard shortcut ALT+T+Q. The preferences dialog will be opened. Inthe Certi fi cat es
Opt i ons tab, look for the field Key St or e per si st ence. This field has a combo list which
allows you to select one of the following two options:

< Fully persist (file name & encrypted password) - this is the default value when starting
CERTivity® for the first time. When this option is selected, the application will save both
the KeyStore name and the encrypted password of each KeyStore which is opened
when exiting the application. This is not recommended if the machine is not exclusively
accessed by you.

» Persist only KeyStore file name (without password) - When this option is selected, the
application will only save the name and location of the KeyStore file, and you will be
prompted to enter the password for each KeyStore which was previously opened when
selecting the KeyStore tab for the first time after launching the application.

The KeyStore is not loaded until you provide the correct password. If you enter a wrong
password, you will be prompted to enter the password again. Also, if the file of the
KeyStore has become corrupted since the last run, you will be informed regarding the
issue. If you choose to cancel entering a password, the KeyStore tab will be closed, and
the KeyStore will not be remembered for opening on the next launch anymore.

Changing the KeyStore persistence type will only take effect when clicking on OK on the
preferences dialog. If the dialog is closed otherwise, the new selected persistence type will
be disregarded.

Note

When changing from a lower level of persistence (from "Persist only KeyStore file
name" option) to a higher level of persistency ("Fully persist" option), if you have
KeyStores which have not yet been unlocked (for which you have not yet entered
the password), and you still do not enter the password before exiting the application,
on the next run, you will still be prompted to enter the passwords for the KeyStores
for which you did not provide them when having the previous level of persistency.

A screenshot showing the dialog which prompts you to enter a password for opening the
KeyStore when the application is launched, can be seen below:

% Password needed @

Password for “JK5-+KeyStore-sample. jks™

QK ] | Cancel
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5.7 Open Microsoft Windows KeyStores

5.7.1 Open

5.7.2 Open

These operations are functional only on Microsoft Windows platforms. The Windows system
native KeyStores are opened and similar visualising and editing actions can be performed
on these KeyStores with some limitations:

< Private Key Fields are not available for inspecting;

« DSA and EC(DSA)/ECGOST3410 Key Pairs cannot be generated and neither imported;
« EC(DSA)/ECGOST3410 Certificates cannot be imported for safety reasons;

« Key Pairs cannot be exported or copied;

« Private Keys cannot be exported;

< Undo/Redo functionality is not available due to the fact that all the actions are persistent,
no save is needed, and so, it is possible that the KeyStore gets modified from outside
between undo and redo, and then the behavior may be unexpected.

Especially for the Root KeyStore a native confirmation dialog will also appear for editing
actions. This is not under the control of CERTIivity. It is advisable to do the same logical
confirmation both in the CERTivity confirmation dialog as well as in the Windows native one.
As these are the Operating System KeyStores take care when editing, especially for the Root
CA KeyStore. For example when renaming a certificate entry (key pairs can not be renamed),
there are 2 native pop-ups appearing: First to confirm deleting of the certificate, and the
second to confirm the import of the certificate with the new alias. If on the delete dialog "YES"
is selected and on the import dialog "NQO" is selected, then the node gets deleted. There is
no way to recover the node back.

Due to a JRE 1.6 64-bit distribution limitation opening the Windows KeyStores is not
functional on Microsoft Windows 64-bits Releases. JRE 1.7 resolves this issue, as well as
using a 32-bit distribution of JRE 1.6.

Windows Root KeyStore
The Windows-ROOT KeyStore contains all root CA certificates trusted by the machine.

In order to open the Windows Root KeyStore, click on Menu File > Open > Open
W ndows Root CA KeyStore. A new tab will be opened containing the Windows Root
KeyStore entries.

Native confirmation dialogs will be displayed upon, adding, deleting.

If you want to add an entry, but the current KeyStore already contains an entry with the
same SHAI1 fingerprint, you will have to choose to overwrite the old entry or not because
Windows Root CA KeyStore do not allow more entries with the same content. The operating
system, will ask for a confirmation of deleting the entry from the Root Store and also a Security
Warning from the operating system will be displayed, informing about the installing of a new
entry.

Windows User KeyStore
This operation is functional only on Microsoft Windows platforms. In order to open Windows

User KeyStore, clickon Menu File > Open > Open W ndows User KeyStore.Anew
tab will be opened containing the Windows User KeyStore entries.
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Due to a JRE 1.6 64-bit distribution limitation opening the Windows KeyStores is not
functional on Microsoft Windows 64-bits Releases. JRE 1.7 resolves this issue, as well as
using a 32-hit distribution of JRE 1.6. For this reason the bundled CERTivity setup is using
the 32-bit distribution of JRE 1.7.

5.8 Change KeyStore Password

In order to change a KeyStore password, open the desired KeyStore (Menu Fil e > Qpen
> Open KeySt or e) and click on "Change KeyStore Password" or use the toolbar

ke
A new dialog will be opened, for entering the new password. The password must be retyped.
In case of error the message "Ent ered passwords do not mat ch" will appear.

A screenshot for the Change KeyStore Password action can be seen below:

7% C/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JCEKS-KeyStore-Sample.jce - CERTivity (== ][=]
File Edit KeyStore Signatures View Tools Window Help
e =] = 5 0 ¥ B \ m
7 Gl @ g cE g e ST g
2| Windows Root CA KeyStore Hl El delicious,cer 8| |7 UBER-KeyStore-Sample,ubr Bil % JCEKS-KeyStore-Sample.joe Hl lI]EJ @
4/ Change KeyStore Password | {3 View [ Convert KeyStore Type -y Generate Key Pair  5-# Generate Secret Key '{)'i S5L Certificates Retriever ﬁ)'. Import Key Pair E Import Certificate
Entry Alias a4 Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T10:35:41+0300 valid Trusted
El delicious.com RSA 2048 2013-08-25T19:49: 30+0300 2013-04-28T15:15:26+0300 valid Not Trusted
El digicert root ca RSA 2048 2014-07-26T21:15:15+0300 2012-10-05T10:35: 18+0300 valid Trusted
‘B"' kp-dsaver1 DSA 836 2014-10-05T12:13:37+0300 2012-10-05T12:15:21+0300 valid
@y kp-dsaver3 DSA 512 2014-10-08T10:39:20+0300 2012-10-05T10:56:05+0300 Valid
‘B"' kp-md2rsaver 1 RSA 2048 2014-10-06T10:43: 11+0300 2012-10-05T10:56:31+0300 valid
-md2rsaver3 RSA 2043 Valid
‘o ! Enter Password @
- kp-mdsrsaverl RSA 2048 valid
&y kp-mdSrsaver3 RSA 1080 Valid
8y kp-sh Irsaverl RSA 2048 Enter a password for JCEKS-KeyStore-Sample.jee: valid
g kp-shalrsaver3 RSA 2043 Enter Password: | Expired
-y kp-with-expired-cert RSA 2048 e Expired
g kp-with-ext DSA 1024 Valid
gk sk-aes Secretkey
g sk-arcfour Secretkey
oK Cancel
gk sk-blowfish Secretiey -
gk sk-des Seretiey
gk sk-desede Secretiey 2012-10-05T10:30:444+0300
-5k sk-hmacmd$ Secretiey 2012-10-05T10:30:55+0300
ke sk-hmacshal Secretkey 2012-10-05T10:51:09+0300
ik sk-hmacsha2se Secretiey 2012-10-05T10:31:20+0300
ke sk-hmacsha3s4 Secretkey 2012-10-05T10:51:31+0300
gk sk-hmacsha512 Secretiey 2012-10-05T10:31:45+0300
-l skrc2 Secretkey 2012-10-05T10:51:56+0300
El uleeds-udn-trust RSA 2043 2020-05-30713:48:353+0300 2013-04-26T15:15:26+0300 Valid Trusted
Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 0 selected

5.9 View/Convert KeyStore Type
In order to view/convert a KeyStore type, click on Vi ew Convert KeyStore Type of the
opened KeyStore window. The available KeyStore types are:
 jks - Java KeyStore (Oracle's KeyStore format);

» pkcsl2 - Public-Key Cryptography Standards #12 KeyStore (RSA's Personal Information
Exchange Syntax Standard);

 jceks - Java Cryptography Extension KeyStore (More secure version of JKS);
* bks - Bouncy Castle KeyStore (Bouncy Castle's version of JKS);

« bks-vl1 - Legacy version of Bouncy Castle KeyStore - this has been added for people
needing to create and manage key stores compatible with earlier versions of Bouncy
Castle (less than 1.49);
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« uber - Bouncy Castle UBER KeyStore (More secure version of BKS).

After selecting the new desired KeyStore type, click on Change t ype button.

For converting the KeyStore type all passwords for key pairs and secret keys are needed!

A screenshot for the change KeyStore password action can be seen below:

74 C:/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JCEKS-KeyStore-Samplejce - CERTivity = HEH = |
File Edit KeyStore Signatures View Tools Window Help
558 " El I e R ] e
2| Windows Root CA KeyStore Hl El delicious,cer 8| |7 UBER-KeyStore-Sample,ubr Bil % JCEKS-KeyStore-Sample.joe Hl lI]EJ @
3/ Change KeyStore Password | {3 View / Convert KeyStore Type| &y Generate Key Pair 5+ Generate Secret Key Q’i S50 Certificates Retriever E’. Import Key Pair Import Certificate
Entry Alias & Key Type Exqire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T10:35:41+0300 Valid Trusted
El delicious.com RSA 2043 2013-08-25T19:49:30+0300 2013-04-26T15:15:26+0300 Valid Not Trusted
El digicert root ca RSA 2048 2014-07-26T21:15:15+0300 2012-10-05T10:35: 18+0300 valid Trusted
g kp-dsaverl DSA 836 2014-10-05T12: 1337 +0300 2012-10-05T12:15:21+0300 valid
-8y kp-dsaver3 DsSA 512 2014-10-06T10:39:20+0300 2012-10-05T10:56:05+0300 valid
-H‘ kp-md2rsaver 1 RSA 2048 Lt Tioudoa L Lo loncTinca.al 0 valid
&y kp-midarsaver3 RSA 2048 1 KeyStore Type (== o vaia
-8 kp-mdSrsaver1 RSA 2043 KeyStore Type: 0 valid
&y kp-mdSrsaver3 RSA 1080 Current KeyStore Type: Jesks 0 Valid
- kp-shalrsaverl RSA 2043 New KeyStore Type: jks = 0 Valid
&y kp-shairsaver3 RSA 2043 0 Expired
e kpouith-expire-cert Ao 2089 For converting the KeyStore type all passwords for key pairs 5 Epred
Age kp-with-ext DS 1024 and secret keys are needed. o valid
ik sk-ges Secretiey 0
g sk-arcfour Secretkey 0
gk sk-blowfish Secretkey Change type ] [ Cancel ] [ Help 0
g sk-des Secretkey 0
gk sk-desede Secretiey 2012-10-05T10:30:444+0300
-5k sk-hmacmd$ Secretiey 2012-10-05T10:30:55+0300
gk sk-hmacshal Secretiey 2012-10-05T10:31:09+0300
~5g# sk-hmacsha256 Seretiey 2012-10-05T10:31: 2040300
ke sk-hmacsha3s4 Secretkey 2012-10-05T10:51:31+0300
-5k sk-hmacsha512 Secretkey 2012-10-05T10:31:45+0300
-l skrc2 Secretkey 2012-10-05T10:51:55+0300
El uleeds-udn-trust RSA 2043 2020-05-30713:48:353+0300 2013-04-26T15:15:26+0300 Valid Trusted
Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 0 selected

Note

When converting to a pkcs12 KeyStore type, the KeyStore password and the entry
passwords will be lost (because the pkcs12 has no passwords.

When converting from pkcsl2 to any other KeyStore type, passwords will be
required.

Note

In uber KeyStore type the alias name is case sensitive.

5.10 View Certificate Details

From the KeyStore window, you can view specific details for the selected certificate in
the Details Panel. The following certificate details will be displayed, similar to opening a
standalone certificate:

e Format;

* Version;
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Serial Number;
Validation date period,;
Public Key;

Extensions;

Signature Algorithm;
Subject/issuer;
Common Name (CN);
Organization Unit (OU);
Organization Name (O);
Locality Name (L);
State Name (ST);
Country (C);

Email (E);

Trust Status (only for Certificate entries, not for the Certificate part of Key Pairs);

Note
This field is not visible when the Certificate details are displayed for user
verification in import operations.

MD5 Fingerprint;

SHAL FingerPrint.

The Certificate Details part of the KeyStore window contains also the following actions
available:

Test on Custom Protocol - which will open a new window for testing the certificate against
a raw TCP/IP connection with the possibility to send text requests;

Get Revocation Status - which will open a dialog to check the revocation status;

View Associated CRL - which will open a new tab to view the entire Certificate
Revocation List associated to the certificate in case one is available in the certificate
extension;

Open Public Key - which will position the TreeTable on the Public Key node under the
Certificate entry and will populate the Details Panel with details about the Public Key
(algorithm, key size, modulus, public exponent, ASN.1);

PEM - which will open a new window containing the PEM representation of the certificate;

ASN.1 - which will open a new window containing the ASN.1 representation of the
certificate.

Display more certificate fingerprints - which will expand the list of certificate fingerprints
by adding to the list the fingerprints of a certificate in the following hashes: MD2,
MD4, RIPEMD-128, RIPEMD-160, RIPEMD-256, SHA-224, SHA-256, SHA-384 and
SHA-512.

Display less certificate fingerprints - which will collapse the list of certificate fingerprints
by removing from the list the fingerprints of a certificate in the following hashes: MD2,
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MD4, RIPEMD-128, RIPEMD-160, RIPEMD-256, SHA-224, SHA-256, SHA-384 and

SHA-512.
A screenshot for Certificate's Details in the KeyStore window can be seen below:
% C:/Program Files (+86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity =]
File Edit KeyStore Signatures View Tools Window Help
dps GO S D @I hE X e &Y il
7/ JCEKS-KeyStore-Sample.jee m\ 3/ IKS-KeyStore-sample. jks s=| EEE

2| Change KeyStore Password {3 View [ Convert KeyStore Type -y Generate Key Pair  5-# Generate Secret Key gi; 551 Certificates Retriever ﬂ*" Import Key Pair Import Certificate

Entry Alias & Key Type Expire Date Last Modified Validity Status Trust Status
‘E‘ kp-mdSrsaver3 R5A 1080 2014-10-05T10:50:36+0300 2012-10-05T11:01:474+0300  Valid =
% kpshalrsaverl RSA 2048 2014-10-05T10:52:25+0300 2012-10-05T11:01:47+0300 Valid
‘E‘ kp-shalrsaver3 R5A 2048 2013-02-05T10:55: 1240200 2012-10-05T12:114:394+0300  Expired
@ kp-with-expired-cert RSA 2048 2012-10-06T12:24:35+0300 2012-10-05T12:24:39+0300 Expired
—--‘E‘ kp-with-ext D5A 1024 2014-00-04T13: 12:15+0300 2012-10-05T11:07:544+0300  Valid |
i@ Private Key

£+ Certificate Chain
L 5B saroeosaveswinexensosl L
~#—g Public Key
"4+ Extensions
-[&] uleeds-udn-trust RSA 2048

2020-05-30T13:48:38+0300 2013-04-26T15:14: 1640300 Valid Trusted

MM

Certificate Details

Q Test on Custom Protocal E Get Revocation Status E View Associated CRL

Format: Wersion: Subject [ Issuer (self signed certificate):
X.509 3 (O=SampleDSAVer3 Organization Name,OU=SampleDSAVer3 Crganization Unit, CN=SampleDSAVer3 With Extensions EB
Serial Number: Common Name (CN): | SampleDSAVer3 With Extensions
5
e -g Organization Unit (OU):  SampleDSAVer3 Organization Unit £
Valid from:

Organization Name (0):  SampleDSAVer3 Organization Mame
2012-09-03T13:12:15+0300
Locality Name {L):

To:

2014-09-04T13: 12: 1540300 B B
Public Key: CEEch

DSA 1024 bits Email (E):

Extensians:

Authority Key Identifier, Basic Co ASN,1

Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

5.11 View Public Key Details

When selecting a Public Key entry alias in the KeyStore window, the Public Key Details are
displayed at the bottom of the window. The Public Key Details that can be retrieved this way,

are:

Algorithm;

Key size;

Parameters Specification (for Elliptic Curve keys);
ASN.1 representation;

Fields, depending on the Algorithm type:

* Fields of RSA Public Key: Modulus, Public Exponent.

* Fields of DSA Public Key: Base Generator G, Prime Modulus P, SubPrime Q, Public
Key.
* Fields of EC/ECGOST3410 Public Key: Public Point Affine X-coordinate, Public Point

Affine Y-coordinate, Cofactor, First Coefficient A, Second Coefficient B, Finite Field
Size, Generator Affine X-coordinate, Generator Affine Y-coordinate, Generate Order.

A screenshot for a certificate's Public Key Details can be seen below:
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% C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/ICEKS-KeyStare-Sample.jce - CERTivity
File Edit KeyStore Signatures View Tools Window Help

I = \G-J B 5@ ¥ BidgEXilk

f=lE =]

J?LIS_"'.@I%? FEHIZS SME

E| El digicert root ca

-++ Extensions

RSA 2048

2014-07-26T21:15:15+0300

2012-10-05T10:35: 1840300

=/ Windows Root CA KeyStore | [5] delidous.cer | |7 UBERKeyStore-Sample.ubr 8| | JCEKS-KeyStore-Sample.jce |

EHEE

Valid

Trusted

3/ Change KeyStore Password ¥z View / Convert KeyStore Type & Generate Key Pair 5% Generate Secret Key ‘3(3 SSL Certificates Retriever ﬂ}i Import Key Pair E Import Certificate

Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T10:35;41+0300 Valid Trusted -
El delicious.com RSA 2043 2013-08-25T19:49, 3040300 2013-04-26T15:15:26+0300 Valid Mot Trusted

T Y Y O

Ay kp-dsaverl DSA 896 2014-10-05T12:13:37+0300 2012-10-05T12:15:21+0300 Valid B
[ -H‘ kp-dsaver3 D5A 512 2014-10-06T 10:39: 2040300 2012-10-05T 10:56:05+0300 Valid
.y kp-mdarsaverl RSA 2048 2014-10-06T10:43; 1140300 2012-10-05T10:56; 31+0300 Valid
- -H‘ kp-md2rsaver3 RSA 2043 2014-10-05T10:47: 1940300 2012-10-05T 10:56:53+0300 Valid
.y kp-mdSrsaverl RSA 2048 2014-10-05T10:49; 0440300 2012-10-05T12:15; 1440300 Valid
- Ay kp-mdSrsaver3 RSA 1080 2014-10-05T10:50: 36+0300 2012-10-05T10:57:18+0300 Valid
.y kpshalrsaverl RSA 2048 2014-10-05T 10052, 25+0300 2012-10-05T 157 29+0300 Valid -
Public Key Details
Algorithm: Key Size: ASN. 12 -
RSA 2048 DER Sequence
DER Sequence
Fields: Objectldentifier(1.Z.840.113549| |
NULL [
Modulus 0xCECCEST3E6FBD4BBES2D2D32A6DFESE13FCICD2549B6712AC3D5943467A20A1CB0 DER Bit String[270, 0]

Public Exponent | 5F&32640B1C4B7BZEFD098A4A341593AD3DCI4DE3CDBT438R44ACC4D2582FT4AR553
1238EEF3496D71917E63B6RBAG5FC3A484FB4F6251BEFBCSECDB3B9ZE306E508310C
C4284155FBCBSARI157E71EB35BF4D72093DBE3R38505B77311B80B3CTZ4459RR7AC
6D00145A04B7BA13EBS10ASE4141224E656187814150A6795C83DE1S94A5TDS2EEESD
1C532CT7ESBCDIANE16R46873003404135CA171D35ATCSSDBEEG4EL378T305604E511
B4298012F1793988R202117C2766B788B778FZCAORRE38RB0RE4CZBFE65D9584C1R1

3082010a0282010100céccesT73e6fbd
22c3d5943467220alcb05£692640b1c| |
74382442cc4d2582£74225531238e1,
SlbefBcSecdb3852e306e508510cod2
be3a38505b77311ba8db3c724453%2aTa
65618781415026795c89de194a57d52

Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 0 selected

5.12 View Certificate Extensions Details

Certificate extensions offer more information about the certificate by extending the original
X.509 certificate standard information with additional identification information or information
about the cryptographic capabilities and restrictions in usage of the certificate. Only V3
certificates can have extensions.

When selecting an Extensions entry alias in the KeyStore window, the certificate extensions
details are displayed at the bottom of the window. The extensions details panel can also be
obtained by clicking on the "Open" button next to the extensions text field in the certificate
panel.

CERTivity allows viewing the extensions contained in a certificate and can display the content
of the following extensions:

« Authority Information Access;

< Authority Key Identifier;

* Basic Constraints;

¢ CRL Distribution Points;

« Extended Key Usage;

¢ Issuer Alternative Name;

» Key Usage;

* Netscape Cert Type;

¢ Private Key Usage Period;

¢ Subject Alternative Name;

« Subject Information Access;

CERTivity®'s KeyStore 61



 CERTivity

e Subject Key Identifier;

« Inhibit Any Policy;

* Name Constraints;

e Policy Constraints;

e Freshest CRL;

« Certificate Policies;

* Policy Mappings;

* Subject Directory Attributes.

A screenshot for certificate extensions can be seen below:

" C:/Program Files (486)/Edulib/CERTivity/ doc/samples/keystore/JCEKS- KeyStore-Samplejce - CERTivity =N =]
File Edit KeyStore Signatures View Tools Window Help
=] zas g ¥ L] L\\y
iy G B ID @ X = i Eh 5t T o Y e
2| Windows Root CA KeyStore HlEldE\iuuus.cer 8| |7 UBER-KeyStore-Sample.ubr Bil % JCEKS-KeyStore-Sample.joe Hl lI]EJ@

3/ Change KeyStore Password {3 View / Convert KeyStore Type -y Generate Key Pair -+ Generate Secret Key Q’i S50 Certificates Retriever E’. Import Key Pair Import Certificate

Entry Alias & Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15: 145040300 2012-10-05710:35:41+0300 valid Trusted -
El delicious.com RSA 2048 2013-08-25T19:4%9: 30+0300 2013-04-26T15:15;26+0300 Valid Not Trusted
= El digicert root ca RSA 2043 2014-07-26T21:15:15+0300 2012-10-05T10:35:18+0300 valid Trusted
g Public Key =
"+ Extensions
-H‘ kp-dsaver1 DSA 836 2014-10-05T12:13:37+0300 2012-10-05T12:15:21+0300 Valid [
.y kp-dsaver3 DSA 512 2014-10-06T10:39; 2040300 2012-10-05T10:56; 05+0300 Valid
-H‘ kp-md2rsaver 1 RSA 2043 2014-10-06T10:43: 1140300 2012-10-05T 10:56: 31+0300 Valid
.y kp-mdarsaver3 RSA 2048 2014-10-05T10:47,19+0300 2012-10-05T10:56; 53+0300 Valid
-8y kp-mdSrsaver1l RSA 2043 2014-10-05T10:49; 0440300 2012-10-05T12:15: 1440300 valid
.y kp-mdSrsaver3 RSA 1080 2014-10-05T10:50; 36+0300 2012-10-05T10:57; 18+0300 Valid
-8y kp-shalrsaverl RSA 2043 2014-10-05T10:52: 2540300 2012-10-05T 10:57: 28+0300 valid -
Certificate i

Extensions: Extension Value:

Basic Constraints (2.5.29.19) [C]

Extended Key Usage (2.5.22.37)

Authority Information Access (1.3.6,1.5.5.7.1.1)
CRL Distribution Points (2.5.29.31)

Subject Key Identifier {2.5.29.14)

Key Usage (2.5.22.15)

Authority Key Identifier {2.5,.29.35)
1.2.840.113533.7.65.0 (1.2.840.113533.7.65.0)

Subject is CA: Yes
Path Length Constraint: 1

Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 0 selected

The extensions that exist in a certificate are displayed in a list (left side of bottom panel)
using their name and their Object Identifier (OID). For the ones which are not recognized,
only the OID will be displayed.

Also, extensions which are marked as critical can be identified by the symbol "[C]" at the
end of the name.

The value of each extension is displayed in the right side of the bottom panel when selecting
it from the list. The content is displayed in a text format, having indentation where needed
(when some fields have other sub fields) for a better representation and to be easy to read.

5.12.1 View Certificate Extensions ASN.1 Representation

CERTivity allows displaying the ASN.1 representation for each extension (even for those
which are not yet recognized). To see the ASN.1 representation click on the button "ASN.1"
from the bottom right corner of the extensions panel. A new dialog will open displaying the
ASN. 1 content.
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This dialog can be seen in the screenshot below:

=

CRL Distribution Points - ASN.1 Dump ==

DER Sequence
DER Sequence
Tagged [0]
Tagged (0]

Tagged [§] IMPLICIT
DER Octet Stringl51]
6B87474703aZfZ2f6372

&1

£2 57374Ze636f6d2f41646454727573
T44578746572€e

http://crl _usercrust_com/AddTrus
tExternalCARoot.cxrl

[ Copy ][ Close ][ Help ]

Note

When clicking the "ASN.1" button, the dialog will display the ASN.1 content of the
selected extension from the extensions list (in the left of the extensions panel).

5.13 View Certificate Chain Details

In order to view certificate chain details, open the desired KeyStore (Menu Fi | e > Open >
Open KeySt or e) and click on the entry alias Certi fi cate Chai n.

In the bottom part of the window, you can see the list with all the certificates. More details
for all the certificates from the list can be obtained by selecting one certificate and clicking
on Open as well as selecting the certificate directly from the Tree view. It is also possible
to select a certificate from the chain and copy it into the clipboard in order to paste it into
another KeyStore or even in the current one.

" C:/Program Files (486)/EduLib/CERTivity/ doc/samples/keystore/PKCS12-KeyStore-Sample,pl2 - CERTivity N [l -=-] ]
File Edit KeyStore Signatures View Tools Window Help
5 = " ] a® >
T @R DE X B EX L BN RS
(5] sampieDSAVer Leer 3 4 BKSeyStore-Sample.bks s¢] = JCEKSKeyStore-Samplece 5| 5] PKCS 12KeyStore-Sanple.p12 5| LHEE

4/ Change KeyStore Password {3 View [ Convert KeyStore Type -y Generate Key Pair  5-# Generate Secret Key ‘)(3 S5L Certificates Retriever ﬂ)i Import Key Pair Import Certificate

[=h-8-g kp-dsaverl
. ®u Private Key

&y kp-dsaver3
g kp-md2rsaver 1

g kp-mdZrsaver3

DSA 512
RSA 2043
R5A 2043

2014-10-06T10:39: 2040300
2014-10-06T10:43: 1140300
2014-10-05T10:47: 1940300

2013-05-01T16:05:40+0300
2013-05-01716:05:40+0300
2013-05-01T16:05:40+0300

Valid
valid
Valid

Entry Alias & Key Type Expire Date Last Modified Validlity Status Trust Status
-[5] certwith extensions  RSA 1024 2013-09-03T15:14:5040300  2013-05-01T16:05:53+40300  Valid Trusted -
- [F delicious.com RSA 2048 2013-05-25T19:49,3040300  2013-05-01T16:05:5340300  Valid Not Trusted I
(5] digicert root ca RSA 2048 2014-07-26T21:15:1540300  2013-05-01T16:05:53+40300  Valid Trusted
DSA 896 Z014-10-05T12:1 33740300 2013-05-01T16:05:4040300  Valid E

e N A N R A

[E sampleDsavert
- [5] SampleDSAver3

Certificate Chain Details

Certificates:

SampleDSAVer 1 Open
SampleDSAVer3

Case Aware Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

5.14 View Private Key Details

When selecting a Private Key entry alias in the KeyStore window, after introducing the correct
password, the Private Key Details are displayed at the bottom of the window. The Private
Key Details that can be retrieved this way, are:
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e Algorithm;

« Key size;

« Parameters Specification (for Elliptic Curve keys);
e ASN.1 representation;

« Fields, depending on the Algorithm type:

* Fields of RSA Private Key: Modulus, Private Exponent, Public Exponent, CRT
Coefficient, Prime Exponent P, Prime Exponent Q, Prime Modulus P, Prime Q.

 Fields of DSA Private Key: Base Generator G, Prime Modulus P, SubPrime Q, Private
Key Value.

» Fields of EC/ECGOST3410 Private Key: Private Value S, Cofactor, First Coefficient
A, Second Coefficient B, Field Size, Seed, Generator Affine X-Coordinate, Generator
Affine Y-Coordinate, Generator Order.

A screenshot for Private Key Details can be seen below:

% C/Program Files (xB6)/Edulib/ CERTivity/doc/samples/keystore/PKCS12-KeyStore-Sample 12 - CERTivity =R =]
File Edit KeyStore Signatures View Tools Window Help
s 7 [ B | i ERE e Sy
T | - = [ 9 = = Ve L A ki ]
(5] sampleDSAverLcer 5| 7 BKS-KeyStoreSample.bks 3 |5 JCEKSeyStore-Samplejee 5| |3) PKCS12eyStoreSample.p12 %] EHEE

3 Change KeyStore Password 3| View / Convert KeyStore Type  ®-g Generate Key Pair 5+ Generate Secret Key Q’i S50 Certificates Retriever ﬂ3’. Import Key Pair Import Certificate

Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
B cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2013-05-01T16:06:17+0300 Valid Trusted -
El delicious.com RSA 2048 2013-08-25T19:49:30+0300  2013-05-01T16:06: 1740300  Valid Mot Trusted
B digicert root ca RSA 2043 2014-07-26T21:15:15+0300 2013-05-01T16:06:17+0300 Valid Trusted

=) &y kp-dsaveri DSA 896 2014-10-05T12:13,37+0300 2013-05-01T16:06;17+0300 Valid =
| ety ! ' | |
E] [rﬁ‘ Certificate Chain
-- El SampleDSAVer1 N
- El SampleDSAVer3

Base Generator G |oxz2a487A9E356783171A5B61E52F45DD396TAG0573174019CB15958118
Prime Modulus P || 36E3FD0ES45EF15252292429C973060473546B987EAZTCEE300RE06233

SubPrime Q T8574ClADFF320D30DFCC1B7BCETT0EFZAZSESZASEZDED2S01D124AFZD

ObjectIdencifier(l.2.840.10040.4.1)
DER Sequence
Integer|(

Integer (74359707515440816857

-8y kp-dsaver3 DsSA 512 2014-10-06T10:39: 2040300 2013-05-01T16:06:17+0300 valid
-8y kp-md2rsaverl RSA 2043 2014-10-06T10:43: 1140300 2013-05-01T16:06:17+0300 Valid
&y kp-mdarsaver3 RSA 2048 2014-10-05T10:47,19+0300 2013-05-01T16:06;17+0300 Valid =
Private Key Details
Algorithm: Key Size: ASN.1: -
DsA 896 DER Sequence
Integer(0) =
Fields: DER Sequence

Private Key Value || 3FDC37ESABEEEECS3CA0BF3Fa71B4D083 6498 6BBADF4DEFFZT70B Integer (714904154116914651810111420%

DER Qctet Stringlzz]
0214570£0ecaléd44aBbesead7b7a4dz356311237 ~

Case Aware Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

5.15 Generate Key Pair

In order to generate a Key Pair and add it into the current KeyStore, click on Gener at e Key
Pai r . A new window will be opened, containing:

« asection for Keys, where you have to select the desired algorithm and size for the future
Key Pair;

 a section for the Certificate, where you have to complete the certificate related fields.
This section contains 2 tabs:

* A tab which allows adding information to the certificate such as the version of the
certificate, if it will be signed by the selected CA Issuer, signature algorithm, validity
period, serial number, common name, and other optional fields such as organization,
organization unit, locality name, state name, country or email address;
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« A tab which allows adding extensions to the certificate for version 3 certificates. This
tab is enabled when the "Version 3" option is selected in the first tab.

« an alias for the Key Pair entry in the current KeyStore.

A screenshot for generate key pair action can be seen below:

% C:/Program Files (86)/EduLib/CERTivity/doc/samples/keystore/IKS-KeyStore-sample.jks - CERTivity o [ B &®
File Edit KeyStore Signatures View Tools Window Help
=) & B B

8 S A ? v o [l % e

|:‘] Readme.txt & JKS-KeyStore-sample. jks ml lr B @
i Change KeyStore Password s View / Convert KeyStore Type |-y Generate Key Pair| 5+ Generate Secret Key B 551 Certificates Retriever E7. Import Key Pair E Import Certificate

Entry Alias 4 Key| 7 Generate Key Pair (=3 Trust Status
@[3 certwith extensions  RSA|  geys: Trusted
#l-[3] deiidous.com RSA Mgorittm: @ EEE DA ) EC Mot Trusted
@ [3] digicert root ca RSA Trusted

Key Size: | 2.048 =

Common Mame (CN):
Organization Unit {OU):

Organization Mame (0):

Sample Common Name
Sample arganization Unit

Sample organization Name

)-8y kp-dsaverl DsA

+"Er' kp-dsaver3 DSA

-8y kp-md2rsaver1 Rsa|  Certificate:

+n|¥ kp-mdzrsaver3 RSA Add certificate information > Add certificate extensions

184 kp-mdsrsaver 1 RsA| [ certificate Info | Certificate Extensions

+‘E" kp-md rsaver3 RSA Wersion: (T Version 1 @) Version 3

E: .y kpshalrsaverl RSA Sign By <...>

)-8y kp-shairsaver3 RSA

“ge kershalrsa Signature Algorithm: | MDSWithRSA -
£}y kp-with-expired-cert  RSA =

*‘E‘F kp-with-ext Dsa Validity Period: 1] |Year(s) -~
w1 (3] deeds-udn-tust RSA Serial Number: | 349171 Generate Trusted

Locality Mame {L):
State Name (ST):

Country (C): MNone -

Email {E):

Alias:  |sample_key_pair|

OK H Cancel H Help

Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

Depending on the RSA/DSA algorithm selected, the key size and the signature algorithm are
different while for EC(DSA)/ECGOST3410 Parameter Specification is involved.

e For RSA the minimum and maximum key sizes are configurable. The minimum key size
can be setfrom Menu Tool s > Opti ons > RSA Key Pair min size. The minimum
key size allowed is 1024 bits. It can be set past this value to impose a higher minimum
key size, to avoid generating keys under a certain size. The maximum key size is also
configurable from Menu Tool s > Opti ons > RSA Key Pair nax si ze. Thereason
for this is that for higher RSA key size values the processing time for creation, as well as
for using that key for encrypting/decrypting will be too big which will be very unsuitable
in production. The key-size has to be a multiple of 8 - this is also the spinner increment.

If a value smaller than the minimum key size or larger than the maximum key size is
provided, then a warning will be issued upon pressing OK.

The default key size value that appears initially in the Generate Key Pair dialog can be
set from Menu Tool s > Options > RSA Key Pair default size.

The signature algorithm for RSA can be one of the followings: MD5W t hRSA,
MD2W t hRSA or SHA1TW t hRSA. The default signature algorithm is MD5W t hRSA.
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« For DSA the minimum key size is 512 bits and the maximum is 1024 bits. The key size
must also be a multiple of 64 - this is ensured by the spinner. If a value out of the range
512- 1024 is provided then a warning will be issued upon pressing OK.

The signature algorithm for DSA can only be SHA1W t hDSA.

* For EC(DSA) and ECGOST3410 key types you have to use the available named curves
via supported Parameter Specifications as below. Note that depending on the KeyStore
type the available parameter names may vary:

e For EC(DSA):

c2t nb191v3,

c2tnb191v2,

c2t nb191v1,

c2t nb359v1,

primel92vl, prinel92v2, prinel92v3, c¢2tnb239v3, c2tnb239v2,
c2t nb239v1, prinme256vl, c2tnb431rl, prine239v3, prine239v2,
pri me239v1, sect 233r1, secpll2r?2, secpllzri, secp256k1l
sect 113r 2, secp521r1, sect 113r1, sect 409r 1, secpl9zrl
sect 193r 2, sect 131r 2, sect 193r1, sect 131r1, secpl60kl
sect571r1, sect 283k1, secp384r1, sect 163k1, secp256r1
secpl28r 2, secpl28ri, secp224ki, sect 233k1, secpl60r 2,
secpl60rl, sect 409k1, sect 283r1, sect 163r 2, sect 163r1l
secpl92kl, secp224rl, sect239kl, sect571k1l, B-163, P-521, P-256,
B- 233, P-224, B-409, P-384, B-283, B-571, P-192, c2pnb272wl*,
c2pnb208wl*, c2pnb163v3*, c2pnbl163v2*, c2pnbl63v1*,
c2pnbl76wl*, c2pnb304wl*, br ai npool p512r 1*, c2pnb368wl*,

br ai npool p384t 1*,
br ai npool p512t 1*,
br ai npool p320r 1*,
br ai npool p224t 1*,
br ai npool p160t 1*.

br ai npool p256r 1*,
br ai npool p256t 1*,
br ai npool p192t 1*,
br ai npool p384r 1*,

br ai npool p192r1*,
br ai npool p224r 1*,
br ai npool p160r 1*,
br ai npool p320t 1*,

The names marked with * are supported only by Bouncy Castle's KeyStores UBER,
PKCS#12 and BKS. They are not supported for KeyStores of type JKS or JCEKS.
It is strongly recommended to use only the common set of parameter specifications
to avoid incompatibility issues between the different providers. CERTIivity is avoiding
the import operations with unknown EC parameter names, or the above * marked
ones as these may lead to corruption of the JKS KeyStores, for example. Also, not
all the operations may work with the EC parameter names marked with * or unknown
parameter specifications.

* For ECGOST3410: Gost R3410-2001- Crypt oPro- A, Gost R3410- 2001-
Crypt oPro- XchB, Gost R3410-2001- Crypt oPro- XchA, Gost R3410-2001-
CryptoPro-C, GostR3410-2001-CryptoPro-B.

5.15.1 Manage Certificate Extensions

Certificate extensions are used to offer more information about the certificate by extending
the original X.509 certificate standard information with additional identification information or
information about the cryptographic capabilities and restrictions in usage of the certificate.

In order to be able to add extensions to the certificate, select the Certificate
Ext ensi ons tab (the Version 3 option has to be selected inthe Certificate Info tab.
Version 1 certificates do not accept extensions, therefore the tab is disabled for version 1
certificates).

This tab offers the possibility to create a new set of extensions for the certificate, or load a
set of extensions from a previously saved template. The extensions are represented in this
dialog using a tree-like list, as it can be seen below:
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“ Generate Key Pair
Keys:

Certificate:

Certificate Info | Certificate Extensions

Algorithm: @) RSA (T DSA () EC

-

Key Size: | 2.048 =

Add certificate information > Add certificate extensions

| extensions
B , Basic Constraints
[ @ IsCA
; ‘.. @ Path Length Constraint
.
= | Autharity Key Identifier
i Key Identifier
[=+- | Authority Certificate [ssuer
=+ || General Name
E} , Directory Name
i #% Common Mame

‘.. # Organization

# Organization Unit

Digital Signature
[] Mon Repudiation
[7] Key Encipherment
[7] Data Endpherment
[T] Key Agreement

[T] Key Cert Sign

»

m

View As XML ] [ Load Extensions ] [ Save Extensions

Tk

-

Message Type

Field

Error

Alias:

sample_key_pair

l Ok H Cancel ][ Help

The extensions of the certificate together with their items can be added in the tree list from
the left side (as it can be seen in the above picture), while on the right side, the values of
each added extension item can be set after selecting the item for which the value should be

set from the left side tree.

5.15.1.1 Creating an extension

To create an extension, the following steps must be performed:

* Right click on the extensions item from the extensions list;

¢ From the contextual menu that appears, select one of the available extensions;
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Certificate Info | Certificate Extensions

s cinn [

Add Authority Key Identifier

Add Basic Constraints

Add CRL Distribution Points
Add Extended Key Usage

Add Key Usage

Add Metscape Cert Type

Add Private Key Usage Period
Add Subject Key Identifier

Add Certificate Policies

Add Policy Mappings

Add Subject Alternative Mame
Add Issuer Alternative Mame
Add Authority Infformation Access
Add Subject Information Access

Add Inhibit Any Policy u
Add Mame Constraints

Add Policy Constraints i

Add Freshest CRL

Add Subject Directory Attributes

CERTIivity allows adding the following 8 extensions to a certificate:
* Authority Key ldentifier:

This extension is used for identifying the public key corresponding to the private key
used to sign a certificate. It is used where an issuer has multiple signing keys (either
due to multiple concurrent key pairs or due to changeover). The identification may be
based on either the key identifier (the subject key identifier in the issuer’s certificate)
or on the issuer name and serial number. For more details please see RFC 5280 -
4.2.1.1 Authority Key Identifier [http://tools.ietf.org/html/rfc5280#section-4.2.1.1].

CERTivity allows computing the value of the keyldentifier field by deriving it from the
public key (issuer public key) used to verify the certificate's signature. There are two
available methods used by CERTivity for generating the key identifier:

* 160-bit hash of the value of the bit string of the public key;
* 64-bit hash of the value of the bit string of the public key.
+ Basic Constraints:

This extension identifies whether the subject of the certificate is a CA (using the isCA
field) and the maximum depth of valid certification paths that include this certificate
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(using the pathLengthConstraint field). For more details please see RFC 5280 -
4.2.1.10 Basic Constraints [http://tools.ietf.org/html/rfc5280#section-4.2.1.9].

* CRL Distribution Points:

This extension identifies how CRL information is obtained. The cRLDistributionPoints
extension can contain one or more DistributionPoint items. A Distribution Point
consists of three fields, each of which is optional: di stri buti onPoi nt, reasons,
and cRLI ssuer . Each of these fields is optional, but a DistributionPoint must not
consist of only the reasons field; either distributionPoint or cRLIssuer must be present.
For more details please see RFC 5280 - 4.2.1.14 CRL Distribution Points [http://
tools.ietf.org/html/rfc5280#section-4.2.1.13].

» Extended Key Usage:

This extension indicates one or more purposes for which the certified public key may
be used, in addition to or in place of the basic purposes indicated in the key usage
extension. In general, this extension will appear only in end entity certificates. For more
details please see RFC 5280 - 4.2.1.13 Extended Key Usage [http://tools.ietf.org/html/
rfc5280#section-4.2.1.12].

* Key Usage:

This extension defines the purpose (e.g., encipherment, signature, certificate signing)
of the key contained in the certificate. The usage restriction might be employed when
a key that could be used for more than one operation is to be restricted. For example,
when a RSA key should be used only to verify signatures on objects other than public
key certificates and CRLs, the digitalSignature and/or nonRepudiation bits would be
asserted. Likewise, when a RSA key should be used only for key management, the
keyEncipherment bit would be asserted. For more details please see RFC 5280 -
4.2.1.3 Key Usage [http://tools.ietf.org/html/rfc5280#section-4.2.1.3].

* Netscape Cert Type:

This extension is used for limiting the applications for a certificate. If the extension
exists in a certificate, it will limit the uses of the certificate to those specified. The
following values are available:

e SSL d ent: the certificate is selectable when a server requests a certificate;

e SSL Server: the Netscape Communicator will talk to a server (otherwise it will
complain that the certificate is invalid);

« SSMME dient: the certificate can be used for SIMIME signing and encryption;

e Obj ect Signi ng: the certificate can be used for signing objects such as Java
applets and plugins;

» Reser ved: this bit is reserved for future use;
e SSL CA: the certificate can be used for issuing certificates for SSL use;
« S/ M ME CA: the certificate can be used for issuing certificates for SIMIME use;

e Obj ect Signing CA: this certificate is certified for issuing certificates for Object
Signing.

 Private Key Usage Period:
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This extension allows the certificate issuer to specify a different validity period for the
private key than the certificate. This extension is intended for use with digital signature
keys. This extension consists of two optional components, notBefore (the date from
when the certificate can be used) and notAfter (the date until the certificate can be
used). For more details please see RFC 3280 - 4.2.1.4 Private Key Usage Period
[http://tools.ietf.org/html/rfc3280#section-4.2.1.4].

Subject Key Identifier:

This extension provides a means of identifying certificates that contain a particular
public key. For more details please see RFC 5280 - 4.2.1.2 Subject Key Identifier
[http://tools.ietf.org/html/rfc5280#section-4.2.1.2].

CERTivity allows computing the value of the keyldentifier field by deriving it from the
public key (subject public key) used to verify the certificate's signature. There are two
available methods used by CERTIvity for generating the key identifier:

» 160-bit hash of the value of the bit string of the public key;
» 64-hit hash of the value of the bit string of the public key.

Certificate Policies:

This extension contains a sequence of one or more policy information terms, each
of which consists of an object identifier (OID) and optional qualifiers. In an end entity
certificate, these policy information terms indicate the policy under which the certificate
has been issued and the purposes for which the certificate may be used. In a CA
certificate, these policy information terms limit the set of policies for certification paths
that include this certificate. For more details please see RFC 5280 - 4.2.1.4. Certificate
Policies [http://tools.ietf.org/html/rfc5280#section-4.2.1.4].

Policy Mappings:

This extension is used in CA certificates. It lists one or more pairs of OIDs; each pair
includes an i ssuer Donmi nPol i cy and a subj ect Dorai nPol i cy. The pairing
indicates the issuing CA considers its i ssuer Domai nPol i cy equivalent to the
subject CA's subj ect Dormai nPol i cy. For more details please see RFC 5280 -
4.2.1.5. Policy Mappings [http://tools.ietf.org/html/rfc5280#section-4.2.1.5].

Subject Alternative Name:

This extension allows identities to be bound to the subject of the certificate. These
identities may be included in addition to or in place of the identity in the subject
field of the certificate. Defined options include an Internet electronic mail address, a
DNS name, an IP address, and a Uniform Resource Identifier (URI). For more details
please see RFC 5280 - 4.2.1.6. Subject Alternative Name [http://tools.ietf.org/html/
rfc5280#section-4.2.1.6].

Issuer Alternative Name:

This extension is used to associate Internet style identities with the certificate issuer.
For more details please see RFC 5280 - 4.2.1.7. Issuer Alternative Name [http://
tools.ietf.org/html/rfc5280#section-4.2.1.7].

Authority Information Access:
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This extension indicates how to access information and services for the issuer of the
certificate in which the extension appears. Information and services may include on-
line validation services and CA policy data. (The location of CRLs is not specified in this
extension; that information is provided by the cRLDi st ri but i onPoi nt s extension).
This extension may be included in end entity or CA certificates. For more details
please see RFC 5280 - 4.2.2.1. Authority Information Access [http://tools.ietf.org/html/
rfc5280#section-4.2.2.1].

» Subject Information Access:

The Subject Information Access extension indicates how to access information and
services for the subject of the certificate in which the extension appears. When the
subject is a CA, information and services may include certificate validation services
and CA policy data. When the subject is an end entity, the information describes
the type of services offered and how to access them. In this case, the contents of
this extension are defined in the protocol specifications for the supported services.
This extension may be included in end entity or CA certificates. For more details
please see RFC 5280 - 4.2.2.2. Subject Information Access [http://tools.ietf.org/html/
rfc5280#section-4.2.2.2].

« Inhibit Any Policy:

This extension indicates that the special anyPol i cy OID, with the value {2 5
29 32 0}, is not considered an explicit match for other certificate policies except
when it appears in an intermediate self-issued CA certificate. The value indicates the
number of additional non-self-issued certificates that may appear in the path before
anyPol i cy is no longer permitted. The inhibit anyPolicy extension can be used in
certificates issued to CAs. For more details please see RFC 5280 - 4.2.1.14. Inhibit
anyPolicy [http://tools.ietf.org/html/rfc5280#section-4.2.1.14].

+ Name Constraints:

This extension indicates a name space within which all subject names in subsequent
certificates in a certification path MUST be located. This extension MUST be used
only in a CA certificate. Restrictions apply to the subject distinguished name and apply
to subject alternative names. Restrictions apply only when the specified name form is
present. If no name of the type is in the certificate, the certificate is acceptable. For
more details please see RFC 5280 - 4.2.1.10. Name Constraints [http://tools.ietf.org/
html/rfc5280#section-4.2.1.10].

 Policy Constraints:

The Policy Constraints extension constrains path validation in two ways. It can be
used to prohibit policy mapping or require that each certificate in a path contain an
acceptable policy identifier. If the i nhi bi t Pol i cyMappi ng field is present, the value
indicates the number of additional certificates that may appear in the path before policy
mapping is no longer permitted. If the r equi r eExpl i ci t Pol i cy field is present,
the value of requireExplicitPolicy indicates the number of additional certificates that
may appear in the path before an explicit policy is required for the entire path. The
policy constraints extension can be used in certificates issued to CAs. For more
details please see RFC 5280 - 4.2.1.11. Policy Constraints [http://tools.ietf.org/html/
rfc5280#section-4.2.1.11].

» Freshest CRL (a.k.a. Delta CRL Distribution Point):
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This extension identifies how Delta CRL information is obtained. The extension MUST
be marked as non-critical by conforming CAs. For more details please see RFC 5280 -
4.2.1.15. Freshest CRL (a.k.a. Delta CRL Distribution Point) [http://tools.ietf.org/html/
rfc5280#section-4.2.1.15].

» Subject Directory Attributes:

This extension is used to convey identification attributes (e.g., nationality) of the
subject. This extension is defined as a sequence of one or more attributes.
Conforming CAs MUST mark this extension as non-critical. For more details
please see RFC 5280 - 4.2.1.8. Subject Directory Attributes [http://tools.ietf.org/html/
rfc5280#section-4.2.1.8].
Each extension can be added only once. Therefore, after an extension is added, on the
next right click on the ext ensi ons root node, on the pop-up menu only the remaining
available extensions which have not already been added will be displayed.

« If the new added extension contains subitems (like the Authority Key Identifier extension
for example which contains Key Identifier, Authority Certificate Issuer, and Authority
Certificate Serial Number) these can be added in the same way, by right clicking on the
list item of the new added extension. A popup menu containing the available subitems
will be displayed. In the same way as for extensions, some of the subitems can be added
only once, so they will appear only once on the first popup menu when right clicking on
the item for which they have to be added.

Some extensions contain mandatory subitems (for example the "Is CA" field, from
Basic constraints extension), which will be added automatically when adding the new
extension item. Also, after creating the extension item, the popup menu containing the
available subitems will be automatically displayed as a form of autocompletion.

If the selected extension or subitem does not contain any more mandatory or optional
subitems, in the right side of the dialog, a panel will be displayed allowing the input of the
value of the extension or subitem. This panel will contain either a text field (for extensions
and items which allow various textual input) or a list of checkboxes for the ones which
only have certain defined values (like the Key usage extension).

» For items which allow text input, to set the filled in value, press the Set val ue button.

After each extension or subitem added, as well as after each value set for an extension
or subitem, the structure of the extension and the values are verified to ensure that they
are valid according to the RFC 3280 [http://tools.ietf.org/html/rfc3280] and REC 5280 [http://
tools.ietf.org/html/rfc5280] standards. For the extensions to be able to be created, their
structure and value has to be valid according to this standard. Otherwise, when trying to
create the certificate, a message will be displayed informing that the structure or the values
of the extensions are not valid, and asking if the certificate should be created without adding
the extensions or to return to the certificate generation dialog for correcting errors.

Note

The validity state of the structure and content of the extension can be seen at any
time at the bottom of the certificate structure list. For a valid structure, a green note
will be displaying the message "Extensions structure is valid".

If the structure is not valid, due to missing mandatory subitems or invalid values
set, the note will be displaying a red warning containing the message "Extensions
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structure is invalid". Also, under this note a table will become visible containing the
additional information about each item which is invalid. The table contains the type
of message (Error or Warning), the name of the extension item or subitem which
is invalid, and an additional message containing the details of the error, as can be
seen below:

Certificate Info | Certificate Extensions |

, extensions
=1 | Authority Key Identifier
=l Authority Certificate Issy
‘o sy General Mame

4 1 |

[ View As XML ] [ Load Extensions ] [ Save Extensions

-

Extensions structure is invalid

Message Type Field Error

Errar General Mame ve-complex-type, 2.4.b: T,
cvo-complex-type. 2.4.b: T...

Selecting a row in the table will trigger the selection of the extension item or subitem
to which the table row refers to. If the selection of the row is done having the pointer
over the last column ("Error" column) a popup dialog will also be displayed showing
the full details of the error.

Field value auto completing

For some extension fields, the value can be obtained from the information from the certificate
or which is to be set to the certificate in case of generating a new Key Pair (for example from
the serial number, or the Issuer/Subject name), or by computing hash values on the public
key from the certificate or the one which is created when generating a new Key Pair.

< For Authority Key Identifier extension:

e The value of the Key Identifier field is computed using one of the two methods
(mentioned above) for generating the hash over the issuer public key.

For generating a new Key Pair (containing a new self-signed certificate), the private
- public Key Pair is usually generated when pressing the OK button. But, if the Key
Identifier item is added for the Authority Key Identifier, a message will be displayed
requesting to generate the public key earlier, so that its hash can be generated and
used as a value for this field.
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“ Key Pair generation needed @

The value of this item requires that the public key to be generated. Do you want to generate it now?

If this request is denied, the Authority Key Identifier can still be added, but the value
will have to be set by the user.

Note

This message will not be displayed when signing CSR files, because in that
case both the public key of the issuer certificate and the public key of the
resulting CA reply are generated at the time of adding extensions to the CA

reply.

By default when generating the public key and computing the hash over it, the hash
will be 160-bit. To use the 64-bit hash, switch to the 64-bit radio button. The value
from the text field will be replaced with the 64-bit value. Also, to use back the 160-bit
value, select the 160-bit radio button.

The radio buttons can be seen in the screenshot below:

Certificate Info | Certificate Extensions |

o extensions
= | Autharity Key Identifier
W=y Identifier

Key Identifier |5462E7F3BB352FB4023A1F4B49AAEF5745B63F5:

(71 64-bit hash

* The Directory Name of the Authority Certificate Issuer, in the case in which the
Authority Certificate Issuer should be represented using a Directory Name, can be
autocompleted at generation time using the name values of the certificate Issuer DN
(which for self-signed certificates is the same with the Subject DN), if these fields have
been completedinthe Certi fi cat e | nf otab. Only the name items for which there
is a value added in the previous tab will be added. The rest can be added manually
by right-clicking on the Di r ect ory Name node, and adding a name component from
the remaining items in the popup menu.

» The Authority Certificate Serial Number extension item can have it's value taken from
the Seri al Nunber fieldintheCerti fi cate | nf otab. If the serial number was not
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set, when creating the Authority Certificate Serial Number a message will be displayed
asking to generate and set the Serial Number and also use that value for the Authority
Certificate Serial Number. If this request is denied, then the value of the Authority
Certificate Serial Number must be set manually.

* For CRL Distribution Points extension:

For this extension, the same mechanism for autocompleting values applies where
Directory Name items are used, like the one mentioned for the Authority Key Identifier
extension. The names are taken from the Issuer DN if they were added before creating
the Directory Name item.

» For Subject Key Identifier extension:
The value of this extension can be generated automatically in the same way the Key
Identifier item from the Authority Key Identifier extension can be generated (presented

above). The only differences are that for this extension the hash is computed over the
public key of the user certificate, not the public key of the issuer certificate.

5.15.1.2 Save extensions template

After creating one or more extensions, the structure of the extensions together with their
values can be saved to a file as a template, so that it can be reused for other certificate
generation. The template will be represented by an XML document.

To save an extensions template the following actions must be performed:
» Click on the Save Ext ensi ons button;

« If the extensions structure is not valid or the items contain invalid values, a warning
message will be displayed asking if the template should be saved anyway although it is
invalid. If the "No" button is pressed, it will return to the panel for adding extensions.

% Invalid extensions structure @

The content of the entered certificate extensions is not valid, Are you sure you want to save?

« In the file chooser dialog that appears, type the name for the template. It will be saved
in an XML document file.

5.15.1.3 Load extensions template

Extension structure templates previously created together with their values can also be
loaded back from a file to be used for creating the same extensions for more certificates.
To load an extension template the following actions must be performed:

e Click on Load Extensi ons button;

* From the file chooser dialog that appears, select the template file to be loaded. The
loaded extension structure will appear in the list on the left of the panel and will be
validated.
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5.15.1.4 View As XML

The extension structure can also be viewed in XML format. This XML format is the one in
which the extension structure and values will be saved in the template file if this option is
chosen.

The structure can be viewed in XML format at any time (either if the structure is valid or
invalid), by clicking on the Vi ew As XML button. A dialog will open like the one below:

% Generate Key Pair | 22| Trust Status
Keys: Mot Trusted
. s _ Mot Trusted
Algorithm: (@) @ DsSA ©EC
Mot Trusted
Key Size: | 2,048 =
Certificate:
Add certificate information >  Add certificate extensions
Certificate Info | Certificate Extensions
) extensions I e - ”
B |, Basic Constraints 0
T - . .
i i.m IsCA Extensions XML Representation @
# Path Length Constraint
i L JKey Lsage <?xml version="1_.0" encoding="UTF-3"?><ext:-extensions xmlns:ext=" +
e Authority Key Identifier <ext:authorityKeyIdentifier>
i ® Key Idn?ntﬁer ) <ext:keyIldentifier/>
- o Autherity Certificate Issuer <ext:authorityCertIssuers
B bt General Name <ext:CGeneralName>
& b Directory MName <gxt:directoryName>
i # Common Mame D
# Organization Unit - :DU'I)
i@ Organization ext Ol |
<ext:i0/> =
</ext:directoryName>
</ext:GeneralVName>
e </extzauthorityCertIssuer>
eld </ext:authorityFeyIdentifiers>
Message Type Fie <ext:basicConstraints>
<extich/>
<ext:pathlenConstraint»Z0</ext:pathlenConstraint>
Alias: |key_pd </ext:basicConstraints>
<ext:keyUsagerdigitalSignature</ext:keylUsage> e
o4 i ’ 1L} 2
[ Copy ] [ Cloze ] [ Help ]

The XML structure can be copied to clipboard with a simple click on the Copy button, or by
selecting the entire text and using the copy shortcut (CTRL-C).

The XML structure follows the tree like structure of the extensions list. The direct XML child
nodes of the ext ensi ons root node represent the extensions. The items of each extension
(when they are present) are represented as child nodes of each extension node. The name
of the XML nodes are similar to the names of the extensions and their subitems in the ASN.1
representation (which can be seen for each extension in RFC 5280 [http://tools.ietf.org/html/
rfc5280]).

5.15.1.5 Mark extensions as critical

Extensions can be marked as critical or non critical. When an extension is marked as critical,
it indicates that its value contains information of such importance that an application cannot
ignore it. If a particular certificate-using application cannot process a critical extension, the
application should reject the certificate.
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CERTivity allows marking the extensions as critical. By default, after the extension item is
created in the extensions list, the extension is considered to be non-critical.

To make an extension critical after its structure was created in the list, right click on the
extension item, and from the popup menu that appears select Criti cal extension as
it can be seen below:

Certificate Info | Certificate Extensions I_

| extensions
=~ |, Basic Constraints

Critical gxtension

N

Delete

After the extension is marked as critical, next to the extension item in the tree list the "[ C] "
symbol will be added, informing that the extension was marked as critical, as it can be seen
below:

Certificate Info | Certificate Extensions

, extensions
=] |, Basic Constraints
{ L@ IsCA

.

Also, in the right click menu for the extension item, the "Critical extension” menu will be
checked.

—

To unmark an extension that has been marked as critical, right click on the extension item
again, and from the popup menu that appears select again Cri ti cal extensi on (which
now is checked) to uncheck it.

Note

Although all extensions can be marked as critical, the "Internet X.509 Public Key
Infrastructure Certificate and Certificate Revocation List (CRL) Profile" (RFC 3280
and RFC 5280) recommends that some extensions should not be marked as critical.
If an extension is marked as critical, the application which uses the certificate has to
be able to process the extension, or otherwise to reject the certificate.

The extension creation may fail in the situation in which some of the extensions
which should not be marked critical are marked so. For example, if the Authority Key
Identifier extension is marked as critical (although the above mentioned profile does
not recommend to be marked as so), if for the Authority Certificate Issuer an Uniform
Resource Identifier is set, if the value of this URI does not have a valid form, the
creation of the extension will fail. The same situation applies to the CRL Distribution
Points extension.

The other extensions supported by CERTivity which the profile does not recommend
marking as critical are Private Key Usage Period and Subject Key Identifier.

CERTivity®'s KeyStore 77



* CERTivity

5.15.1.6 Delete extensions

The extensions and their subitems can also be deleted from the extensions structure. To
delete an individual extension or subitem the following steps can be performed:

* Select the extension or subitem to be deleted;

« Right click on it, and from the popup menu, select Del et e.

Or:
* Select the extension or subitem to be deleted;

e Press "Del et e" key.

Also, to delete the entire structure, right click on the extensions item node, and select Del et e
all.

5.16 Generate Secret Key

In order to generate a Secret Key and add it into the current KeyStore, click on Gener at e
Secret Key. In the new window, the user has the option to select from a wide range
of key algorithms and sizes. The algorithms are defined for 2 providers: for the Bouncy
Castle Provider and for the Sun JCE Provider (if it exists on the system where CERTivity
is running), allowing the user to select only the supported key sizes for each algorithm
depending on the algorithm type and provider. In case the Sun JCE Provider is not available,
the Default provider will be used which means that all the Secret Key algorithms (that
CERTivity supports) will be displayed with the key sizes starting from 1 for each algorithm.
For this case, if the algorithm or the key size is not supported by the Default provider, an
error will be displayed.

To generate a Secret Key, the user has to select a Provider, then to select an algorithm, then
a key size, and finally to enter an alias for the Secret Key which will be generated.

A screenshot for generate secret key action can be seen below:
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74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/ICEKS-KeyStare-Sample.jce - CERTivity [= HEH 2 |
File Edit KeyStore Signatures View Tools Window Help
3 E \r?'J ||:EH e ol lil a]:b f* gk Ll S .§I %5 _,w
|:‘| Readme. txt ml 7| JKS-KeyStore-sample. jks ml 3| JCEKS-KeyStore-Sample. jee m‘ m@@
3/ Change KeyStore Password ¥z View / Convert KeyStore Type  #-g Generate Key Pair | 5-# Generate Secret Key ‘3(3 SSL Certificates Retriever 3’. Import Key Pair Import Certificate
Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15: 14:50+0300 2012-10-05T10:35:41+0300 Valid Trusted
El delicious.com RSA 2048 2013-08-25T19:49:30+0300 2013-04-26T15:15:26+0300 valid Not Trusted
El digicert root ca RSA 2043 2014-07-26T21:15:15+0300 2012-10-05T10:35: 18+0300 Valid Trusted
-8y kp-dsaverl DSA 896 2014-10-05T12:13:37+0300 2012-10-05T12:15:21+0300 valid
-H‘ kp-dsaver3 D5A 512 2014-10-06T 10:39:20+0300 2012-10-05T10:56:05+0300 valid
-8y kp-md2rsaverl RSA 2048 Generate Secret Key @ Valid
-8 kp-md2rsaver3 RSA 2048 R Valid
4y kp-mdSrsaver1 RSA 2043 Valid
g kp-mdrsaver3 REA 1080 Key Algorithm Provider: i Valid
.y kp-shairsaverl RSA 2043 Key Algorithm: |, valid
-8y kp-shairsaver3 RSA 2043 Key Size: 192+ Expired
&y kp-with-expired-cert RSA 2043 Expired
g kp-with-ext DSA 1024 Valid
gk sk-aes Secretkey (=
gk sk-arcfour SecretKey
-5k sk-blowfish Secretkey oK ] [ Cancel ] [ Help
gk sk-des Secretkey
gk sk-desede Secretiey 2012-10-05T10:30:44+0300
gk sk-hmacmds Secretiey 2012-10-05T10:30:55+0300
-5 sk-hmacshal Seretiey 2012-10-05T10:31:09+0300
ke sk-hmacsha2se Secretkey 2012-10-05T10:51:20+0300
-5 sk-hmacsha3a4 Seretiey 2012-10-05T10:31:31+0300
ke sk-hmacsha512 Secretkey 2012-10-05T10:51:45+0300
gk skrc2 Secretiey 2012-10-05T10:31:58+0300
E uleeds-udn-trust RSA 2048 2020-05-30713:45:33+0300 2013-04-26T15:15:26+0300 valid Trusted
Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 0 selected

Note

JKS and PKCS#12 KeyStore types do not support storing Secret Keys. This is a
limitation of the standards, not of the CERTivity application.

The key algorithms are dictating the JCE provider and the key sizes supported. These are
depicted in the following table.

Table 5.2. Size and Provider for Secret Keys

Key Algorithm

Key Size

Provider

AES

1-256

Bouncy Castle

128 - 256, multiple of 64

Sun JCE

AESWrap

1-256

Bouncy Castle

ARCFOUR

40 - 1024

Sun JCE

Blowfish

1-448

Bouncy Castle

32 - 448, multiple of 8

Sun JCE

Camellia

128 - 256, multiple of 64

Bouncy Castle

Castb5

1-128

Bouncy Castle

Castb

1-256

Bouncy Castle

DES

64

Bouncy Castle

56

Sun JCE
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Key Algorithm Key Size Provider
DESede 128, 192 Bouncy Castle
112,168 Sun JCE
DESedeWrap 128, 192 Bouncy Castle
GOST28147 256 Bouncy Castle
Grainvl 80 Bouncy Castle
Grain128 128 Bouncy Castle
HC128 128 Bouncy Castle
HC256 256 Bouncy Castle
Noekeon 128 Bouncy Castle
RC2 1-1024 Bouncy Castle
40 - 1024 Sun JCE
RC4 40 - 2048 Bouncy Castle
RC5 1-128 Bouncy Castle
RC5-64 1-256 Bouncy Castle
RC6 1-256 Bouncy Castle
Rijndael 1-256 Bouncy Castle
Salsa20 128, 256 Bouncy Castle
SEED 128 Bouncy Castle
Serpent 128 - 256, multiple of 64 Bouncy Castle
Skipjack 1-128 Bouncy Castle
TEA 128 Bouncy Castle
Twofish 128 - 256, multiple of 64 Bouncy Castle
VMPC 128, 6144 Bouncy Castle
VMPC-KSA3 128, 6144 Bouncy Castle
XTEA 128 Bouncy Castle
HmacMD2 1- Bouncy Castle
HmacMD4 1- Bouncy Castle
HmacMD5 1- Bouncy Castle
1- Sun JCE
HmacRIPEMD128 1- Bouncy Castle
HmacRIPEMD160 1- Bouncy Castle
HmacSHA1 1- Bouncy Castle
1- Sun JCE
HmacSHA224 1- Bouncy Castle
HmacSHA256 1- Bouncy Castle
40 - Sun JCE
HmacSHA384 1- Bouncy Castle
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Key Algorithm Key Size Provider
40 - Sun JCE
HmacSHA512 1- Bouncy Castle
40 - Sun JCE
HmacTIGER 1- Bouncy Castle

5.17 Import Trusted Certificate

In order to import a trusted certificate, click on | nmpor

t certificate in the KeyStore

window. Then, the desired certificate can be selected and an entry alias can be associated

with it.
A screenshot for import trusted certificate action can be seen below:
7% C/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample jks - CERTivity [= ==
File Edit KeyStore Signatures View Tools Window Help
= =] = o L] - iil M
1 ﬂlm\% Il e e el Tt e |
[ Readme.txt 8| (5 JKSKeyStore-sample jks | =) JCEKS-KeyStore-Sample.jee | LHEE
3/ Change KeyStore Password {3 View / Convert KeyStore Type -y Generate Key Pair -+ Generate Secret Key Q’i S50 Certificates Retriever E’. Import Key Pair @ Import Certificate
Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T11:00:50+0300 valid Trusted
[ delicious.com 7 Import Certificate = Not Trusted
(5] digicert root ca . Trusted
-y kp-dsaverl Lookin: | || certificates - ok El-
% kp-dsaver3 (5] delicious.cer
g kp-md2rsaverl ’l;:’ Sl jira.cer
.y kp-md2rsaver3 REEEHYI/I:EMS —RJ sampleDSAVer 1.cer
-8 kp-mdSrsaver1 (5] sampleDSAVer 1.crt
.y kp-mdSrsaver3 L5l sampleDSAver 1.p7h
-8y kp-shairsaveri ! || sampleDSAVer 1. pipath
8y kp-sharsaver Desktop [l sampleD5AVer 1-PEMencrypt, cer
8y kp-aith-expired-cert 47‘J sampleDSAVer 1-PEMenarypt.p7b
A = [@5] sampleDSAVer 3.p7c
S kp-with-ext E [55) sampleDSAVer 3-PEMencrypt. cer
El uleeds-udn-trust My Documents sampleDSAVer 3-PEMencrypt.p7c Trusted
A
Computer
=)
A File name: |
Metwork
etuor Fles of type: [ Certificate Files (*.cer; *.crts *p7b; =.p7c; =.pkipath; =.spc) = |
Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 0 selected

If for the certificate which was selected to be imported a Trust Path can not be established, a

warning message will be displayed informing that trust
if the user would like to view the certificate and decide if
or not. The warning message can be seen below:

could not be established and asking
the import operation should be done

P

% Trust Path Verification

import operation should continue?

A trust path for the selected certificate could not be established. Importing not trusted
certificates is not recommended. Do you want to view the certificate details and decide if the

=3
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If "No" is selected or the dialog is closed, the import operation will be aborted.

If "Yes" is selected, the certificate will be displayed in a dialog with the options "Accept
Import" to continue the import, or "Cancel Import" to abort the operation which can be seen
in Certificate Trust Established by User.

5.17.1 Certificate Trust Established by User

In the situations when trust can not be established for a certificate, if the user decides to view
the certificate to establish if it can be trusted or not, the following dialog will be displayed
containing the details of the certificate:

¥ Certificate Details 3
Format: Version: Subject [ Issuer (self signed certificate):
X.509 3 O=SampleDSAVer3 Organization Name, Ol =SampleDSAVer3 Orgar El
Serial Number: Common Name (CMN):  |SampleDSAVer3
0x30343 'ﬁl Organization Unit (OU): |SampleDSAVer3 Organization Unit
Valid from:

Organization Name (0):  SampleDSAVer3 Organization Name
2012-10-05T 10:35: 2040300
Locality Mame (L):

Ta:

2014-10-08T 10: 38: 2040300 Sl
Public Key: Country (€):
DSA 512 bits Open Email (E):
Extensions:

Open [ PEM | | Ashi

Signature Algorithm:
SHA1WIthDSA

Certificate Fingerprints

MD5 Fingerprint:  |A3:8E:22:C3:39:20:67:44:B0: 4F: 25:D9:C2:C3:E0: 11 &I
SHA1Fingerprint: |FD:DC:F1:80:E8:FE:B2:79:5A:27:A3: 14:B1:00:DF: 75:D0:CT7:D5:55 El

More ...
[ Accept Import ] | Cancel Import | | Help |

If the user does not trust the certificate after viewing its details, he can abort the import
operation by pressing "Cancel Import", or by closing the dialog.

If the user decides that the certificate can be trusted after viewing its details, he can continue
the import operation by pressing "Accept Import".

5.18 Import Key Pair

In order to import a Key Pair, click on | nport Key Pai r in the KeyStore window. Three
types of Key Pairs can be imported:

« PKCS#12 - which defines a file format commonly used to store private keys with
accompanying public key certificates, protected with a password-based symmetric key;
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« PKCS#8 - which is used to carry private certificate key pairs (encrypted or unencrypted);

« OpenSSL - with which a public key doesn't need to be generated separately because
the private key contains the public key information as well;

The "Input File(s) Information" area contains the following fields, which are enabled
depending on the previously selected Key Pair type:

« the decryption password;

 the Key Pair File;

« the Private Key File;

« one or more Certificate(s) File(s);

e« an"Add More Certificates..."button which creates more Certificate(s) file input
fields.

The files for each Certificate(s) field can be selected using the Br owse button. Also, the
Certificate input fields which are not needed (except for the first one) can be removed
using the "-" (minus) button next to the Br owse button of each Certificate input field. The
Certificate(s) input fields which are empty will be ignored, but at least one of the Certificate
input fields must contain a valid value.

The Certificate input fields can accept also files which contain more certificates (such as
Certificate Chain files - ".p7b", ".p7c" files). The order in which the certificate files are provided
in the input fields is not important, as the certificates will be ordered (with the user certificate
first and the signer or root certificate last) using a sorting algorithm based on subject - issuer
matching.

When pressing OK, the resulting certificate chain will be validated (using a validation
algorithm based on signature verification and subject - issuer matching), and the importing
operation will continue only if the certificate chain is valid. Otherwise the user will be informed
that the resulting chain is not valid and the Import Key Pair dialog will reappear to allow
modifications.

A screenshot for Import Key Pair action (using a private key and Certificate(s) files) can be
seen below:
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74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity =@ ][=]

File Edit KeyStore Signatures View Tools Window Help

=L W0 B X e BN i
E]Raadme‘txt 8| |7 JK5-KeyStore-sample. jks El 7| JCEKS-KeyStore-Sample. jee m‘ EB@

3/ Change KeyStore Password ¥z View [ Convert KeyStore Type  #-g Generate Key Pair 5+ Generate Secret Key ‘}5 SSL Certificates Retriever ﬂ}. Import Key Pair E Import Certificate

Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
[E] certwith extensions ~ RSA 1024 [ = . Trusted
Import Key Pair @
-[Z] delicous.com RSA 2048 Not Trusted
[E] digicert root ca RSA 2043 Key Pair Type Trusted
% kp-dsaverl DsA 835 () PKCS #12 @ PKCS #8 () OpenssL
g kp-dsaver3 DSA 512
-8 kp-md2rsaverl RSA 2043 Input File(s) Information
-8y kp-md2rsaver3 RSA 2043 Private Key Encrypted:
-mdSrsaver 1 RSA 2043
‘B' b Decryption Password: |esess
-8g kp-mdSrsaver3 RSA 1080
9 kp-shairsaverl RSA 2043 Key Pair File: Browse
8 kp-shalrsaver3 RSA 2048 Private Key File: | \privatekey'\privatekey-encrypt-PBE_SHA1_2DES.pkcs8
&y kp-with-expired-cert RSA 2043
By kp-with-ext DSA 1024 Certificate(s) File: | \CERTivity\doc\samples'certificates\sampleDSAver 1. cer
El uleeds-udn-trust RSA 2043 Certificate(s) File: |2c\samples'certificates\sampleDSAVer 3-PEMencrypt. cer E] Trusted
Certificate(s) File: E]
Add More Certificates. ..
ok [ Cancel ] [ Help

Lower Case Aliases | 14 entries (4 certificates, 10 key pairs, 0 secret keys), 1 selected

5.19 SSL Certificates Retriever

In order to import a trusted certificate, click on SSL Certificates Retriever in the
KeyStore window. For retrieving certificates,in the host/port fields you must specify the server
from which the certificates will be retrieved. If you have a HTTPS URL and you want to retrieve
the certificates then you need to enter the host without any path and the port separately. By
default the HTTPS port is 443.

The server response is available in the "Response information" area. For the retrieved
certificates, the available actions are:

* View detalils;

* Import to KeyStore;

» Export to file.

A screenshot for SSL Certificates Retriever action can be seen below:
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74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/ICEKS-KeyStare-Sample.jce - CERTivity |EHEHE|
File Edit KeyStore Signatures View Tools Window Help
7 B qhi\% : o HER k4 ’7'—-5—‘*@'1’-1” 0125 9ME
[ Readme.bet &[5 IK-KeyStore-sample jks @] (3) JCEKSKeyStore-Sample.jee | =
3/ Change KeyStore Password ¥z View [ Convert KeyStore Type  #-g Generate Key Pair 5+ Generate Secret Key i}a SSL Certificates Retriever ﬂ’. Import Key Pair E Import Certificate
Entry Alias 4 Key Type U S81 Certificates Retriever @ tus Trust Status
[E certwithextensions  RSA 1024 | pequestinformation: Trusted
El delicious.com RSA 2048 Retrieve certificates from: Not Trusted
[E] digicert root ca RSA 2043 (@ URL (HTTPS):  |https:/ffacebook.com Trusted
8 kp-dsaverl DsA 898 (7) Host name: facebook.com Port: |443
g kp-dsaver3 DSA 512
-8y kp-md2rsaver1 RSA 2048 Stop retrieving
-8 kp-md2rsaver3 RSA 2043 P
‘E" kp-mdSrsaver 1 RSA 2048 Response information:
@ kp-mdSrsaver3 RSA 1080 - .
&y kp-sha trsaver RSA 2048 =[] = facebook.com
-8y kp-shalrsaver3 RSA 2048
&y kp-with-expired-cert RSA 2043
By kp-with-ext DSA 1024
gk sk-aes Secretiey
gk sk-arcfour SecretKey
g sk-blowfish Secretkey
gk sk-des Secretkey
gk sk-desede Secretkey
gk sk-hmacmds Secretkey
-5 sk-hmacshal Secretiey
gk sk-hmacsha2se Secretkey
-5 sk-hmacsha3a4 Secretiey
g sk-hmacshas12 Secretkey
gk skrc2 Secretkey
El uleeds-udn-trust RSA 2048 Trusted
(4 certificates, 10 key pairs, 11 secret keys), 0 selected

When importing a selected certificate into the active KeyStore, the certificate trust will be
verified in the same way it is verified when importing a trusted certificate into the active
KeyStore. If a Trust Path can not be established using the provided TrustStores and the
Trust Path validation options (which can be set from Tool s > Options > Trust Path
Opt i ons), a message will be displayed informing about that and asking if the certificate
should be displayed for user verification. If "No" is selected, or the dialog is closed, the import
operation is aborted. If "Yes" is selected, the certificate details will be displayed, and the user
will have the option to continue the import operation (by selecting the "Accept Import" button)
or to abort it (by selecting the "Cancel Import" button).

5.20 Extend Validity
In an opened KeyStore window, select the key pair entry and click on the right mouse button.
From the popup menu select Ext end Val i di ty. A new expiration date must be selected.

This functionality makes sense only for the Key Pairs containing only a self signed certificate.

A screenshot for extend certificate's validity action can be seen below:
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74 C:/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JCEKS-KeyStore-Sample,jce - CERTivity = HEH 2 |
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Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
B cert with extensions RSA 1024 2013-09-03T15: 14:50+0300 2012-10-05T10:35:41+0300 Valid Trusted
El delicious.com RSA 2048 2013-08-25T19:49:30+0300 2013-04-26T15:15:26+0300 valid Not Trusted
B digicert root ca RSA 2043 2014-07-26T21:15:15+0300 2012-10-05T10:35: 18+0300 Valid Trusted
-8y kp-dsaverl DSA 896 2014-10-05T12:13:37+0300 2012-10-05T12:15:21+0300 valid
‘B"' kp-dsaver3 D5A 512 2014-10-06T 10:39:20+0300 2012-10-05T10:56:05+0300 valid
-8y kp-md2rsaverl RSA 2048 2014-10-06T10:43: 1140300 2012-10-05T10:56:31+0300 valid
‘B"' kp-md2rsaver3 RSA 2048 19 Baend Certificate Validity @ S6:53+0300 valid
4y kp-mdSrsaver1 RSA 2043 Current Validity Details: 15: 1440300 Valid
@ kp-mdSrsaver3 RSA 1080 Expiration Date: S7:15+0300 Valid
.y kp-shairsaverl RSA 2043 2012-10-06T12:24: 35+0300 572940300 Valid
-8y kp-shalrsaver3 RSA 2048 Serial Number: 16:57+0300 Expired
& kp-with-expired-cert RSA 2048 100291 2513540300 Expired
g kp-with-ext DSA 1024 07:42+0300 valid
gk sk-aes Secretkey New Validity Details: 25 34+0300
g sk-arcfour Secetkey New Expiration Date: 25:494+0300
g sk-blowfish Secretkey Year: 2014 Month: |02 Day: 08| 20040300
gk sk-des Secretiey 30:25+0300
ik sk-desede Secretiey Mew Serial Number: 30:44+0300
gk sk-hmacmds Seqetiey 5477 30:55+0300
-5 sk-hmacshal Seretiey 310940300
= sk-hmacsha2se Secretkey 51:20+0300
g sk-hmacsha3s4 Secretiey 31:31+0300
ke sk-hmacsha512 Secretkey 31:45+0300
gk skrc2 Secretiey 2012-10-05T10:31:58+0300
B uleeds-udn-trust RSA 2048 2020-05-30713:45:33+0300 2013-04-26T15:15:26+0300 valid Trusted
Extend certificate validity. = Lower Case Aliases | 25 entries (4 certificates, 10 key pairs, 11 secret keys), 1 selected

As it can be seen in the screenshot, the user can also set a new serial number for the new
resulting certificate. The serial number can be generated randomly by using the Gener at e
button, or the user can set a certain serial number by typing it in the text box. The new serial
number has to be a pozitive integer value. Otherwise, a red message will be displayed under
the text box informing that the new serial number is invalid and the operation will not continue.

5.21 Regenerate Key Pair

CERTivity offers the possibility to regenerate a Key Pair, more exactly to generate a new
Key Pair using part of the information from an existing certificate and key information from
a Key Pair.

In order to regenerate a Key Pair, in an opened KeyStore window, select a Key Pair entry
and invoke the contextual menu (usually by performing a right click on the entry). From
the menu that appears, select Regenerat e Key Pair. A dialog similar to the one from
Generate Key Pair action will appear which will have some fields pre-filled with the
information obtained from the certificate of the selected Key Pair. The information which is
taken from the certificate is:

» Key Algorithm (of the public key);
« Key Size (of the public key);

* Certificate Version;

 Certificate Signature Algorithm;

« Certificate Subject/Issuer distinguished name components (Common Name (CN),
Organization Unit (OU), Organization Name (O), Locality Name (L), State Name (ST),
Country (C), Email (E)).
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If some of the information mentioned above is missing, or can not be extracted from the
certificate, the defaults will be used. For example, if the key algorithm type can not be parsed,
the default selection will be RSA, or if the Certificate Signature Algorithm can not be obtained
(oris of an unsupported type), the default value will be used (MD5W t hRSA, for RSA keys, and
SHA1W t hDSA for DSA keys). Also, the fields representing the subject distinguished name
components will be filled only if these components are present in the certificate and contain
a non empty value.

The Serial Number field will not be pre-filled with the value from the certificate from the
selected Key Pair, because each certificate must have a unique serial number. Thus, this
has to be provided (or generated using the Gener at e button) by the user.

Also, the new certificate will be valid for the period mentioned in the Validity Period field
(which by default is 1 year) and the validity period will start from the moment of generation,
regardless of the validity of the initial certificate from which the information is obtained.

The Regenerate Key Pair dialog, allows adding extensions to the certificate as well, but these
are not pre-filled with the ones from the initial certificate.

A new alias name for the new Key Pair that will be generated is required. The new Key Pair
will not replace the initial one in the KeyStore.

After filling all the required information, press OK. You will be prompted to enter a password
for the new Key pair, and the Key Pair will be generated.

5.22 Generate CSR File

In order to generate a Certificate Signing Request file for a Key Pair entry, in an opened
KeyStore window, select that Key Pair entry and invoke the contextual menu (usually by
clicking the right mouse button). In this contextual menu select Generat e CSR Fi | e. For
generating a CSR file, you have to specify:

< the name of the generated file;

e the algorithm to use for signing the request; this is automatically
adjusted based on the key algorithm wused in the Key Pair. For
DSA keys the possible selections are: SHAL1w thDSA, SHA1W t hDSA,
SHA224W t hDSA, SHA256W t hDSA, SHA384W t hDSA and SHA512W t hDSA,
while for RSA keys the possible selections are: MD2W t hRSA,
MD5W t hRSA, SHAIW t hRSA, SHA1IW t hRSAandMGF1, SHA224W t hRSA,

SHA224W t hRSAandMGF1, SHA256W t hRSA, SHA256W t hRSAandMGF1,
SHA384W t hRSA, SHA384W t hRSAandMGF1, SHAS512W t hRSA,
SHA512W t hRSAandMGF1, Rl PEVMD128W THRSA, RI PEMD160W THRSA

andRlI PEMD256W THRSA.

« the challenge - the challenge-password attribute, which specifies a password by which
the entity may later request certificate revocation.

The supported CSR formats are PKCS #10 and SPKAC (Signed Public Key and Challenge).
These are selectable from the file chooser filter list.

5.23 Import CA Reply

In an opened KeyStore window, select a key pair entry and invoke the contextual menu
(usually by clicking the right mouse button). In this menu select | nport CA Reply . The
CA Reply can be chosen from a file chooser.
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Importing the CA Reply will replace your self-signed certificate with a certificate chain. This
chain will be either the one returned by the CA in response to your request (if the CA reply is
a chain) or one constructed (if the CA reply is a single certificate) by establishing a Trust Path
using the CA Reply certificate and the trusted certificates available in the given TrustStores
(which can be setfrom Tool s > Opti ons > Trust Pat h Opti ons).Itcanalsobeasingle
certificate which is signed by a signing authority, if the Trust Path could not be established
but the user accepts the import.

The process of importing a CA Reply is more detailed and implies a series of validations
and steps for establishing trust or constructing the chain from the CA Reply if it is a single
certificate. There are two types of validations performed: one type which is critical and stops
the validation process if it fails (if the CA Reply contains a chain and the chain is not valid, or
other errors occur durring the validation and import process), and one type which will inform
the user that the CA Reply chain is not trusted or that a Trust Path could not be established for
the given CA Reply (if it is a single certificate) and lets the user choose if the import process
should continue or not by displaying the details of the top certificate of the CA Reply.

The chain of certificates representing the received CA Reply is considered to be valid if the
signature of each certificate is verified by the public key of the certificate on the next higher
level in the chain. Also, for the import process to be able to be performed, it is necessary
that the chain of the CA Reply to correspond to the entry for which the import is being made.
This means that the public key of the first certificate in the chain to be equal to the public key
of the self-signed certificate which it should replace in the Key Pair selected for performing
the import.

A CA Reply (either containing a certificate chain or a single certificate) has to be trusted. The
received chain is considered to be trusted if the top certificate is trusted, which means, to be
present in the TrustStores set by the user. Also, a CA Reply containing a single certificate is
considered to be trusted if a Trust Path can be established for it using the trusted certificates
in the TrustStores set by the user.

A screenshot for importing a CA Reply is depicted below:
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Key Pair Details ;

Private Key Certifiy | 3

@ Teq My Documents

Form [/

A
%.50 Computer In Unit, CN=SampleD5AL
Serial =

.

Network )
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2012
LoCanty Name (LT
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The steps and validations for importing a CA Reply and the order in which they are performed
in CERTivity® are as following:

« First, if the CA Reply contains a chain, the chain is verified to not contain any loops.
If any loop is detected you will be informed by a warning message that the CA Reply
contains a loop and you will be asked to decide if the import operation should continue
or not. If this loop is not a mutual trust loop, we advise you not to import the CA Reply;

* Then, the CA Reply is verified to belong to the entry for which it should be imported. This
means that the public key of the first certificate from the chain is tested to be equal to the
public key of the certificate from the Key Pair for which the import attempt is performed.
If the CA Reply does not belong to this entry, the import process will stop and you will
be informed by an error message that the CA Reply does not belong to that entry.

The error message will contain the information "The public key of the CA Reply
does not match the public key of the key pair entry" asitcan be
seen in the screenshot below:
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1 Warning @

The public key of the CA Reply does not match the public key of the key pair entry.

« If the CA Reply contains only a single certificate, a valid trusted certificate chain (a
Trust Path) is attempted to be established using the certificates present in the available
TrustStores (set from Tools > Options > Trust Path Options). If this is not
possible, the certificate from the CA Reply will be displayed and you will be prompted to
take a decision if the CA Reply should be trusted and imported as it is or not;

« If the CA Reply contains a chain of certificates, the chain is sorted to have the root
certificate last and the user certificate first (if this is not already sorted in this way); The
chain is then verified for validity which means that for each certificate is checked that
its signature is verified by the public key of the certificate at the next higher level in the
chain and that its issuer is equal to the subject of the higher level certificate; if the chain
is not valid, the import process will stop and you will be informed by an error message
that the CA Reply does not contain a valid certificate chain;

If the chain is valid, then the top certificate of the chain is verified if it is trusted by
searching it in the the available TrustStores (set from Tool s > Qptions > Trust
Pat h Opti ons). Ifitis, then the CA Reply is imported. Else, the top certificate of the
chain will be displayed and you will be prompted to take a decision if the CA Reply should
be trusted and imported or not;

For example, if the top certificate of a CA Reply is not found within any of the available
TrustStores, the following message will be displayed:

1 Warning @

! ] Could not establish trust for the top certificate, Do you want to view the certificate and decide if
the operation should continue or not?

)

If "No" is selected or the dialog is closed, the import operation will be aborted.

If "Yes" is selected, the certificate will be displayed in a dialog with the options "Accept
Import" to continue the import, or "Cancel Import" to abort the operation which can be
seen in Certificate Trust Established by User.

A CA Reply file can be obtained by sending a CSR (Certificate Signing Request) to a
Certificate Authority, which will sign it and send back a CA Reply file (usually a file of the type
PKCS#7 CA Reply File, having the extension .p7r). Creating a CSR file can be done using
CERTivity® as it is described in the section Generate CSR File.
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The CA Reply can also be obtained using CERTivity® to sign the CSR file, by performing
the following steps:

« Select a Key Pair entry, and generate a CSR file (as described in the section Generate
CSR file). A CSR file will be obtained;

* Sign the CSR file obtained at the previous step. The process for signing CSR files is
explained in the section Signing CSR Files. The resulting file will be the actual CA Reply
file which can then be imported for the Key Pair for which the CSR file was generated;

« Import the CA Reply for the corresponding Key Pair entry.
5.24 Select CA Issuer

In an opened KeyStore window, select a key pair entry and invoke the contextual menu
(usually by clicking the right mouse button). From this menu use Sel ect CA |ssuer. If
the key pair is not unlocked, you will be prompted to enter the password for the private key
associated to the key pair entry. If another key pair found in any of the opened key stores
was previously selected as the CA Issuer, that selection will be lost, being replaced with the
current one.

When a key pair is selected as the CA Issuer, in the contextual menu the Sel ect CA | ssuer
option will be checked. Also, the Status Bar will display information regarding this selection in
the following format: CA | ssuer: keystore nane / alias for selected issuer.

5.25 Sign Certificate by <aliasForlssuer>

In an opened KeyStore window, select a key pair entry and invoke the contextual menu
(usually by clicking the right mouse button). The following situations can occur:

« If the contextual menu will display an active Sign Certificate by
<al i asFor | ssuer > option, this means that a CA Issuer was previously selected and
you can proceed with the signing operation by selecting the option.

« If the contextual menu will display an inactive Si gn Certificate by <...>option,
this usually means that no CA Issuer was previously selected. In order to use this option
you must first select a CA Issuer, using the Sel ect CA | ssuer option.

e If the contextual menu will display an inactive Sign Certificate by
<al i asFor | ssuer > option, this could also mean that you accessed the contextual
menu for the same key pair that was previously selected as CA Issuer. This is a
precaution measure to make sure the user will not attempt to sign a generated CSR with
the same key pair that generated it.

The Sign Certificate by <aliasForlssuer> option is automatically replicating in
one step the effect of the following individual actions:

« Generate a CSR for a selected key pair;

« Sign the previously generated CSR using another key pair and obtain a CA Reply;

< Import the obtained CA Reply in the initial key pair used to generate the CSR.

The workflow of the Si gn Certificate by <aliasForl ssuer> action is the following:

e After you selectthe Sign Certificate by <aliasForl ssuer> option, you will be
prompted to enter the password for the private key associated to the selected key pair
entry if need be. If the password entered is correct you may proceed to the next step.
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« After the key pair selected was unlocked, the certificate details from the CSR will be
shown in a newly opened dialog requiring to provide a Serial Number and double
checking the validity period. Additionally, when signing the CSR, certificate extensions
can be added to the certificate.

» After the second step was completed and the OK button was pressed, a temporary,
internal CA Reply will be created and transparently imported in the selected key pair, thus
the target Key Pair will now contain a signed user Certificate and the issuer Certificate
as part of the Certificate Chain.

5.26 Export Key Pair

In an opened KeyStore window, select the key pair entry and click on the right mouse button.
From the popup menu select Export > Export Key Pair action. The Key Pair will
be exported in the selected file. The Key Pair can be exported in PKCS #12 KeyStore
Files format. Also, a PKCS #12 password is required. While exporting a Key Pair, an error
might occur if the password length is too long - this has to do with the out of the box Java
Cryptography Extension (JCE) limited Strength Jurisdiction Policy Files.

A screenshot for the export Key Pair action is depicted below:

74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity = [ @] =]
File Edit KeyStore Signatures View Tools Window Help
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Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status

+E| cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T11:00:50+0300 Valid L
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e ** Export Key Pair To File (55|

& El digicert roo
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-y kp-dsavers (5} exportedKeyPairsample 1.pfi

L dZren = PKCS #12 Password

g kp-mi o b 5} exportedKeyPairsample2.p12

-4 kpmdarsay | Recent Items Password:  eeses

-y kp-mdSrsa

+n|¥ kp-mdsrsan ! Retype Password: seess

+ “y kp-shalrsa Desktop

+"Er' kp-sha Irsay S

! ; My Documents

S kp-aith-ext - Files of type:  [piCs #12 KeyStore Files (*pfi; *.p12) = Cancel
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B
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5.27 Export Certificate Chain

In an opened KeyStore window, select the key pair entry and click on the right mouse button.
From the popup menu select Export > Export Certificate Chain action. The
Certificate Chain will be exported in the selected file, having the following formats:

*« PKCS #7 Certificate Files;
« PKCS #7 Certificate Files (PEM encrypted);
* PKI Path Certificate Files.

5.28 Export Certificate

In an opened KeyStore window, select the certificate entry and click on the right mouse
button. From the popup menu select Export > Export Certifi cate. The certificate
will be exported in the selected file. The certificate can be exported in the following formats:
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X.509 Certificate Files;

X.509 Certificate Files (PEM encrypted);
PKCS #7 Certificate Files;

PKCS #7 Certificate Files (PEM encrypted);
PKI Path Certificate Files.

Note that certificates can also be exported from signed files or from a SSL source.
5.29 Export Public Key

In an opened KeyStore window, select the certificate entry and click on the right mouse
button. From the popup menu select Export > Export Public Key action. The Public
Key will be exported in the selected file. The Public key can be exported in the following
formats:

e OpenSSL;
¢ OpenSSL (PEM encrypted).

5.30 Export Private Key

In an opened KeyStore window, select the key pair entry and click on the right mouse button
- if the private key is not unlocked you will be prompted for the private key password. From
the popup menu select Export > Export Private Key action. The exported Private
Key type can be PKCS #8 (both binary and PEM) or OpenSSL - this is selectable from the
right side of the file chooser window. The exported key can also be encrypted (in this case
an encryption algorithm and a password must be provided) or not. For PKCS #8 one can
further chose to PEM encode the file, by using the File Chooser filter (Files of type: PKCS
#8 Private Key Files (PEM encoded) (*.pkcs8).

The Private Key will be exported in the selected file, having the following formats, depending
on the export Private Key Type and file chooser filter selection:

* PKCS #8 Private Key Files;
* PKCS #8 Private Key Files (PEM encoded);
e OpenSSL Private Key Files (PEM encoded).

The encryption algorithm is dependent on the selected export Private Key Type and
CERTIvity automatically changes this in the list.

Table 5.3. Encryption Algorithm for Private Keys

Type Encryption Algorithm
PBE_SHA1 2DES
PBE_SHA1 _3DES
PBE_SHA1 RC2_128

PKCS #8
PBE_SHA1_RC2_40
PBE_SHA1_RC4 128
PBE_SHA1_RC4_40
OpenSSL AES-128-CBC
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Type

Encryption Algorithm

AES-128-CFB

AES-128-ECB

AES-128-OFB

BF-CBC

BF-CFB

BF-ECB

BF-OFB

DES-CBC

DES-CFB

DES-ECB

DES-EDE-CBC

DES-EDE-CFB

DES-EDE-ECB

DES-EDE-OFB

DES-EDE

DES-EDE3-CBC

DES-EDE3-CFB

DES-EDE3-ECB

DES-EDE3-OFB

DES-EDE3

DES-OFB

RC2-40-CBC

RC2-64-CBC

RC2-CBC

RC2-CFB

RC2-ECB

RC2-OFB

A screenshot for the export Private Key action is depicted below:
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5.31 Rename a KeyStore Entry

You can rename an entry contained in a KeyStore. There are more ways to do the renaming
action:

e using Edit Menu > Renane ;
 using the context menu (by clicking the right mouse button and then on Renane);
« using the Rename toolbar icon;

< use the keyboard shortcut, by default the F2 key (exactly as the Windows Explorer
renaming shortcut) or the CTRL+R combination.

Note that the alias will not be changed if the alias already exists in the KeyStore. An error
message will notify the user in this cases, so the user can give another alias.

5.32 Delete KeyStore Entry
You can delete an entry (either certificate, key pair or secret key) contained in a KeyStore.
There are more ways to do the deleting action:
e using Edit Menu > Del ete ;
« using the context menu (by clicking the right mouse button and then on Del et e);
using the Delete toolbar icon;

« use the keyboard shortcut, by default Del et e key.

Note that a "Confirm Entry Delete" window will be displayed first, so the user has the
possibility to change his mind regarding the delete action. In case of the native Windows
Root KeyStore the OS will prompt for a native confirmation dialog as well.

5.33 Copy KeyStore Entry

You can copy KeyStore entries (Certificates, Key Pairs and Secret Keys) as well as
certificates part of a Key Pair's Certificate Chain into the clipboard. There are more ways to
do the copying action:
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using Edit Menu > Copy ;
using the context menu (by clicking the right mouse button and then on Copy);
using the Copy toolbar icon;

use the keyboard shortcut, by default CTRL+C key.

5.34 Cut KeyStore Entry

You can remove the currently selected entry from a KeyStore and place it in the clipboard.
There are more ways to do the cut action:

using Edit Menu > Cut;
using the context menu (by clicking the right mouse button and then on Cut );
using the Cut toolbar icon;

use the keyboard shortcut, by default CTRL+X key.

5.35 Paste KeyStore Entry

You can insert the KeySstore entry (including a Certificate part of a Certificate Chain) from
the clipboard in another KeyStore or even in the same KeyStore (an overwrite/rename
confirmation dialog is invoked in this case). The paste action is active when, in the target
KeyStore, the selection is not on a sub-entry, but on a main entry or there is nothing selected.
There are more ways to trigger the paste action:

using Edit Menu > Past e;
using the context menu (by clicking the right mouse button and then on Past e);
using the Paste toolbar icon;

use the keyboard shortcut, by default CTRL+V key.

In case the alias already exists in the KeyStore, the user has to choose between the following
actions:

Overwrite - in case of pasting a single entry and overwriting the existing entry;
Overwrite all- in case of pasting more entries and overwriting the existing entries;
Rename - in case of pasting a single entry;

Rename all- in case of pasting more entries;

Skip - in case of skipping the paste for a single entry;

Skip all - in case of skipping the paste of all entries.
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6. CERTivity®'s Signatures

6.1 Verify

Using CERTIvity, you can verify signatures for:
* JAR files;
o XML files;
* PDF files.

using Menu Si gnature > Verify command.

Note

You can use the examples provided in the distribution kit in doc/ sanpl es folder,
to test verify and sign features.

6.1.1 Verify JAR Signatures

When verifying a JAR signature, a KeyStore entry can be selected for verifying the entry
certificates. In case there is no KeyStore selected, you can continue verification of the JAR
signature without checking the existence of the certificates from the JAR entries in the
KeyStore. An error will be displayed if KeyStore file could not be loaded or if the KeyStore
password is wrong or the file is corrupt. A successful JAR file verification occurs if the
signature(s) are valid, and none of the files that were in the JAR file when the signatures were
generated have been changed since then. After the JAR signature verification operation, the
messages that will be displayed are:

« "The JAR file was verified."in case of successful JAR signature verification;

« "The JAR file was not verified."incase the JAR file has not a valid signature.

The embedded certificate(s) can be viewed, exported into an external file or directly imported
into the active KeyStore.

7% C/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample jks - CERTivity (===
File Edit KeyStore Signatures View Tools Window Help
F =] = 5 0 ¥ B . it
TG DE WS EEX e B Sy Eall
2| KSKeyStoresample.jks 5 B@
4/ Change KeyStore Password {5 View [ Convert KeyStore Type .-y Generate Key Pair  5-# Generate Secret Key '{)'i S5L Certificates Retriever 37. Import Key Pair E Import Certificate
Entry Al Key Ty Validity Status Trust Statu:
niry Allas 4 ¥ Tvpe " Verification Results @ sty s s s
(5] certwith extensions RSA 1024 Verification Status: valid Trusted
[E] delicious.com RSA 2043 Signature is vaiid. valid Mot Trusted
El digicert root ca RSA 2048 Verification Detgails: Valid Trusted
-8y kp-dsaverl DSA 836 Valid
-8y kp-dsaver3 DSA 512 Valid
-8-g kp-md2rsaverl RSA 2043 Valid
4y kp-md2rsaver3 RSA 2043 Valid
- kp-mdsrsaverl RSA 2048 valid
&, kpmdsrsaver3 RSA 1080 Embedded Certificates details: Vaiid
SampleMD2RSAVer1 {SampleMD2RSAVer 1)
-8y kp-shalrsaverl RSA 2048 valid
g kp-shalrsaver3 RSA 2048 Expired
-8y kp-with-expired-cert RSA 2048 Expired
g kp-with-ext DSA 1024 Valid
[E] uleeds-udn-trust RSA 2048 Valid Trusted
View Certificate ] [ Export Certificate ] [ Import To KeyStore ]
Lower Case Aliases
.. ®, .
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Note

You can use JAR examples provided in the distribution kit in doc/ sanpl es/j ar
folder, to test the verify JAR features.

When importing a selected embedded certificate into the active KeyStore, the certificate trust
will be verified in the same way it is verified when importing a trusted certificate into the active
KeyStore. If a Trust Path can not be established using the provided TrustStores and the
Trust Path validation options (which can be set from Tool s > Options > Trust Path
Opt i ons), a message will be displayed informing about that and asking if the certificate
should be displayed for user verification. If "No" is selected, or the dialog is closed, the import
operation is aborted. If "Yes" is selected, the certificate details will be displayed, and the user
will have the option to continue the import operation (by selecting the "Accept Import" button)
or to abort it (by selecting the "Cancel Import" button).

6.1.2 Verify XML Signatures

XML signatures can be used as authentication credentials or as a way to check data
integrity. XML signatures can be applied to XML file, HTML pages, gif files, XML-encoded
data. When validating an XML signature, an XML file must be chosen first. If there is no
certificate embedded, the certificate identified by the current selected entry is used to validate
the XML signature.

After the XML signature verification process, the messages that will be displayed are:
e "Fil e not signed."in case the XML file was not signed;
e "Signature is invalid."incase the XML file signature is not valid,;

e "Signature is valid."in case the XML file signature is valid. The trusted state of
the embedded certificate is not checked.

If the certificates are embedded these will be shown under the "Certifi cates detail s"
panel and details can be viewed or Certificates exported or directly imported into the active

KeyStore.
7% C/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample jks - CERTivity (===
File Edit KeyStore Signatures View Tools Window Help
=] = d ¥ B vil
ql:ﬂ% * aILiIX " L'HEL‘ ] it
JKS-KeyStore-sample.jks 32 ENEE
7 Change KeyStore Password (5] View [ Convert KeyStore Type -y Generate Key Pair  5-# Generate Secret Key W) 551 Certificates Retriever ﬁ’. Import Key Pair E Import Certificate
Entry Alias 4 Key Type N — == Validity Status Trust Status
+E| cert with extensions RSA 1024 Verification Status: Valid Trusted
* [ delicious.com RSA 2043 Signature is valid. Validation done with embedded certificate] valid Mot Trusted
+E| digicert root ca RSA 2048 Verification Details: valid Trusted
)-8y kp-deaverl DSA 836 valid
-8y kp-dsaver3 DSA 512 Vaid
+]-&g kp-md2rsaverl RSA 2048 Valid
i Ay kp-mdarsaver3 RSA 2043 Valid
-8 kp-mdSrsaver1 RSA 2048 = 5 e valid
: E Certificate: tails:
T8y kp-mdSrsaver3 RSA 1080 moeaed Certneates aetals Valid
P SampleMD 2R5AVer 1 {SampleMD2RSAVer 1)
-8y kp-shalrsaverl RSA 2048 valid
+"Eﬂ kp-sha Irsaver3 RSA 2043 Expired
-y kp-with-expired-cert ~ RSA 2048 Expired
g kp-with-ext DSA 1024 valid
71 [3] uleeds-udn-trust RSA 2048 Vaiid Trusted
I View Certificate I { Export Certificate I { Import To KeyStore I
Close Help
Lower Case Aliases
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Note

You can use XML examples provided in the distribution kit in doc/ sanpl es/ xni
folder, to test the verify XML features.

When importing a selected embedded certificate into the active KeyStore, the certificate trust
will be verified in the same way it is verified when importing a trusted certificate into the active
KeyStore. If a Trust Path can not be established using the provided TrustStores and the
Trust Path validation options (which can be set from Tool s > Options > Trust Path
Opt i ons), a message will be displayed informing about that and asking if the certificate
should be displayed for user verification. If "No" is selected, or the dialog is closed, the import
operation is aborted. If "Yes" is selected, the certificate details will be displayed, and the user
will have the option to continue the import operation (by selecting the "Accept Import" button)
or to abort it (by selecting the "Cancel Import" button).

6.1.3 Verify PDF Signatures

The Portable Document Format (PDF) allows to digitally sign a document by inserting
a cryptographic signature value in the file. A signature is in most cases represented by
a signature field containing the name and other attributes of the signer. When verifying
a PDF signature, a PDF file must be chosen first. The digital signatures CERTivity
understands for PDF verification are the public/private-key encrypted document digest
with the standard SubFilter values adbe. x509. r sa_shal, adbe. pkcs7. det ached, and
adbe. pkcs7. shal. The exact specified handler (the Fi |l ter value) is ignored when
verifying the signature according to the PDF Reference “An application may substitute a
different handler when verifying the signature, as long as it supports the specified SubFilter
format.”

After verifying the PDF signature, a dialog called "Veri fi cati on Resul ts"is presented
for the Document containing the global document status and details for each Signature found.
The global Verification Status can be one of:

* "File not signed."in case the PDF file was not signed;

« "At |least one known signature is invalid."in case atleast one of the
supported (known) PDF file signature is not valid,;

« "Al'l known si gnatures are valid. "incase all of the supported (known) PDF file
signatures are valid according to the sub-filter values and algorithm (including the digest
being recomputed and compared with the one stored in the signature). The trusted state
of the embedded certificates is not checked.

¢ "Unknown. " in case the document is containing only unsupported SubFilters.

For each signature recognized in the document, you can see the signer details, such as
name, location, reason, date, certificate, signature verification status and verification info. The
embedded certificate of each signature can be viewed and even exported into an external file.

A Verbose text report can be analysed (Show Det ai | s) revealing the reason why, for
example, some signatures are not valid, or revealing the value of the SubFilter/Filter. This is
especially useful to observe the details for invalid cases as many information is logged. For
example, according to the adbe. pkcs7. shal SubFilter the signature process involves two
digests - the SHAL digest of the byte range which is encapsulated in the PKCS#7 signed-
data field with Contentinfo of type Data, and then this signed-data field is digested and signed
according to the PKCS#7 standard. So there are two digest verified, and if one of these fails
the validation fails, and this could be visible by inspecting the Details section, for example:
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The cal cul ated SHA1 Message Digest coincides with the encapsul ated
PKCS#7 signed-data field. Continuing the signature verification
procedure. Digest Msmatch [nmessage-di gest attribute val ue does not
mat ch cal cul at ed val ue].

Although a signature may not be valid, the option View Certificate > Export
Certificate > Inport to KeyStore can be available in many situations (usually if
preliminary validation passes) as long as the certificate is embedded according to the PDF
standards. For example, in the case above where the second message-digest mismatch the
embedded certificate can still be viewed/exported/imported to KeyStore.

7} C:/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample,jks - CERTivity (===

File Edit KeyStore Signatures View Tools Window Help

15 G B i EiEXih BB HGIT25:9MEY
7| JKSHeyStore-sample.jks 52 EE‘@

3/ Change KeyStore Password {3 View / Convert KeyStore Type -y Generate Key Pair -+ Generate Secret Key -&7 S50 Certificates Retriever 37. Import Key Pair @ Import Certificate

Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
B cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T11:00:50+0300 valid Trusted
[E] delicious.com RSA 2048 4 o itication Resulte e |V Not Trusted
El digicert root ca RSA 2043 Valid Trusted
&, -d 1 DSA 896 Gocument: Jalid
Vali
v kp-dsaver Document Name: |SignedPDFwithADBE_X509_RSA_SHAL.pdf
-8y kp-dsaver3 DsA 512 Valid
&, kpmdarsavert RSA 2048 Verification Status: |All known signatures are valid. Vaiid
-8y kp-md2rsaver3 RSA 2048 Verification Info: | The document contains a single known signature which is valid. valid
@ kp-mdSrsaverl RSA 2048 valid
Signatures: Y
-8y kp-mdSrsaver3 RSA 1080[ .| | valid
SampleMD2RSAVer1 (SampleMD2RSAVer 1]
-8 kp-shalrsaverl RSA 2048 pi ol ) = valid
&y kp-shalrsaver3 RSA 2043] Name: |EduLib Expired
g kp-uith-expired-cert RSA 2043 Location: |Romania Expired
Ry kp-with-ext DSA 1024 : = Vaiid
El deeds-udn-trust RSA 2048] Reason: |Test signing POF with ADBE_X509_RSA_SHA1 vaiid Trusted

Date: |2012-10-05T16:24:49+0300
Certificate: | SampleMD2RSAVer1 (SampleMD2RSAVer 1)
Verification Status: |Signature is valid.

Verification Info:

View Certificate ] [ Export Certificate ] [ Import To KeyStore

Details:

Verifying the Signature for the document: C:\Program Files (x86)\EduLib\CERTiv «
Document is not encrypted. =
Document version: 1.4 =
Signature dictionary found.

Name=CO0S5tring {EduLib}

Modified=COSString{D:20121005162449+0300%

Signature Name: Edulib
Tha | amath nf Ginmad Cantant i 7454077

< m 3

Lower Case Aliases

Note

You can use PDF examples provided in the distribution kit in doc/ sanpl es/ pdf
folder, to test the verify PDF features.

Note

Verifying the signature of a PDF which is encrypted is not supported.

When importing a selected embedded certificate into the active KeyStore, the certificate trust
will be verified in the same way it is verified when importing a trusted certificate into the active
KeyStore. If a Trust Path can not be established using the provided TrustStores and the
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Trust Path validation options (which can be set from Tool s > Options > Trust Path
Opt i ons), a message will be displayed informing about that and asking if the certificate
should be displayed for user verification. If "No" is selected, or the dialog is closed, the import
operation is aborted. If "Yes" is selected, the certificate details will be displayed, and the user
will have the option to continue the import operation (by selecting the "Accept Import" button)
or to abort it (by selecting the "Cancel Import" button).

6.2 Sign
6.2.1 Signing JAR Files

In order to sign a JAR file, make the following steps:
« select a Key Pair from the KeyStore tree table;

« either choose the main menu Si gnatures > Sign > JAR fil e or the contextual
menu Si gn > Jar file;

« unlock the Key Pair if requested by providing its password;
« select the JAR file that will be signed;
« complete the signature information:
1. signature file name;
2. digest algorithm:
* MD2 (reference can be found in RFC 1319);
» MDS5 (reference can be found in RFC 1321);
« SHAl(reference can be found in FIPS 180--3);
3. signature algorithm - SHA1 with DSA;
4.checkthe "Add ful |l nanifest digest attribute"optionin case youwant

this attribute to be added at the signature;

The signed JAR file can be overwritten or can be saved in an other location, according to the
options selected in the "Fi | e Savi ng Opti ons" area.
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74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity =@ ][=]

File Edit KeyStore Signatures View Tools Window Help

12 5 B i EEdEX R BISHIE S

3| JKS-KeyStore-sample.jks 5 E] B @
3/ Change KeyStore Password ¥z View [ Convert KeyStore Type  #-g Generate Key Pair 5+ Generate Secret Key 1}5 SSL Certificates Retriever ﬂ}. Import Key Pair E Import Certificate
Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
B cert with extensions RSA 1024 2013-09-03T15: 1 50+0300 2012-10-05T11:00:50+0300 Valid Trusted
(2] 4=l 73 Choose File To Sign == -
digi r .
E ko Lookin: | || jar - &% B
g kp Signature Information:
ey kp ':_‘} ] signed_MD2_RSA.jar Signature File Name: |kp-md2rsaver1
8o ko Recentltems |\ Sined_MDS_RSAjar Signature Algorithm: |MD2 With RSA v
i signed_SHA1_RSA.jar = =
R Digest Algorithm: |MD2 -
g kp|
oy ko ! Add full manifest digest attribute
Desktop
8w kp- File Saving Options:
= @ Overwrite current fil
-8y kp- o .
F () Save to anew file Lo iE
El ule My Documents
Computer
&
Network File name: ro-edulib-cm-core. jar Sign JAR file
Files of type: :Jm Files (=.jar) - Cancel
Lower Case Aliases

Note

You can use JAR examples provided in the distribution kit in doc/ sanpl es/ | ar
folder, to test the sign JAR features.

6.2.2 Signing XML Files

In order to sign an XML file, make the following steps:
« select a Key Pair from the KeyStore tree table;

« either choose the main menu Si gnatures > Sign > XM fil e or the contextual
menu Sign > XM file;

< unlock the Key Pair if requested by providing its password;
« select the XML file that will be sign;
< complete the signature options:

1. signature type:

« enveloped - the signature applied over the XML content that contains the
signature as an element.

« enveloping - the signature applied over the content found within an Object
element of the signature itself.

» detached - the signature applied over the content external to the Signature
element, and it can be identified by way of a URI or a transform.

2. digest algorithm:
* SHAZ,;
» SHA256;
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* SHA512;

3.check "Attach key information to signature" and "Attach
certificate informati on to signature"incase youwant to attach those
information to the signature.

The signed XML file can be overwritten or can be saved in an other location, according to
the options selected in the "Fi | e Savi ng Options" area.

7% C/Program Files (x86)/Edulib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample jks - CERTivity (===
File Edit KeyStore Signatures View Tools Window Help
- =] = 5 0 B
? 5 8% ot g X e BN Y
7| JKSHeyStore-sample.jks 52 E‘@
3/ Change KeyStore Password {3 View / Convert KeyStore Type -y Generate Key Pair -+ Generate Secret Key -&7 S50 Certificates Retriever 37. Import Key Pair @ Import Certificate
Entry Alias & Key Type Expire Date Last Modified Validity Status Trust Status
B cert with extensions RSA 1024 2013-09-03T15:14:50+0300 2012-10-05T11:00:50+0300 Valid Trusted
(3] delig 3 sign XML File ==
El digi r
Lok in: . xml - o E2-
Ay kpd
-8y kp-d || Signed_Detached_SHA 1_Fxclusive.xml Signature Options:
E
By kp-n i || Signed_Detached_SHA 1_Indusive.xml Signature Type: _Enveloped -
g kper] Recent Ttems || Signed_Enveloped_SHA1_Exclusive.xml Digest Algorithm: SHAL -
" Signed_Enveloped_SHA1_Indusive,xml .
g kp-l =
ke Signed_Enveloping_SHA1_Exclusive,xml Canonicalization Algorithm: | Indusive -
= = a _SHALE
o ko] ! Signed_Enveloping_SHA1_Indusive.xm| Enveloping Object ID:
.y kpg Tz Attach Key To Signature:
i ke = Attach Certificate To Signature:
oy kpo E
5] sl My Documents File Saving Options:
(@ Overwrite current file
L™ () Save toa new file Browse
= =
Computer
@
Network.
File name: Unsigned.xml
Files of type: | XML Files (*.xml) -
Tower Case Aliases

You can use XML examples provided in the distribution kit in doc/ sanpl es/ xm
folder, to test the sign XML features.

An example of using the XML signature is for signing PAD files. PAD is the Portable
Application Description file in which an author provides product descriptions and
specifications for online sources in a standard way. PAD signing provides a mechanism by
which PAD file consumers can ensure that PAD files are authentic.

The steps for signing a PAD file using CERTivity are:
e create an XML PAD file according to the standards;

« create a new PKCS12 keystore;

< generate a key pair for which the organization name of the certificate to match exactly
with the company name or the first and last name defined in your PAD file. Add Extended
Key Usage extension (Code Signing) and Key usage extension (Digital Signature) to
the certificate;

« sign your XML PAD file using this keystore.
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6.2.3 Signing PDF Files

CERTivity can digitally sign by public/private-key encrypted byte range digest a
PDF document, supporting the standard SubFilter values adbe. x509.rsa_shal,
adbe. pkcs7. det ached, and adbe. pkcs7. shal. The signature supported by CERTivity
is of document (or ordinary) type (according to the PDF Reference, version 1.7) and without
a visual representation. The name of the signature handler (Fi | t er) is Adobe. PPKLi t e.
Multiple signatures can be applied incrementally. The signature process is currently not
conditioned by the existence of other signature types or by any post-signing changes
(Doc NDP).

In order to sign a PDF file, make the following steps:

« select a Key Pair from the KeyStore tree table;

« either choose the main menu Si gnatures > Sign > PDF fil e or the contextual
menu Si gn > PDF fil e;

« unlock the Key Pair if requested by providing its password;
 select the PDF file that will be signed;
« complete the signature information:

1. Signer Name;

2. Signer Location;

3. Signer Reason;

4. select signature SubFilter - standard value that represents the encoding to use
when signing the PDF file:

e adbe.pkcs7.shal - The adbe.pkcs7.shal digest of the byte range is
encapsulated in the PKCS#7-signed data field;

» adbe.pkcs7.detached - No data is encapsulated in the PKCS#7-signed data
field;

« adbe.x509.rsa_shal - The adbe.x509.rsa.shal digest uses the RSA encryption
algorithm and SHA-1 digest method. This SubFilter is available only for RSA
Key Pairs.

The signed PDF file can be overwritten or can be saved in another location, according to the
options selected in the "Fi | e Savi ng Opti ons" area.
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74 C:/Program Files (x86)/Edul ib/CERTivity/doc/samples/keystore/JKS-KeyStore-sample.jks - CERTivity e [ =] =]
File Edit KeyStore Signatures View Tools Window Help
5 =] = ﬂIEl 5 0 E & B
7 8 S "% Oy X o= FHS7 e
3| JKS-KeyStore-sample.jks 5 EB@
3/ Change KeyStore Password ¥z View [ Convert KeyStore Type  #-g Generate Key Pair 5+ Generate Secret Key 1}5 SSL Certificates Retriever ﬂ}. Import Key Pair E Import Certificate
Entry Alias 4 Key Type Expire Date Last Modified Validity Status Trust Status
El cert with extensions RSA 1024 2013-09-03T15: 14:50+0500 2012-10-05T11:00:50+0300 Valid Trusted
(3] deicousc| 3 Choose File To Sign ==
[E] dgicert ro : T
Look in: f ‘B
g kp-dsaver ookin pd i EF
-8y kp-dsaver ] SignedPDFuwith ADBE_PKCS7_DETACHED.pdf Signature Information
L
-8y kp-md2rsg ";B" @ SignedPDFwithADBE_PKCS7_SHA1.pdf Signer Mame: | EduLib
o SignedPDFwithADBE _X 509_RSA_SHA1.pdf
“g kpmd2rsa Recent Items = g. T T F Signer Location: |Romania
8y kp-mdsrsa ] UnsignedrDF. pdf
‘B‘ kp-mdsrsq Signer Reason: | Testing
.y kpshalrs: !
-8y kp-shalrs: Desktop Signature Subfilter: Iadba.pk:s?.shal -
adbe.pkes7.shal
kp-with-e i ions:
‘e - = TS ladbe.x509.rsa_shal
A kp-aith-e 5 @) Querwrite aurreradbe, pkes?. detached
- leeds-ud -
(& uleedsu My Documents (7) Save to a new file fiiEz
Computer
@
Network

File name: UnsignedPDF. pdf Sign PDF file
Fiesoftype: [pOF Fies (*pdf) -]

Lower Case Aliases

Note

You can use PDF examples provided in the distribution kit in doc/ sanpl es/ pdf
folder, to test the sign PDF features.

Note

Signing a PDF which is encrypted is not currently supported. Signing a PDF
containing xref-streams is not fully supported and for example the size of the
generated signed PDF could become much too large and the time for processing is
pretty expensive. A warning message is presented if xref-streams are detected, with
the option to continue the signing procedure.

6.2.4 Signing CSR Files
In order to sign a CSR file, make the following steps:

« select a Key Pair from the KeyStore tree table;

« either choose the main menu Si gnatures > Sign > CSR fil e or the contextual
menu Sign > CSR file;

« unlock the Key Pair if requested by providing its password;
« select the CSR file that will be signed;
« select a file where to save the CA Reply.

The certificate details from the CSR will be shown in a new opened dialog requiring to provide
a Serial Number and double checking the validity period. Additionally, when signing the CSR
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file, certificate extensions can be added to the certificate that will result in the CA Reply.
Adding the extensions can be done in the same way as it is done when creating a self signed
certificate when generating a new key pair (please see "Gener at e Key Pair" and "Add
Ext ensi ons To Certifi cate" chapters for more details).

The dialog that allows adding extensions when signing a CSR can be seen in the screenshot
below:

% Sign CSR File

[l

Keys:
Algorithm: RSA (@ DSA EC
Key Size: | 896

Certificate:

Add certificate information = Add certificate extensions

Certificate Info | Certificate Extensions

| extensions

= |, Basic Constraints [C]
o @ 15 CA
""" # Key Usage [C] Key Identifier |19F76E1127A3%ACECEDSETS1BFECSD 1D
= 1) Authority Key Identifier
£t | Authority Certificate Issuer B
E-iff General Name @ 160-bit hash
=} |, Directory Name -
i ® Common Mame () 64-bit hash
# Organization Unit
# Organization
‘.. @ Authority Certificate Serial Mumber
----- # Subject Key Identifier

1 | 1 | r

[ View As XML ] [ Load Extensions ] [ Save Extensions

l QK ” Cancel ” Help ]

Using the information mentioned above (Serial Number, Extensions, and the information
collected from the CSR), the CSR file will be signed generating a CA Reply.

Note

You can use CSR examples provided in the distribution kit in doc/ sanpl es/ csr
folder, to test the sign CSR features.
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7. FAQ

7.1 How to Install the Unlimited JCE Jurisdiction Policy?

If you exported your PKCS#12/Uber KeyStore file from your browser and used a stronger
password that is greater than 7 characters, you may need to download and install the Java
Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files so you can read
the file.

This is a matter of U.S. policy and U.S. export controls and is not triggered by technical
reasons.

Usually, for Oracle, the Unlimited JCE is available to download as an additional
resource in the download index for JDK/JRE (http://www.oracle.com/technetwork/java/
javase/downloads/index.html ). This will depend on the Java version currently used to start
CERTivity, which can be observed under Hel p > Advanced Details > Java System
Properti es. For example, for Oracle Java 1.7.0_45, which is also the current JRE in the
bundled setups, you can download the required files from:

« http://www.oracle.com/technetwork/java/javase/downloads/jce-7-
download-432124.html

CERTIivity has a wizard which tries to handle automatically the installation of the Unlimited
JCE Jurisdiction Policy, through an embedded browser opened at the official Oracle address.
You only have to Accept the license agreement, if your conditions allows this, and click the
download link. The rest of the procedure is automatically taken care by CERTivity. To benefit
from this go to Hel p > Advanced Details > Security Properties and check
the Policy Status to see if the Unlimited Policy is installed or not. If it is not Installed (status
value is f al se), then use the | nst al | button. This works for Java version 1.7.0_13 or later
because the browser is made available through JavaFX. For more details read the section
Advanced Details.

If for some reasons, such as JavaFX incompatibilities, the wizard for automatic installation
of the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files is not
working, then, in order to manually install these files, follow the steps below:

1. Accept the license agreement from the Java vendor;
2. Download the unlimited strength JCE policy files;

3. Uncompress and extract the downloaded file - this will create a version dependent
subdirectory called, for example, Unl i i t edJCEPol i cy for Java 1.7,

4.Install the unlimited strength policy JAR files from the uncompressed
Unl i mi t edJCEPol i cy directory:

¢ in case of using a CERTivity bundled JRE setup, the place for JCE policy files
isin${certivity.hone}/jre/lib/security, for example for Windows: C:
\ Program Fil es (x86)\ EduLi b\ CERTi vity 1.2\jre\lib\security;

« the standard place for JCE policy files is: ${j dk. home}/jre/lib/security
in case of using JDK for starting CERTivity, or ${j re. hone}/ | i b/ security in
case of using a JRE. To see the exact version of Java used for CERTivity consult
the Hel p > About menu or the CERTIvity log file. To control the Java used
to start CERTivity set the j dkhone property from ${certivity hone}/etc/
certivity.conf byuncommenting and pointing it to the JRE path, for example:
j dkhome="C:\ Program Fi | es\ Java\jre7".
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7.2 Which Are the Available KeyStores Types in CERTivity Application?

The available KeyStore types are:
¢ jks - Java KeyStore (Oracle's KeyStore format);

e pkcsl2 - Public-Key Cryptography Standards #12 KeyStore (RSA's Personal Information
Exchange Syntax Standard);

« jceks - Java Cryptography Extension KeyStore (More secure version of JKS);
« bks - Bouncy Castle KeyStore (Bouncy Castle's version of JKS);

« bks-v1 - Legacy version of Bouncy Castle KeyStore - this has been added for people
needing to create and manage key stores compatible with earlier versions of Bouncy
Castle (less than 1.49);

¢ uber - Bouncy Castle UBER KeyStore (More secure version of BKS);
* Windows Root CA KeyStore;

« Windows User KeyStore.

7.3 Sometimes the Entry Name (Alias) Changes its Case

For UBER KeyStore (Bouncy Castle UBER KeyStore) as well as in PKCS12 KeyStore, the
alias name is case sensitive. For other types of KeyStore, the alias name is not case sensitive.

So, when converting from UBER or PKCS12 to other type of KeyStores, or when moving an
entry from a UBER or PKCS12 type KeyStore to an other, the alias name will be changed
to lower case.

7.4 Fonts too large

If the system font is too big, on some platforms the application is not rendering well out of
the box - especially text is getting out of the editing fields.

If you encounter such a case and you are not using Gnome as a Desktop Environment you
can edit the file ${certivity hone}/etc/config/certificates.conf and under
the option def aul t _opt i ons modify the parameter - - f ont si ze <si ze>.

The default out of the box value for si ze is 11 points at a 72 DPI .

If you are using Linux and Gnome as a Desktop Environment, the default GTK Look and
Feel is ignoring the font size specified via the Java command line arguments, as well as any
possibility of specifying the font from Java. If this is your case, the options you have are either
to set the Gnome system font size to a smaller value or to use the Metal Look and Feel.

To change the font settings in Gnome, use the appropriate menu item in the Gnome menus.
The menus differ depending on the OS distribution and version. In recent Gnome releases, it
is usually: System > Preferences > Appearance, tab Fonts, row Application font, for the font
size continuing with the Details section from the same Fonts tab, then Resolution box for
the DPI if needed.

You can switch to the Metal or Motif Look and Feels by
editing the file ${certivity_hone}/etc/config/certificates.conf and
adding under the option defaul t _options the parameter - -| af
j avax. swi ng. pl af . nret al . Met al LookAndFeel .
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7.5 Having rendering issues?

In case CERTIivity KeyStores Manager has graphical or rendering issues such as:
* incorrect repaints;
¢ non-viewable text and buttons;
« incorrect rendering windows;
¢ black pop-up windows;

¢ even system crashes for certain system configurations.

Then you need to customize how the 2D painting system operates. For example some of the
rendering issues are due to an incompatibility between Java, Windows DirectDraw and the
Video card and are generally affecting any Java Desktop application on that machine.

Oracle (Sun) has some parameters available for fixing the incorrect rendering, for the
Windows and DirectDraw case they are :

< ddoffscreen used to turn off the Java 2D system's use of DirectDraw and Direct3D for
offscreen surfaces;

e noddraw used to turn off the Java 2D system's use of DirectDraw and Direct3D
completely;

¢ d3d used to turn off the Java 2D system's use of Direct3D.
For the whole list of switches there are more details on http://docs.oracle.com/javase/7/docs/

technotes/guides/2d/flags.html  [http://docs.oracle.com/javase/7/docs/technotes/guides/2d/
flags.html].

When experiencing rendering problems on Microsoft Windows systems, a
good solution is to deactivate DirectDraw. Try to set the following
parameters (properties) -J-Dsun.java2d.ddoffscreen=false -J-Dsun.java2d.d3d=false -J-
Dsun.java2d.noddraw=true

in the file ${certivity.nome}/etc/certivity.conf(.sh) from the CERTIivity installation directory
(default for the JRE installer case is C:\Program Files (x86)\EduLib\CERTivity 1.0\etc
\certivity.conf) under the default_options directive. For safety reasons do a backup of that
file before editing.

Edit the file so that the default_options line becomes:

default_options="--branding certivity -J-Xms128m -J-Xmx256m -J-
Dsun.java2d.ddoffscreen=false -J-Dsun.java2d.d3d=false -J-
Dsun.java2d.noddraw=true --fontsize 11"

Make sure it remains a single line (i.e. no line terminator inside) and save the file. Close
CERTivity and then restart it.

7.6 Why do | get an "Access Denied" error when trying to save a KeyStore to afile located in
Program Files?

In Windows 7, saving or modifying files located in the Windows special folders (such as
Program Files, Program Files (x86), etc.) may require your permission due to the User
Account Control (UAC) function. The UAC function should ask for your permission any time
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a program wants to make a major change to your computer, and does not allow modifying
or writing the files into the specified directory if the permission is not granted.

In many applications, saving to or modifying files from the special directories leads to an
"Access Denied" error, due to the restriction imposed by the UAC. That is why, when trying
to save a KeyStore or export a Certificate or Private / Public Key to a file located in one of
the Windows special folders you might get an "Access Denied" type error.

To avoid this from happening, you can try setting the UAC function to a lower level or turning it
off. A detailed description about the UAC settings and the potential impact of each setting on
the security of your computer can be found at http://windows.microsoft.com/is-I1S/windows7/
What-are-User-Account-Control-settings. To find out how to turn off the UAC function you
can find more information at http://windows.microsoft.com/en-US/windows-vista/Turn-User-
Account-Control-on-or-off. Also, if you don't want to modify the UAC function settings or to
turn it off, you can try to save the files to a different folder where writing to files is not restricted.
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8. License Agreement

This EULA (End User License Agreement) is a legal agreement between you (either an
individual or an entity), the end user, and EduLib S.R.L. for the use of CERTivity KeyStores
Manager Software, its enhancements/derivatives and all supporting documentation (the
"Software"). PLEASE READ THIS EULA CAREFULLY BEFORE COMPLETING THE
INSTALLATION PROCESS AND USING THE SOFTWARE. By obtaining the Software, you
agree to comply with the terms and conditions of this license. Installing and using the Software
will signify your agreement to be bound by these terms and conditions. If you do not agree to
these terms and conditions, do not continue installing the Software or do not continue using
the software and destroy all its copies.

This is a license agreement and not an agreement for sale.

8.1 Definition
¢ "EduLib" means EduLib S.R.L.;

« "Software" means the executable code of CERTIivity KeyStores Manager Software, its
enhancements/derivatives and all supporting documentation;

« "Agreement" means this End User License Agreement;

« "License" means the permission granted by EduLib to use the licensed Software product.
8.2 Grant of License
The Software product is owned by EduLib. It is licensed, not sold.

The Software product is protected by copyright laws and international copyright treaties, as
well as other intellectual property laws and treaties. EduLib reserves all intellectual property
rights, including copyrights and trademark rights.

This License permits you to use a single copy, or multiples copies if you are the only user of
the Software product identified above. According to your order, the Software is licensed as
a single product, to an individual user for Single User License, or group of users for Multi-
User License. This Agreement requires that each user of the Software be licensed, either
individually, or as part of a group. A Multi-User License provides for a specified number of
users to use this Software at any time. This does not provide for concurrent user Licensing.
Each user of this Software must be covered either individually, or as part of a group Multi-
User License. The Software is in use on a computer when it is loaded into the temporary
memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that computer.
This Software may be installed on a network provided that appropriate restrictions are in
place limiting the use to licensed users only.

Backup Copy: You may make copies of the Software product and the Software product
License as reasonably necessary for the use authorized above, including as needed for
backup and/or archival purposes. No other copies may be made. Each copy must reproduce
all copyright and other proprietary rights notices on or in the Software product.

The above apply for: Trial License, Standard License and Professional License of the
Software.

8.3 Restricted Use for Evaluation

This Software product can be used in conjunction with a free evaluation Software License.
During the evaluation period, EduLib grants you a limited, non-exclusive, non-transferable,
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non-renewable License to copy and use the Software for 30 days evaluation purposes only
and not for any commercial use. At EduLib discretion, EduLib may provide limited support
through email or discussion forums at EduLib web site. Evaluation Software has been limited
in some way either through time outs, restricted use or evaluation warnings. EduLib bears no
liability for any damages resulting from use (or attempted use after expiration) of the Software
product, and has no duty to provide any support before or after the expiration date of an
evaluation License.

On or before expiry of the evaluation period you may pay a License fee to obtain the right to
use the Software for extended use. If you do not pay such a fee you must destroy all copies
of the Software.

8.4 Support Services

EduLib may provide you with support services related to the Software product according to
your order.

Any supplemental software code or related materials that EduLib provides to you as part
of the support services, in periodic updates to the Software product or otherwise, is to be
considered part of the Software product and is subject to the terms and conditions of this
Agreement.

With respect to any technical information you provide to EduLib as part of the support
services, EduLib may use such information for its business purposes without restriction,
including for product support and development. EduLib will not use such technical information
in a form that personally identifies you without first obtaining your permission.

Technical support is provided via electronic mail at the following address: support@edulib.ro
[mailto:support@edulib.ro] . EduLib will use its best efforts to provide you with technical
support within 2 working days of your request. Please check our web site to find our latest
contact information.

8.5 Refund

Even if the Software is provided free of charge during the Trial Period to allow potential
customers to evaluate and test it before paying the License fee, EduLib allows for 30 days
money refund. This refund policy does not apply when the payment is done via Purchase
Order.

8.6 Restrictions

You may not use, copy, or distribute the Software product, except as granted by this
Agreement, without written authorization from EduLib.

You may not tamper with, alter, or use the Software product in a way that disables,
circumvents, or otherwise defeats its built-in licensing verification and enforcement
capabilities.

You may not remove or alter any trademark, logo, copyright or other proprietary notice,
legend, symbol or label in the Software product.

You may not modify or create derivative copies of the Software License.

You may not reverse engineer, decompile, defeat License encryption mechanisms, or
disassemble the Software product or the Software License Key (File).
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You may not modify the Software or create derivative works based upon the Software.

You may not rent, lease, lend, or in any way distribute or transfer any rights in this Agreement
or the Software product to third parties without EduLib's written approval, and subject to
written agreement by the recipient of the terms of this Agreement.

8.7 High Risk Activities

The Software product is not fault-tolerant and is not designed, manufactured or intended
for use or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, in which the failure of the Software product, or any software, tool, process, or
service that was developed using the Software product, could lead directly to death, personal
injury, or severe physical or environmental damage ("High Risk Activities"). Accordingly,
EduLib and its suppliers and licensors specifically disclaim any express or implied warranty
of fithess for High Risk Activities. You agree that EduLib and its suppliers and licensors will
not be liable for any claims or damages arising from the use of the Software product, or any
software, tool, process, or service that was developed using the Software product, in such
applications.

8.8 Third Party Rights

Any software provided along with the Software that is associated with a separate license
agreement is licensed to you under the terms of that license agreement. This license does
not apply to those portions of the Software. Copies of these third party licenses are included
in all copies of the Software.

8.9 Laws and Regulations

According to the EU Export regulations, the Software is not classified as a dual use 5D002.c
product as all its functionalities qualifies it for the exceptions from category 5A002.a.1, which
means no export control because actually the product is not a dual use one according to the
EU COUNCIL REGULATION (EC) No 428/2009 of 5 May 2009. This conclusion was reached
through a consultancy with the Romanian National Authority for Export Controls (ANCEX
[http://www.ancex.ro]).

Nevertheless users are advised and agree that they must come to fully understand, respect
and comprehend the cryptographic functionality found in the licensed Software and must
agree and undertake to comply with any laws of their forum pertaining to said cryptographic
functionality.

You hereby also acknowledge that:

< you have obtained the Software directly from EduLib, through its Romanian-based web
site;

« the Software developed by EduLib is of Romanian origin and therefore subject to
Romania's and European Union's laws, rules and regulations.

You hereby irrevocably declare and agree that the Software you obtained from http://
www.edulib.com:

« is publicly available, without restriction except the normal copyright ones by means of
electronic transactions and a web download;

« has cryptographic functionality that cannot be easily changed by you;
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« is installable by you without substantial support from EduLib; and

« details of the product is available in the documentation included in the product, as well
as available without restriction on EdulLib site.

You hereby warrant that:

« you are allowed to obtain a copy of this Software at your location or in your forum or
territory;

 your installation and usage of this Software conforms to your country's applicable laws
and regulations;

< you will ensure that users having access to your copy of this Software will abide by the
applicable laws and regulations; and

¢ you undertake to defend and indemnify EduLib (including assuming EduLib attorneys
fees) if you violate any laws or regulations pertaining to cryptographic software or
functionality;

« you have the obligation to obtain at your own expense any license or authorizations
required by any legal authority for acquisition, delivery or use of the products, and if
necessary produce evidence to EduLib. You should be liable for all expenses or charges
incurred by EduLib from your failure to obtain such license or authorizations.

8.10 Limited Warranty

You have ensured with the above mentioned evaluation version that the Software works
according to your requirements and the advertised features. EduLib disclaims all warranties
for deficiencies that are reasonably discoverable with the evaluation version of the Software.
You acknowledge that the Software cannot be completely error-free. EduLib disclaims all
warranties regarding non-severe deviations of the advertised features of the Software.
EduLib and its third party suppliers and licensors disclaim all other representations,
warranties, and conditions, expressed, implied, statutory, or otherwise, including, but not
limited to, implied warranties or conditions of merchantability, satisfactory quality, fitness
for a particular purpose, title, and non-infringement. The entire risk arising out of use or
performance of the Software product remains with you.

8.11 Limitation of Liability

To the maximum extent permitted by applicable law, in no event shall EduLib or its
suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever
(including, but not limited to, damages for loss of profits or confidential or other information,
for business interruption, for personal injury, for loss of privacy, for failure to meet any duty
including of good faith or of reasonable care, for negligence, and for any other pecuniary
or other loss whatsoever) arising out of or in any way related to the use or inability to use
the software, the provision of or failure to provide support services, or otherwise under or
in connection with any provision of this Agreement, even in event of fault, tort (including
negligence), strict liability, breach of contract or breach of warranty of EduLib or any supplier,
and even if EduLib or any supplier has been advised of the possibility of such damages.

Because some states and jurisdictions do not allow the exclusion or limitation of liability,
the above limitation may not apply to you. In such states and jurisdictions, EduLib's liability
shall be limited to the greatest extent permitted by law and the limitations or exclusions of
warranties and liability contained herein do not prejudice applicable statutory consumer rights
of person acquiring goods otherwise than in the course of business. The disclaimer and
limited liability above are fundamental to this Agreement between EduLib and you.
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8.12 General

EduLib reserves the right at any time to cease the support of the Software and to alter
prices, features, specifications, capabilities, functions, licensing terms, release dates, general
availability or other characteristics of the Software.

This Agreement embraces the full and complete understanding of the parties as to the
subject matter hereof and may not be diluted or modified except by written amendment which
expressly refers to this Agreement and which is duly executed by both parties.

This Agreement is to be governed by and construed in accordance with Romanian laws.

The United Nations Convention on Contracts for the International Sale of Goods shall not
apply to this Agreement.

8.13 Contact Information

If you have any questions about this Agreement, or if you want to contact EduLib for any
reason, please email to support@edulib.ro [mailto:support@edulib.ro].

8.14 Changes to our License Agreement

If we decide to change our License Agreement, we will post those changes on http:/
www.edulib.com/products/keystores-managet/license/, and update the License Agreement
modification date below.

This agreement was last modified on 15 January 2014.
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9. Sales and Support

Technical support is provided via electronic mail at the following address: support@edulib.ro
[mailto:support@edulib.ro]. EduLib will use its best efforts to provide you with technical

support within 2 working days of your request. Please check our web site to find our latest
contact information.

EdulLib software can obtained from http://www.edulib.com.

Terms and Conditions of Sale are available at http://www.edulib.com/terms-of-sale/.
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Appendix A. CERTivity®'s Features Matrix

The existence and capabilities of the CERTIvity features are controlled by the category of
your license - Standard, Professional or Trial versions.

Feature Trial License Standard Professional
License License
KeyStore Management
Create a New KeyStore Limited to 5 + +
New Actions
per instance
Open an Existent KeyStore Limited to 5 + +
Open Actions
per instance
Open Windows Root CA KeyStore + - +
Open Windows User KeyStore + - +
Open JREs CA TrustStores + + +
Save a KeyStore + + +
Convert KeyStore Type + + +
Change the KeyStore Password + + +
Delete KeyStore Entry + + +
Change KeyStore Entry Alias + + +
Import Certificate into KeyStore + + +
Generate Key Pair + + +
Generate Secret Key + + +
SSL Certificates Retriever + - +
Import Certificate from Signed JAR + + +
Import Certificate from XML and + - +
PDF
Import Key Pair + + +
Add Certificate Extensions + + +
Save Certificate Extensions as + + +
XML
View Private Key Details + + +
Extend Validity of Self Signed Key + + +
Pairs
Regenerate Key Pair + + +
Copy and paste entries from one + + +
KeyStore to another
Change a Key Pair’s password + + +
Password manager to avoid + + +
entering Key passwords each time
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Feature Trial License Standard Professional
License License

Emphasizing expired and about to + + +

expire Certificates or Key Pairs

Generate self signed Key Pairs + + +

(Private Key with corresponding

Certificate)

Copy to clipboard Certificates from + + +

Key Pair’s Certificate Chain

View Public Key, Certificate Chain + + +

Details

Certificates Operations

Open a standalone Certificate + + +
View Certificate Details + + +
Display multiple certificates + + +
including certificate chains

View Public Key Details + + +
View PEM Representation for a + + +
Certificate

View ASN.1 for a Certificate + + +
View ASN.1 for a Certificate + + +
Extension

View Certificate Extensions + + +
Obtain the Revocation Status + + +
Test Certificates on Given Protocol + - +
View the CRL associated to a + + +
certificate

Sign and Verify

Verify Signatures for JAR/APK + + +
Files

Verify Signatures for XML Files + - +
Verify Signatures for PDF Files + - +
Sign JAR/APK Files + + +
Sign XML Files + - +
Sign PDF Files + - +
Export Options

Export Certificate + + +
Export Certificate Chain + + +
Export Key Pair + + +
Export Private Key + + +
Export Public Key + + +
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Feature Trial License Standard Professional
License License

TrustStores Management

Set / Remove TrustStores at + + +
runtime
Configure Trust Path validation + + +

options at runtime

Certificate Authority functions

Certificate Signing made easier + + +
Sign CSR Files + + +
Generate CSR Files + + +
Open CSR Files + + +
Open CRL Files + + +
Import CA Reply + + +
Trust verification when Importing + + +
CA Reply

Certificate chain management: + + +

append and remove certificate
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